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Intro
This chapter offers a brief introduction to the Cumulus Digital Asset

Management System. Cumulus can store any type of digital media

assets, including all types of documents, images, audio, video, layouts

from publishing programs, presentations, and PDF files. Once assets

are stored, Cumulus becomes a central media repository from which

you and your co-workers can view, locate, search, organize, copy,

move, categorize, and otherwise manipulate the cataloged assets.

Once you've settled on a process for storing and retrieving your digital

assets that works for you, the process can be automated, further

enhancing the efficiency of your workflows. 

In this chapter, you will learn how Cumulus can help you manage your

media assets, the theory behind the Cumulus client/server

architecture, and the structure of this manual. 
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Cumulus
Canto offers different editions of Cumulus:
• Cumulus Workgroup Edition 
• Cumulus Enterprise Edition 
The different editions of Cumulus are designed to meet the needs of anyone 
who wants to keep track of their digital media. To meet individual workflow 
needs, Canto has developed a range of additional add-on products. For more 
information on Cumulus products, see Canto’s website (www.canto.com.)vo

This Administrator Guide
The Administrator guide is one of three manuals that are provided with a 
Cumulus edition:
• The Installation Guides describe how to install Cumulus Workgroup or Cumu-

lus Enterprise.
• The Administrator Guide (this manual) describes how to manage users and cat-

alogs.
• The Client User Guide covers how to use Cumulus for Windows or Mac OS X 

to catalog and manage media assets. This guide includes the descriptions on 
how to set up Cumulus sets and templates.

All manuals are provided as PDF files and can be downloaded from Canto’s web-
site.

Organization
To give you the quickest access to the topic you’re looking for, this guide covers only 
those subjects that are the exclusive domain of the Cumulus Administrator. Every-
thing else you need to know about managing your assets with Cumulus can be found 
in the Client User Guide.
This Administrator Guide covers the following topics:
• “Getting Started” – Covers a few basic guidelines about working with 

Cumulus and how to provide catalogs for your workgroup. (See “Getting 
Started” chapter, starting on page 15.)

•  “Managing Catalogs” – Describes how catalogs manage the media assets 
stored on your system, how to define the properties of individual catalogs 
and how to maintain the catalog files (copy, compress, back up, divide, 
merge, etc.). (See “Managing Catalogs” chapter, starting on page 27.)

• “Server Console” – Describes how to use the Server Console that provides utili-
ties for performing Cumulus’ administrative tasks. (See “Server Console” chap-
ter, starting on page 71.)

•  “Managing Users” – Covers how to make catalogs available to users, and how 
to set individual user permissions. (See “Managing Users” chapter, starting on 
page 99.)

• Cumulus Vault – Describes how to configure catalogs for use with the Vault. 
(See “Configuring Vault” chapter, starting on page 131.)

This guide also contains a chapter on solving a few problems that may arise (see 
“Troubleshooting” chapter, starting on page 153), and a glossary to give you a 
quick reference to some of the terms used in this manual (see “Glossary” chapter 
starting on page 167). The Appendix provides information on on parameters for 
Cumulus AssetProcessors and information on the Sample EJaPs folder included 
with any Cumulus Client installation.

http://www.canto.com/
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Cross-Platform Issues
Cumulus is a cross-platform application, meaning that it runs on Windows® and 
Mac® OS X (Macintosh®) systems. Though the program’s features are identical in 
each version, portions of the user interface differ due to operating system or key-
board conventions. These differences are denoted or explained when necessary 
and assumed otherwise (e.g., the difference between “maximizing” a window in 
Windows, and “zooming” a window in the Mac OS X is not explained).

This icon denotes what pertains to Mac OS X only.
This icon denotes what pertains to Windows only.

User Interface Item Conventions
To differentiate user interface items – buttons, menus, text fields, etc.– from sur-
rounding text, those items are displayed in bold. For example:

“Click the Open button.”
To differentiate menu hierarchies, the >  character is used. For example:

“Select File > Open to open a file.”
This example means to select the Open item from the File menu.

Cumulus Step by Step
Instructional steps are identified by the following structure:

1. This would be the first instruction. The mouse icon makes it easy to identify.

2. The final instruction has a border beneath it, indicating that there are no fur-
ther steps.

Understanding Cumulus
To get started with Cumulus, you need to understand only a few basic concepts. 
Cumulus creates special files called catalogs, which Cumulus uses to keep track 
of your valuable assets. As you catalog your assets, Cumulus creates special cata-
log entries called records that represent the assets to be managed. Each record 
contains vital searchable information about the asset it represents. To make 
searching and retrieving records easier, Cumulus lets you organize and classify 
records into logical groups called categories. Any individual set of records com-
prises a collection. A collection is a way of looking at catalog(s).

Assets
An asset in Cumulus is simply any one cataloged file or data stream. A video clip, 
an audio clip, an image, or a page layout document are examples of files that are 
commonly cataloged in Cumulus. But the word file suggests an asset that is 
stored on a digital medium like a hard-disk or CD-ROM. What if the asset is a 
record in a database? This is not a file per se, but as far as Cumulus is concerned, 
it is a data stream that can be cataloged, kept track of and accessed. 

Catalogs
Like a filing cabinet, Cumulus catalogs serve as storage locations for asset collec-
tions. You can have as many catalogs as you like. Catalogs are cross-platform 
compatible, so it doesn’t matter what type of computer is used to create a cata-
log. Catalogs are explained in detail starting on page 27.
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Categories
Like folders in a filing cabinet, Cumulus categories serve to organize assets (files). 
But here the similarities end. Assets can appear in any number of Cumulus cate-
gories at one time. Categories are explained in detail in the Client User Guide. 

Records
Records represent assets. Each record represents one asset. Records hold infor-
mation on the asset, such as file size, type, location, creation date, and much 
more. Cumulus allows the creation of customizable record fields, which can con-
tain almost any sort of information you desire. Since these user-defined record 
fields are also fully searchable, you can tailor Cumulus to fit your requirements. 
Record fields are explained in detail starting on page 28. It’s very important to 
draw the distinction between records and assets. Records are part of Cumulus 
catalogs; assets are not. Records represent assets. 

Collections
Collections are like snapshots from your open catalog. When you work with your 
assets in Cumulus, you’re viewing a constantly changing group of records. With-
out collections, each view of this group would be lost as soon as it was changed. 
Collections, however, enable you to capture any particular set of records and 
save it as you see it—all without disrupting your workflow. For example, you can 
modify the viewing attributes of your records in innumerable ways, add or delete 
records, select the information that appears with each record, and so on. Once 
you see something you like or could use again, save it as a collection and recall it 
whenever you need it. You can even send your collection as an attachment to an 
e-mail message in one easy step.
A collection also acts as your temporary workspace in Cumulus, meaning that 
changes made to your collections do not affect the content of your catalogs. 
Even deleting a record from a collection does not remove it from the catalog 
(unless you really want it to, which you can do, too). Collections are explained in 
detail in the Client User Guide. 
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How Cumulus Works
Cumulus features a client/server architecture in which individual users (or clients) access 
the server application across a network.

The Cumulus Client/Server Architecture
The overall client/server architecture is simple. The Cumulus Server is installed on 
a server computer in the network. The Cumulus Clients are then installed on 
computers that have access to the computer running the Cumulus Server. 
The communication between Clients and Server is handled via the Internet-stan-
dard TCP/IP, enabling Clients to access Cumulus catalogs from within the office 
or anywhere else in the world. Since Cumulus is cross-platform compatible, both 
Mac OS X and Windows Clients can access catalogs administered by any Cumu-
lus Server. The only restriction is that the Client has to have TCP/IP access to the 
computer running the Server.
You don’t have to specify which computers are running the Cumulus Client 
application. The Cumulus Server allows as many Clients to connect as the num-
ber of Clients you purchased, no matter where they’re trying to connect from.

The Cumulus Architecture
Cumulus can be seen as "middleware" 
as it communicates between the levels 
of the employed operating systems, 
storage devices and databases and the 
user interface level. The main compo-
nents of Cumulus are the metadata 
server, an asset server and a processor 
server. These components can be 
installed on different computers with 
different operating systems.
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The Cumulus Administrator 
The Cumulus Administrator has to perform the following tasks: 
• Installing the Cumulus Server application on a server computer in the network. 

(See Installation Guide.)
• Registering your Cumulus configuration and activating the software. (See 

Installation Guide.)
• Configuring the Cumulus Server – employing the Remote Admin utility. (See 

“Remote Admin,” p. 83)
The Cumulus Administrator is responsible for the following tasks: 
• Providing catalogs to Cumulus Clients by creating new catalogs or adding 

existing ones to the list of catalogs administered by the Cumulus Server. (See 
“Providing Catalogs,” p. 19.)

• Configuring each catalog’s settings to meet the specific needs of the work-
group. (See “Catalog Settings,” p. 28.) 

• Making catalogs available or unavailable to Cumulus Clients and defining indi-
vidual user permissions. (See “Managing Users,” p. 99.)

• Maintaining the catalog files themselves, including tasks such as optimizing cat-
alog performance, backing up and restoring catalogs, repairing catalogs, etc. 
(See “Catalog Maintenance,” p. 61.)

The permission to perform these tasks can be given to other users. The Cumulus 
Administrator has all these permissions by default and is the one who is respon-
sible that the permissions are given according to the specific needs of the work-
group.

Cumulus Clients
Cumulus Clients access workgroup catalogs by logging onto the Cumulus Server and 
opening catalogs administered by the Server. Once logged on, they have access to all 
of the functions described in the Client User Guide (provided, of course, that the Cumu-
lus Administrator has not restricted their permissions to use these functions).
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Finding Help
If you have a question that is not answered in this guide, there are a number of addi-
tional resources to check:

Online Help 
Cumulus includes a help system. Access it via the Help menu or the Help buttons 
provided in dialog windows. Similar to other help systems, subjects are orga-
nized by contents and index, and are searchable. The Cumulus help system is 
based on HTML pages that can be viewed with any standard Web browser. How-
ever, if you employ any pop up blockers, the display of the help system may not 
be possible.

TIP: 
Recommend your Cumulus Client users to load Cumulus help online 
from the Canto website, where the latest updates will always be avail-
able. (Help > Source > Online)

Canto Online
The Canto website (www.canto.com) contains many resources of value to you as 
a Cumulus user. Among them Canto's User 2 User Support Forums. These forums 
are non-moderated bulletin boards hosted on the Canto website. Canto support 
does not answer questions here, the forums are user to user only. Feel free to use 
the forums to discuss any problems you may be having using Cumulus and 
receive help from other Cumulus users. 
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Getting Started
This chapter covers some topics important for getting your Cumulus

configuration up and running. Since your workgroup needs Cumulus

catalogs to access, this chapter gives you a few guidelines about effec-

tive catalog administration, as well as information on how to provide

catalogs to your workgroup.
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Dia
Cum
The Cumulus Server
Once installed, as default the Cumulus Server is launched “invisibly” every time 
the computer it’s running on is started up. Most administrative actions can be 
performed from a Cumulus Client application logged on as Cumulus Administra-
tor to the Server. Before you can log on from a Client, however, you have to reg-
ister the Cumulus software and maybe configure the Cumulus Server properties. 
You configure the properties of a Cumulus Server using the Remote Admin mod-
ule. For details on the Remote Admin module, see “Remote Admin,” p. 83”. 

The Cumulus Administrator
To administer Cumulus, there has to be a user account which functions as the 
Cumulus Administrator. This user account is created during the installation of the 
Cumulus Server with the default name cumulus. 
There is only one Cumulus Administrator, but to provide your workgroup with 
extra flexibility in managing catalogs, Cumulus permits more than one user to act 
as Cumulus Administrator simultaneously. It does not, however, permit more 
than one user to open a catalog as Administrator at the same time. Each one sim-
ply needs to enter the user name of the Cumulus Administrator when connect-
ing to the Cumulus Server. 

Initial Tasks and Their Order
The sections that follow describe how to log on as Administrator and then how 
to provide catalogs as this is the next step to be performed. This should be done 
before you set up any Cumulus Client users as you can only allow them access to 
catalogs that are provided by the Cumulus Server. For a description on how to 
set up users, see “Managing Users,” p. 99. However, before you let your Cumulus 
Clients work with these catalogs you should set up the catalogs as well. For a 
description on how to set up catalogs, see “Catalog Settings,” p. 28. 
For general information on the responsibilities of the Cumulus Administrator, see 
“The Cumulus Administrator,” p. 12.

Logging On as Cumulus Administrator
Before you can begin managing your workgroup’s catalogs, you have to log onto 
the Server as Cumulus Administrator from a Cumulus Client application.
To log on as Cumulus Administrator:

1. From any Cumulus Client, select File > Connect to Server.

The Connect to Server dialog box appears. 

2. In the Server field, select or enter the name of the Cumulus Server, you want 
to connect to. 

If you are logging on from the same computer as the Server is installed, you 
can type in localhost. If more than one Cumulus Servers are available to you, 
click on the arrow to get a list displayed. This list contains the names/IP 
addresses of all currently active Cumulus Servers in the network. If necessary, 
edit the IP address of the Cumulus Server by selecting another one from the 
drop-down list. The IP address can be either a numbered address or the 
name of the Cumulus Server (e.g., cumulus.canto.com).

NOTE: To be able to connect to the Server, every Client must specify a port 
number. By default, Cumulus automatically determines an open port 

log to connect to the 
ulus Server
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number and configures it for both Server and Clients (see “Remote Admin,” 
p. 83). Change the port number only to avoid a conflict with other server 
software. If the port number is changed, all Clients need to be informed of 
this fact or they will not be able to log on. 

3. Under Connect as, enable Registered User.

4. Type the user name of the Cumulus Administrator in the Name field and the 
corresponding password in the Password field. (See “The Cumulus Adminis-
trator,” p. 16, for information on the identity of the Cumulus Administrator.)

5. Click OK. 

The Catalog Access window appears.

The Catalog Access window lists all catalogs currently administered by the 
Cumulus Server and is the starting point for performing numerous administrative 
tasks. 

Via the Catalog Access window, you can:
• open a catalog and modify its properties (see “Catalog Settings,” p. 28)
• create new catalogs (see “Creating New Catalogs,” p. 20).
• add existing catalogs to the list of those administered by the Cumulus Server 

(see “Adding Existing Catalogs,” p. 21).
• remove catalogs from this list. Then they are not administered by the 

Cumulus Server.
• determine which catalogs should be shared and be available to Cumulus Cli-

ents in general. The individual access permissions of Cumulus Clients for cat-
alogs are defined employing the User Manager module (see “User Manager,” 
p. 101).

• publish catalogs to the Internet (only available if a Cumulus Internet solution 
is installed with your Cumulus configuration).

The Catalog Access window – starting point for 
numerous administrative tasks
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Working Smart 
Before you jump into providing catalogs for your workgroup, it’s a good idea to 
become familiar with a few guidelines that will make your work with Cumulus as 
efficient and effective as possible.

Name a Catalog Manager
It’s best to assign one person in your workgroup to manage assets and Cumulus 
catalogs. Having one manager helps keep things consistent and provides your 
workgroup with a recognized source for asset and catalog information.
For the catalog manager to be able to effectively manage workgroup catalogs, 
this user has to log on to the Cumulus Server as the Cumulus Administrator. For 
details on acting as the Cumulus Administrator, see “The Cumulus Administra-
tor,” p. 16.

Develop an Effective File Naming Convention
Even though Cumulus makes it easy to keep track of assets with its thumbnail 
previews and wealth of search options, there is no substitute for a well planned 
filing system. There will be times that you must access files without the conve-
nience of the Cumulus interface. For example, when writing scripts to enable 
Cumulus to automate the workflow, a consistent and predictable filing system 
can not only save many hours of script debugging, but it can also enable func-
tionality that might not otherwise be possible.
How you name your files will depend on how you use them. A news agency may 
decide to name incoming news stories prefixed with the current date and affixed 
with the file type:

2003-06-01-ElectionResults.txt
2003-06-01-ElectionResults.tif

Using the date in this order lists the files chronologically when sorted alphabeti-
cally. It also makes it easier for Cumulus scripts to select files based on a date 
range.
A Web design group may choose to include an image’s file size in its name to 
make entering HTML size tags more convenient: MainPageBanner200x50.gif
Or, to use this manual as an example, file names for screen shots of menus and 
dialog boxes each begin with either “M_” or “W_” to identify the platform from 
which the images come. For example, the file name for the Mac OS File menu is: 
M_FileMenu.tif. Its Windows counterpart is called: W_FileMenu.tif
Using the two file name prefixes not only helps differentiate the files at a glance, 
but also helps to make the filing system more predictable. From this example, 
you can probably guess the file names of most images in this document. Consis-
tency and predictability are key to developing a naming convention that will 
serve you and your workgroup well.

Develop an Effective Folder Naming Convention
Apply an equally clear naming convention to your folder (directory) structures. 
Cumulus can use your folder hierarchy to create categories when cataloging 
assets. It is a real time saver if your folder structure helps to identify your assets. 
Some users may choose to store assets in folders based on file type rather than 
project name. A sound clip of audience applause, for example, may be used in 
many projects, but it will always be a sound clip. You can use Cumulus’ catego-
ries to associate assets with one or more projects.
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Cross-Platform Catalog Use
Though the catalogs that Cumulus creates are completely cross-platform com-
patible, it is up to you to use a catalog file naming convention compatible with 
each platform which you plan to use for your catalogs.
Keep in mind that catalog names and catalog file names are two different things. 
For cross-platform purposes, you need only be concerned with catalog file 
names. (see “Renaming Catalogs,” p. 65, for catalog naming information.)
Consult your operating system’s documentation for details on the range of char-
acters that can be used. In the meantime, here are a few tips:
• Windows uses a backslash (\) to differentiate folder hierarchies. Mac OS users 

should avoid using this character in their catalog names. (The Mac OS uses a 
colon (:) to differentiate folder hierarchies, but this character is not allowed in 
files name on either platform, so it is of no real concern.)

• Windows file names can be up to 255 characters in length. Mac OS file names 
must be 31 characters or less.

Characters that are safe for use on all Cumulus platforms include all upper and 
lower case letters, all numbers, the hyphen (-), and the underscore ( _ ).

Multiple Catalogs & Servers
You may want to use separate servers for different departments within your 
organization. Although each server can manage one or more catalogs, you must 
have a separate copy of Cumulus for each server. 
When evaluating your media management needs, consider the following ques-
tions:
• How many Clients will access the catalog?
• How many assets do you need to manage, today and in the future?
• Where will the cataloged assets be stored? Who should have access to the 

cataloged assets (for example, to modify them)?
• Does the media archive contain logically unrelated groups of assets? 
• Do different groups of people use different groups of assets? Or do the doc-

uments themselves fall into multiple categories?

Providing Catalogs
Catalogs to be shared by your workgroup must be administered by the Cumulus 
Server, which means that they must appear in the list of catalogs administered 
by the Server (in the Catalog Access window). Catalogs administered by the 
Cumulus Server have to be stored locally on the computer running the Server 
application. So before you jump into providing catalogs for your workgroup, 
make sure that you create or note the location(s) that will house the catalogs you 
provide.
You have a couple of options for providing catalogs to be administered by the 
Cumulus Server. You can either create new catalogs or add existing catalogs to 
the list in the Catalog Access window. If you add catalogs from previous Cumulus 
versions, you should migrate them to the current Cumulus format. The sections 
that follow describe how to provide catalogs to your workgroup using any of 
these routes. 
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Creating New Catalogs
The first step in creating new workgroup catalogs is to create or note the location 
where they will be stored on the computer running the Cumulus Server. So if you 
haven’t already done so, do that now.
Then you can log on to the Cumulus Server from any Cumulus Client and tell the 
Server where the catalog is to be stored and what you want to call it.
To create new catalogs for your workgroup:

1. Log on as Cumulus Administrator to the Cumulus Server (see “Logging On 
as Cumulus Administrator,” p. 16).

2. In the Catalog Access window, click New.

The Create New Catalog window appears.

3. Click Browse.

The Browse window appears:

4. From the Look In drop down menu, select the location where the new cata-
log shall be stored. (Only locations approved by the Cumulus Administrator 
are accessible.)

5. In the File Name field enter a name for the new catalog, then click OK.

The Browse window is closed. In the Location field of the Create New Cata-
log window, the location and the name of the new catalog are displayed.

6. From the Select a Template drop down menu, select a   template.. (For more 
information on catalog templates, see “Catalog Templates,” p. 59).
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7. Click OK.

The new catalog now appears in the catalog list of the Catalog Access window.

Adding Existing Catalogs
Catalogs to be administered by the Cumulus Server must be stored locally on the 
computer running the Server application Only catalogs stored in locations 
approved by the Cumulus Administrator can be used by Cumulus. So before you 
add a catalog for your workgroup, make sure that it is stored in appropriate loca-
tion. You can then log on to the Cumulus Server from any Cumulus Client and 
tell the Server where the catalog can be found.
Catalogs created with Cumulus 6 versions can be used with Cumulus 8. Catalogs 
created with Cumulus versions earlier than 6 must be migrated before they can 
be used with Cumulus 8. (See “Migrating Catalogs,” p. 67, for more information.)
To add an existing Cumulus catalog to the list:

1. Log on as Cumulus Administrator to the Cumulus Server (see “Logging On 
as Cumulus Administrator,” p. 16).

2. In the Catalog Access dialog box, click Add to List.

The Browse window appears.

3. If necessary, select the location where the catalog is stored from the Look In 
drop down menu

Select the desired catalog file (.ccf ) from the list an click Open.The added 
catalog appears in the catalog list of the Catalog Access window.

Your catalogs are now administered by the Cumulus Server and can be accessed 
by Cumulus Clients. 
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Catalog Availability
There are two levels of catalog access to keep in mind when managing user per-
missions:
• Catalog availability – Determines whether or not a catalog is available for 

sharing at all. If available, the catalog is available to every Client who connects 
to the Server, unless you define specific user access restrictions.

• User permissions – Determines how a catalog is shared. You can define 
which access permissions users have. (See “User Properties,” p. 104.)

Making Catalogs Available
Just because a catalog appears in the list of catalogs administered by the 
Cumulus Server, it doesn’t mean that it can be shared by your workgroup. You 
first have to make each catalog available before it can be accessed by Clients.
To make a catalog available to Clients in general:

1. Log on as Cumulus Administrator to the Cumulus Server (see “Logging On 
as Cumulus Administrator,” p. 16).

The Catalog Access window appears. You can see which catalogs are acces-
sible to clients by selecting a catalog and noting whether the Share Catalog 
option is checked for that catalog.

2. Select the catalog you wish to make available to Clients and enable Share 
Catalog.

A dialog asks you to confirm the change of the sharing status of the catalog 
in question.

3. Confirm the change.

The catalog is now available to every Client who has got the respective permis-
sions, see “User Properties,” p. 104.

Making Catalogs Unavailable
There are two ways to make a catalog unavailable to Clients. Both are done from 
the Catalog Access window. You can:
• temporarily deactivate it in the list of catalogs administered by the Cumulus 

Server by disabling Share Catalog.  
• permanently remove it from the list of catalogs administered by the Cumulus 

Server by clicking Remove from List. The catalog is not deleted, but is no lon-
ger administered by the Cumulus Server.

To make a catalog unavailable to Clients in general:

1. Log on as Cumulus Administrator to the Cumulus Server (see “Logging On 
as Cumulus Administrator,” p. 16).

The Catalog Access window appears. You can see which catalogs are acces-
sible to clients by selecting a catalog and noting whether the Share Catalog 
option is checked for that catalog.

2. Select the catalog you wish to make unavailable to clients and disable Share 
Catalog. A dialog box appears asking you to confirm the change of the shar-
ing status of the catalog in question.

3. Click OK.
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The catalog still appears in the list of catalogs administered by the Cumulus 
Server, but it is no longer available to be shared by Clients.
To remove a catalog from the list of catalogs administered by the Cumulus 
Server:

1. Log on as Cumulus Administrator to the Cumulus Server (see “Logging On 
as Cumulus Administrator,” p. 16).

The Catalog Access window appears. 

2. Select the catalog you wish to remove from the list and click Remove from 
List.

If the catalog to be removed is being used by a Client, a dialog box appears 
in which you can determine the length of time the Clients have before they 
will be disconnected. This dialog box also lets you send these Clients a mes-
sage on the impending disconnection.

3. Click OK.

The catalog is removed from the list in the Catalog Access window, but is not 
deleted from the system.

Going On
As Cumulus Administrator, you are responsible 
• for setting up these catalogs to meet the needs of your workgroup. To find 

out how, see “Managing Catalogs,” p. 27.
• for creating Cumulus Client users and giving them the permissions for 

accessing catalogs and functions as it best suits your workflow. To find out 
how, see “User Properties,” p. 104.

• for providing View Sets, Asset Handling Sets, Actions, and Metadata Tem-
plates to the Cumulus Client users that meet the specific needs of your work-
group. To find out how to define these sets, see the Client User Guide. 
The Cumulus Administrator can also give other Client users the permissions 
to define these items. Since Cumulus 6.5, you can have users with very indi-
vidual permissions. For example, you can have users who have the permis-
sions to define shared Asset Handling Sets or the permissions to define 
shared View Sets and others who are allowed to do both. This enables big 
organizations to delegate these tasks to different users, e.g. from different 
departments. However, as the Cumulus Administrator knows best about the 
fields included in the catalogs, it’s also the Cumulus Administrator who 
knows best how to set up View Sets that meet the specific needs of the work-
group and fit the catalogs used by the workgroup. Again it’s the Cumulus 
Administrator who knows best about the Asset Handling modules that are 
used by the workgroup and that’s why the Cumulus Administrator is the one 
who knows best how to set up Asset Handling Sets that are ideal for the 
workflow. The same goes for Actions and Metadata Templates. However, 
since Cumulus 6.5, it is up to you either to take over these tasks yourself or to 
train other users so that they can take on these tasks.

• for configuring messages sent by the mail notification function.



24 CUMULUS® –  ADMINISTRATOR GUIDE
Configuring Mail Notification Messages
Standard messages for the Mail Notifier are contained in the MailConfig.xml 
configuration file, which is located in the conf folder inside your Cumulus Server 
installation folder.
The configuration file contains pre-configured messages. You can easily change 
the wording and content of these messages. Just follow the instructions given in 
the comments of the MailConfig.xml file.

Default User Settings
However, the Cumulus Administrator has all permissions by default and is the 
only one who can define the User Settings before other Cumulus Client users 
start working with a new Cumulus installation. This is possible because all set-
tings are centrally stored at the Cumulus Server. The Cumulus Server installation 
folder includes a conf folder that houses folders where the settings are stored. 
The Users folder holds the individual folders of Cumulus Clients (named as their 
login names) where their individual settings are stored. The Server folder holds 
the shared settings that can be used by all Cumulus Clients. 
When a Client user logs in to a new Cumulus installation for the first time, all set-
tings are taken from the DefaultUser folder. However, only then, as with logging 
in for the first time, an individual folder is created in the Users folder for each Cli-
ent user to store her/his individual settings. When logging in next time, the set-
tings from this individual folder will be taken. 

Customizing Default User Settings
In case the Cumulus Administrator wants the Client users to have initial  User Set-
tings that differ from those Canto provides, there is an easy way to prepare this 
before a Client user logs in  for the first time.
In order to do this, log in as Cumulus Administrator and define the User Settings 
as you want them to be for Cumulus Client users to start with. Then save them 
and close the Preferences windows (or even quit the Cumulus application). The 
User Settings are stored in the Cumulus Administrator’s folder (default: cumulus)  
inside the Cumulus Server installation folder, e.g 

 ..\Canto\Cumulus Enterprise Server\ conf\Options\Users\%7b98ca1422-0171-4d1d-8b84-
8cdda4ab70ae%7d\cumulus or 

 /usr/local/Cumulus_Enterprise_Server/conf/Options/Users/%7b98ca1422-0171-4d1d-8b84-
8cdda4ab70ae%7d/cumulus 
Then copy the ModulePreferences.xml & ModulePreferences.pack files from the  
this folder to the folder of the default user (named defaultuser), e.g.

..\Canto\Cumulus Enterprise Server \conf\Options\Users\ %7b98ca1422-0171-4d1d-8b84-
8cdda4ab70ae%7d\defaultuser or 

   /usr/local/Cumulus_Enterprise_Server/conf/Options/Users/%7b98ca1422-0171-4d1d-
8b84-8cdda4ab70ae%7d/defaultuser

NOTE:
Do not copy any possibly existing collections.xml file! Collections can not be 
duplicated this way. 

TIP: Copying the User Settings of a Selected User for Other Users
The User Manager module offers a function that lets you copy user set-
tings from one user to another. In that case the User Settings for the 
Cumulus application as set in the Preferences window are copied. For 
details see “Copying User Settings,” p. 126.
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Default User Settings with Roles
If you employ the role-based mode of the User Manager, Cumulus offers the pos-
sibilty to provide different initial settings for the different roles. Each role created 
with the User Manager has its own folder located in the Users folder, and if a user 
assigned to certain roles logs in for the first time, she/he will get her/his indivud-
ual user folder which contains the settings provided by the role’s folder. If the 
role’s folder does not contain certain settings they are taken from the Default-
User folder. If a user is assigned to more than one role, the settings from the 
assigned roles will be added and merged before copied to the indivudual user 
folder.
To make use of this feature you must copy the desired settings ( e.g. ModulePref-
erences.xml & ModulePreferences.pack) to the roles’ folders.
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Managing Catalogs
This section describes how to set the catalog settings to suit your

needs and offers some suggestions for effective cataloging strategies,

also it covers some catalog maintenance issues.
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Catalog Settings
Fundamental changes can be made to each catalog by modifying its settings. 
These settings have no effect on catalogs other than on the one for which they 
are set. It’s important to consider a catalog’s settings when the catalog is new, 
before you add records to it. 

PRECONDITIONS To modify a catalog’s settings, you must have the appropriate Administrator per-
missions (Permissions > Administrator Permissions > Modify Catalog Set-
tings.) To view a catalog’s settings, you must have the appropriate Administrator 
permissions (Permissions > Administrator Permissions > View Catalog Set-
tings.) 
To access the settings of a catalog: 

1. Make sure the collection window containing the catalog is the active win-
dow in Cumulus. If you have more than one catalog opened in the active 
collection window, the Catalog Settings window provides a list from which 
you can select the catalog you want to modify. 

2. Select Cumulus / Edit > Preferences. 

3. Click Catalog Settings.

The Catalog Settings window is displayed. If the active collection window 
contains more than one catalog, select the catalog you want to modify 
under Catalogs.

The settings for the selected catalog are displayed in the Catalog Settings 
window.

The Catalog Settings window controls several important factors that come into 
play while managing assets. The options are divided into the following sections:
• General – Catalog location and name, sharing options and options on a cen-

tral location for the assets.
• Record Fields – Displays the record fields that the catalog contains. You can 

add or delete fields and customize selected fields. This allows you to organize 
the information that can be stored on an asset in its record. Remember, meta-
data retrieved from assets while cataloging can only be stored if the corre-
sponding record fields are included in the catalog.

• Category Fields – Displays the category fields that the catalog contains. You 
can add or delete fields and customize the fields.

• Mirroring – Displays the current mirroring settings for the catalog. You can 
activate mirroring and define the database that serves as the mirror. (For 
more information on mirroring, see “Database Mirroring,” p. 54.)

• Permissions Summary – Shows what permissions each user or role has for 
the catalog. You can only view the information, for editing you have to 
employ the User Manager of the Server Console.

See “Overview: Catalog Settings”, below, for an overview of the options available 
from this window.
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verview: Catalog Settings
he Catalog Settings window has three sections that provide access to each of its options. The options that are
t from this window are specific to the active/selected catalog. They have no effect on other catalogs.

eneral Section 
atalog

Catalog file name, as seen from the Windows desk-
top/ Mac OS Finder (not editable from here).
Catalog name. Defaults to file name, can be 
changed. (See “Renaming Catalogs,” p. 65, for 
details. Note that catalogs cannot be renamed while 
set to use the Cumulus Vault in Always and Exclu-
sive mode.)
Displays the catalog format 
Displays the catalog size (actual size/maximum 
size).
Prevents the creation of new categories that share 
names with existing categories.
Activates journaling for the catalog. (See “Journal-
ing Catalogs,” p. 53)
IMPORTANT!  Do not employ journaling and mirror-
ing for the same catalog! Use one of the mechanisms 
depending on how the catalog is used.: (See “Secur-
ing Catalogs,” p. 52, for more information.) 

haring
Enabling this option makes a catalog available to 
Cumulus Clients.
Enabling this option is the first step to publishing a 
shared catalog on the Internet. 

opy Asset to Central Location
If activated, newly cataloged assets can or will be 
copied to the selected Central Asset Location – 
depending on the selected mode. 

0 Displays the selected Central Asset Location
1 Opens a dialog for selecting the Central Asset Loca-

tion.

12 Opens a dialog for selecting the mode for copying asset to the
Central Asset Location.
– As Set in Asset Handling Set – the Asset Handling Set 
employed for cataloging decides if assets are copied to the 
selected Central Location.
– Always – Assets are always copied to the selected Central 
Location, regardless of the Asset Handling Set settings.
– Always and Exclusive – Assets are always copied to Vault 
and their asset storage location is Vault exclusively. (This 
option is available only if Vault is selected as Central Asset 
Location.)

NOTE: Duplicates control with Central Asset Location!
For controlling duplicates with Central Asset Location activated, 
the record fields Original Asset Identifier, Original Asset Name and
Original Asset Reference are required. You have to add these fields
to catalogs with Central Asset Location activated if you also wan
duplicates control. 

ecord and Category Fields Section
Field name.
Field type.
Overview on how the field is used for sorting and 
searching.
Overview on whether the user may edit the content 
of the field. Checkboxes may be activated/deacti-
vated directly.
Overview on whether a field is a mandatory field, or 
whether the field value is checked by a validator. 
Checkboxes for display only!
Overview on the value mode
Opens a menu for selecting the columns to be dis-
played on this tab.
Opens dialog for defining field properties. For details 
see “Overview: Field Properties,” p. 35.
NOTE: Catalog Name, Record ID and Category ID are 
so-called virtual fields. These fields are meant to be 
used for display and processing purposes only. 
Therefore you cannot define their properties. 

9 Opens dialog for selecting the field to be added.
10 Removes the selected field from the list.
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irroring Section
PORTANT!  Do not employ journaling and mirroring 

r the same catalog! Use one of the mechanisms 
epending on how the catalog is used.: (See “Securing 
atalogs,” p. 52, for more information.)

Activates mirroring for the catalog. (See “Setting up 
a Catalog for Mirroring,” p. 57)
Selects the database system used for mirroring the 
catalog.
Defines the actual database used for mirroring the 
catalog. The displayed fields depend on the on the 
selected database system.
Displays information on the actual mirroring pro-
cess.

For more information on mirroring, see “Database Mirroring,” 
p. 54.

ermissions Summary
ows what permissions each user or role has for the 
talog. 

OTE: You can only view the information, for editing 
u have to employ the User Manager of the Server Con-
le. 

Lists the users and roles managed by the Cumulus 
Users catalog.
Displays the permissions the above selected user/
role has for the catalog.
Displays the sets, actions, queries, and templates 
available for the above selected user/role with that 
catalog.
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Employing a Central Asset Location
A Central Asset Location is a single storage location used to store specific digital 
assets. Employing a Central Asset Location ensures your assets remain accessible 
to all, and can more easily be accounted for. Cumulus lets you choose between 
different types of Central Asset Locations:
• File System – Any standard file system location can be used as a Central Asset 

Location. The most common example is a network file server. This type is sup-
ported by the Asset Storage Modules for the operating systems.

• Internet (FTP) Servers – If you need to keep files accessible from an Internet FTP 
server, you can choose an FTP server as Central Asset Location. This option is 
less popular for works-in-progress because of performance and other limita-
tions associated with this type of server access; but when archiving assets, 
this option can be ideal. This type is supported by the URL AssetStore.

• Cumulus Vault – This type provides asset check in/out and version control ser-
vices not available with the other two types. The file system on the Vault 
Server machine physically stores the assets kept in the Vault, but Cumulus 
Vault controls access to the files, which enables it to offer these advanced ser-
vices not available when using the file system directly. This type is supported 
by the Vault AssetStore.

A Central Asset Location is chosen as a catalog property setting. Each catalog can 
have its own Central Asset Location. What the best choice is depends on how the 
catalog is used. For more best practice information on Central Asset Locations, 
see the tutorial “Understanding Central Asset Locations in Cumulus” from 
Canto's “Exploring Series.”
PRECONDITIONS: To set up a Central Asset Location for a catalog, you must have 
the appropriate Administrator permissions (Permissions > Administrator Per-
missions > Modify Central Asset Location (option for the Modify Catalog Set-
tings permission.) 
To configure a catalog to employ a Central Asset Location:

1. Make sure the collection window containing the catalog is the active win-
dow in Cumulus.

2. Select Cumulus / Edit > Preferences. 

3. Click Catalog Settings.

The Catalog Settings window is displayed. If the active collection window 
contains more than one catalog, select the catalog you want to edit under 
Catalogs.

4. Click General.

5. Under Copy Assets to Central Location, enable Use Central Asset Location.

The next step is to choose where to store the copies and which Asset Stor-
age module you want to use.

6. Click Browse. The Choose an Asset Storage Module dialog opens. 

http://www.canto.com/en/docs/exploring/Exploring-CentralAssetLocationsInCumulus7.pdf
http://www.canto.com/en/docs/exploring/Exploring-CentralAssetLocationsInCumulus7.pdf
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7. Select the desired module and click OK. The next steps depend on the 
selected module:

• Selecting the URL AssetStore opens a dialog for entering a URL.

Enter a valid URL of an existing FTP directory and click OK.
• Selecting a File System AssetStore opens a dialog to select a folder. 

Browse for the folder you want the asset to be stored in and then click OK. 
A further dialog appears offering options for the automatic creation of sub-
folders:

None: All cataloged assets are stored in the same folder
By Date: Subfolders are created on a daily basis. Assets cataloged on the 
same day are stored in the same folder. If two or more assets have identical 
file names, a unique identifier will be added to the file name.
By Unique Identifier: Every cataloged Asset gets it’s own folder and 
unique path where it is stored within the Central Asset Location.
Select the desired option and click OK.

• Selecting the Vault AssetStore opens the Select Remote Module dialog.

Select the computer running the file system or the Vault Server from the 
Computer field. Your next step is to decide whether you want the assets 
to be stored directly in the folder of the Vault Server or in a subfolder 
nested in the Vault Server folder. Such a subfolder is called a Vault Folder. 
Select the desired option. If you decided on Use Vault Server Directly, your 
next step is to click OK.
If you decided on Use Vault Folder, the list for selecting this folder is acti-
vated. Then your next step is to select the Vault Folder you want the asset 
to be stored in and click OK. 
NOTE: If a catalog is set as exclusive for a Vault Folder this folder cannot 
be used as a central asset storage location for any other catalog. If you 
want a catalog to be set as exclusive, you have to create a new Vault 
Folder for it. 

8. Select the mode for copying assets to the central asset storage location cho-
sen above. The mode determines when the Central Asset Location is used:

• As Set in Asset Handling Set – the Asset Handling Set employed for cata-
loging decides if assets are copied to the selected Central Location.
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• Always – Assets are always copied to the selected Central Location, regard-
less of the Asset Handling Set used.

• Always and Exclusive (available with Vault AssetStore only) – Assets are 
always copied to Vault and their asset storage location is exclusively Vault. 

9. Click Apply to save your changes and select the next catalog you want to set 
up for a Central Asset Location.
OR 
Click OK to save your changes and close the Preferences window.

When users catalog assets to this catalog from now on, the asset can be copied 
or will be copied to the selected Central Asset Location.

NOTE: Central Asset Locations and Asset Handling Sets
Every Asset Handling Set that is to be used with a Central Asset Location (for 
cataloging or access), must be configured with the Central Asset Location’s 
corresponding asset storage module activated. So, activate the Mac OS and 
Windows AssetStore modules for file system locations, the URL AssetStore for 
FTP locations and the Vault AssetStore for Vault locations. 

Customizing Field Properties 
The properties of a catalog field can be extensively customized. You can define:
• whether the field can be edited
• whether the field values should be based on formulas
• whether the visibility of the field is restricted, and to which users or roles
• whether and how the field is indexed for sorting and searching
• whether and how the record field is linked with the asset and its metadata 

fields
• and whether string fields support multiple languages
To access the properties of a record field: 

1. Make sure the collection window containing the catalog is the active win-
dow in Cumulus.

2. Select Cumulus / Edit > Preferences. 

3. Click Catalog Settings.

The Catalog Settings window is displayed. If the active collection window 
contains more than one catalog, select the catalog you want to edit under 
Catalogs.

4. Click Record Fields or Category Fields. This displays a list of the current 
record or category fields included in the catalog.

5. Select the entry for the field whose properties you want to change.

6. Check the Sorting, Contain Search and User Editable options for the field 
and activate the desired options. (See “Record and Category Fields Section,” 
p. 29, for all available options.)

7. Click the Properties button. This brings up a dialog in which you can set the 
properties for the field. The properties depend on the field type. (See “Over-
view: Field Properties,” p. 35, for all available options.)

8. Define the properties as you want them. 

9. Click OK to close the Field Properties window. This brings you back to the 
fields list. 
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TIP: Editing Field Properties of Multiple Record Fields At Once
Certain field properties can be activated or deactivated for multiple 
fields at once. On the record fields list, select the fields and use the 
alternate (right) mouse button to open a context menu. The menu 
options match the field properties you can (de)activate for multiple 
fields at once. 

Selecting a menu item opens a submenu that offers Enable and Dis-
able options. Select the desired option and the field property will be 
enabled/disabled for your selection of fields. If your selection of fields 
includes a field type that does not have the selected property, this field 
will just be ignored.

Editing Language-Specific Field Names
The names of fields as they are shown in the user interface (also known as display 
names) may be translated to different languages, in order to have them dis-
played in the language of the application or the preferred language, respectively. 
The names of the fields provided by Canto are already translated in several lan-
guages.
To edit language-specific names of a field

1. Open the Properties window of the field which display names you want to 
edit.

2. Click the  button to the right of the Field Name field.

The Field Name Editor window appears.  

3. Edit the Name fields for any desired language. Optionally, add a description 
in the respective language.

If a description exists, an info icon is displayed next to the name of the field 
in Info View, Info Window and Info Pane. Hovering the cursor over this icon 
will reveal the description in a tool tip.

4. Click OK.

The language-specific field names are changed accordingly.

5. If you are editing names of a multilingual field, you will additionally be asked 
whether you want to apply your changes to all additional languages. It is 
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strongly recommended to do so in order to keep the names of the multilin-
gual fields consistent in all languages.

6. Click Yes to apply your changes to all languages.

Example: The following table shows the display names of the multilingual field 
Headline as used in the user interfaces (UIs) of different languages. In addition to 
the field in the base language, multi language fields comprehend one extra field 
for each language enabled. To view or edit the content of these field, they must 
be added to View Sets, either individually or in any desired combination.
The base language of the field in this example is English; it is set to support two 
additional languages (German, French).

English Field German Field French Field
Display Name in the English UI Headline Headline (German) Headline (French)
Display Name in the German UI Überschrift (Englisch) Überschrift Überschrift (Französisch)
Display Name in the French UI Titre (Anglais) Titre (Allemand) Titre

verview: Field Properties
he Field Properties window reflects the field type. Most properties are the same but certain field types, e.g. an 
udio field cannot be used for indexing and an initial value does not make any sense. That’s why the properties 
ialog for this field type does not provide these fields.

eneral Tab
ield Properties

Field name. You can use this field to edit a field’s name.
Opens the Field Name Editor to enter/edit the display 
names and, if desired,  descriptions of the fields in other lan-
guages. Language-specific names will be displayed accord-
ing to the selected application language. The according 
field description will be displayed as the field’s tool tip in the 
information window, information view and information 
pane. Useful in multilingual environments. (See “Editing 
Language-Specific Field Names,” p. 34)
Displays the Field type. 
With String List Fields only: If activated, the users can select 
multiple values for this field in the Info View or the Informa-
tion window. The values are displayed with check boxes.
NOTE: Whether this option is activated or not influences the 
available indexing options. If activated, the field can be 
indexed for contain-searching but not for sorting. 
If activated, the visibility of the field is restricted to the users 
(and roles, if your Cumulus runs in role mode) specified here. 
Click the appropriate button (Add User or Add Role. Note 
that the Add User button is available only if you have the 
Browse for Users permission.) These buttons open a corre-
sponding dialog. For adding users, you can search for avail-
able users. The possible search criteria depend on the 
authentication method (see above). 

NOTE: Field visibility can not be restricted for users or 
roles with the “Modify Catalog Settings” permission. 
Such users/roles always can see all fields.

6 List of the users /roles which are allowed to see the 
field. 

7 Opens a dialog to search for users and add them to the
list. 

8 Opens a dialog to select roles and add them to the list.
9 Removes selected users from the list. 

3
1

2

4

5

7 8

6

9
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he options available depend on the field type.
0 Field can be used for sorting and searching. (Equivalent to 

the Sort/Search check box in the Field List column.)
1 The index for sorting records can be set language depen-

dent. Depending on the language selected for running the 
Client application the sorting will follow the rules of the lan-
guage. Activate the languages your users run the Client 
application in. Then a language specific sorting index will 
be created for each of the selected languages. And if the Cli-
ent application is started in one of these languages, a lan-
guage specific sorting of records can be provided.
NOTE: This applies to fields without multiple language sup-
port. For Fields with multiple language support enabled, 
refer to no 15! 

2 Field can be used for searching by means of the operators 
“contain” or “doesn’t contain.” (Equivalent to the Contain-
Search check box in the Field List column.)

3 If activated, searching the contents of String fields can be 
speeded up significantly. Use this option with care because 
it enlarges the catalog size. The optimization of the search 
index requires more memory in the catalog and therefore 
activating this option is only recommended for fields with 
little data content.

4 If activated, Cumulus provides an additional search func-
tion for the Find window and the Advanced Find window. 
You can search for whole words, not just for matching 
strings. Enclose the word you are searching for in single 
quotation marks and Cumulus will only find the records 
that contain the exact word. 

For example searching for copy will find records con-
taining the words copy as well as copyright, copy-
hold, copyfree and so on. Searching for ‘copy’ will 
find records containing the word copy only

15 Only when multiple language support is enabled: If 
activated, Cumulus provides language-specific sort-
ing of records for all languages enabled under the 
Languages tab. 

dditional Options
6 Field will be included in the Record pane’s drop-down list for 

sorting
7 Field will be offered as search criteria in the drop-down lists 

of Find windows and filter definitions.

verview: Field Properties
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ield Values Tab
he values of fields can either be defined by the user or be based 
n formulas.

If activated, the field value can be defined by the user.
Fills the field with an initial value (as defined in the field to 
the right). (See “Initial Value for Fields,” p. 39, for details.)
Allows a user to edit the field contents. (Equivalent to the 
User Editable check box in the Field List column.) 
If activated, the field must be filled with a value when meta-
data are edited. In the Information window or view, empty 
mandatory fields are marked with a special icon and a vali-
dator pane is displayed. Changed metadata can only be 
saved if all required fields are filled in. (For details, see “Man-
datory Fields,” p. 39.).
If activated, the content of the field must match certain cri-
teria, depending on the type of the field; either a defined 
regular expression (string fields), or specific values (fields 
that contain numbers and dates). 
Opens a dialog to specify a regular expression (string fields) 
or specific values (fields that contain numbers and dates) to 
be used as validators for the field content. 
With Cumulus Enterprise or permissions add-on products 
only: 
The Allow User to Edit property is enhanced by the option 
to restrict editing to specified users and roles only. If the 
Restrict Edit option is activated, you must add those users 
to the list you want to permit editing the field. Click the 
appropriate button (Add User or Add Role. Note that the 
Add User button is available only if you have the Browse for 
Users permission.) These buttons open a corresponding dia-
log. For adding users, you can search for available users.
The possible search criteria depend on the authentication 
method (see above). Default search criteria is the login 
name. Enter the search value (a string) and click the Find 
button. The result of this search is listed below. Select the 
user(s) you want and click OK. The users are added. When 
adding roles, Cumulus will list the available roles. Select the 
role(s) you want and click OK. The roles are added. 

9 If activated, the field values are based on the formulas
defined below. For details on how to define such for-
mulas, see “Field Formulas,” p. 40.

tring List Editor Tab
his tab is provided for String List fields only. See “Editing a String List Field,” p. 49, for details.)

verview: Field Properties
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anguages Tab (String Fields only!)
ultiple Languages

he contents of string fields may be kept in more than one lan-
uage. This is especially useful in multilingual environments, 
.g. to provide image captions in several languages. 
or each additional language, a new field is introduced to the 
atalog. However, these fields are not visible in the Record 
ields tab or the Category Fields tab of the preferences dialog, 
ut only from within the properties of the base field.
anguage-specific fields may be selected for display in Record 
iew Sets, e.g. to provide different view sets for different lan-
uages, or to display information in different languages simul-

aneously.
f multiple languages are enabled, Cumulus may be configured 
o display the field contents in the language that is specified for 
he client application. If no language field corresponding to the 
lient language can be found, the specified base language is 
sed instead. 

If activated, the content of the field may be kept in more 
than one language.
Displays and allows to specify the base language
Displays all specified languages for which sub-fields are 
introduced.
Opens a dialog for defining properties for the selected lan-
guage-specific sub-field.

5 Opens a dialog to select one or more additional lan-
guages for which a sub-field is introduced.

6 Removes selected languages from the list, and sub-
fields from the catalog. 

TIP: You may easily check which fields are configured for 
multiple language support. Just have the Multilingual 
column displayed on the Record Fields tab or the Cate-
gory Fields tab (see “Record and Category Fields Section,”
p. 29). Multilingual fields show an activated checkbox.

ield Linking Tab
inking

When cataloging assets, the selected record field will be 
filled automatically. (Read One: only the first matching field 
will be used).
When updating records, the selected record field will be 
filled automatically. (Read One: only the first matching field 
will be used).
NOTE: Do not activate this option if you want to keep the 
additional information you have entered. 
Before updating records, existing values will be removed 
from the selected record field. Allows to refresh the field’s 
contents from new asset values, without accumulating 
unnecessary metadata in the field.
Any changes in field contents will be written back to the 
asset, if the file format and the filter for the asset format sup-
port this function and if Always or Silently is enabled under 
Writing Metadata to Assets in the Asset Handling Set used. 
NOTE: Only if this option is activated for IPTC fields the IPTC 
information edited in Cumulus can be written back. 

ink Matching Fields
List of fields with the same GUID (globally unique identifier) 
or name and type that can fill data into the record field. If 
activated the asset field will fill the record field.
Activates/deactivates the selected field for matching.
If a new Filter module is added that provides any matching 
fields, these fields will be added and activated automati-
cally.

Also Link Following Fields
8 List of fields that are also linked. Use the Add/Remove

buttons to add/remove fields to/from this list.
9 Opens a dialog to select the field to be added.
10 Removes the selected field from the list.

eferenced Tab
Provides an overview of the View Sets, Metadata Templates and Print Templates that bear a reference to the field.

verview: Field Properties
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Defining Field Values
The values of fields can either be defined by the user or be based on formulas. If 
defined by the user, a field can have an initial value and you can allow users to 
edit it or even force them to edit it (mandatory fields).

Initial Value for Fields
To add a default text to a field (e.g. the Notes field) of all newly cataloged assets 
in a certain catalog, you have to enable the option Initial Value for the field and 
enter the text you want to have as default. If the asset’s metadata already contain 
a value for this field, the initial value will be ignored.
As the initial value of a String List field must be one of the terms you entered for 
the String List, you do not enter the initial value but select a term from the list 
provided when clicking the button next to the field.
The initial value of a Boolean field is “false” if the Active option is not checked. If 
you activate this option, the initial value is set to “true”. 

Mandatory Fields 
If the Mandatory Field option is activated for a field, the field must be filled with 
metadata when the metadata are edited. If windows or views which allow the 
editing of metadata contain empty mandatory fields, these fields are marked 
with a special icon and a validator pane is displayed at the bottom of the Infor-
mation Window or Information View. Changes to the metadata can only be 
saved if all required fields are filled in. 
The Mandatory Field option is available for the following field types: Data Size, 
Date, Date Only, Integer, Label, Length, Long, Rating, Real, Resolution, String, 
String List, Time Only.

NOTE: With automatic cataloging the mandatory option attribute is not con-
sidered valid but as soon as a user edits any metadata of a record that includes 
an empty mandatory field and is going to save the changes, a message 
reminds him/her when the record is saved. 

Table Fields
Table fields are special field type that can include other metadata fields. The 
properties of Table fields differ from other field types. 

This field type serves as the basis for the statistics and commenting available in 
Cumulus, and can serve as the foundation for new capabilities. For more infor-
mation on Table fields, contact Canto. 
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Field Formulas
Cumulus field values can be determined by formulas that are authored as part of 
a field’s properties. A formula can be as simple as the concatenation of two field 
values into a single string, or as complex as if-then decision making. 
Formulas can be assigned to record and category fields. Values for existing 
records and categories are calculated (or recalculated) when the record or cate-
gory’s metadata is saved after an edit. Formulas are executed during cataloging 
operations for newly created asset records and categories.
Field formulas offer many significant benefits:
Metadata display versatility Used in conjunction with “display only” metadata 
fields you add to your catalogs, field formulas enable you to provide users with 
data displays formatted in more meaningful ways. 
Example: A video’s Duration field might 
contain the value “25.566.” Even when dis-
played using the field’s label, the user sees 
“Duration: 25.566,” which could be more 
clear. A simple field formula can round that 
value and display it with adjacent strings 
that tell a more complete story: “Length: 26 
seconds.”
This also permits you to do away with 
including field name labels in thumbnail 
views by adding labels only to the fields 
that need them. In the image shown, nei-
ther the asset record name (top) nor the format field (bottom) require field name 
labels because their values make clear what the field is used for. By using a for-
mula to make the Duration field’s value more clear, three lines of vertical space 
are saved that would ordinarily be required for field names.
Another usage example would be to combine the values of the fields Horizontal 
Pixels, Vertical Pixels and the appropriate resolution field to provide a single line of 
commonly used information:
“2400 x 1200 @ 300 DPI”
This single formula, applied to the properties of a string field you add to your cat-
alog, saves you a full 5 lines of vertical space in your thumbnail display. The added 
string field ensures that each field’s original value remains intact.
Calculations Field values can be calculated to provide useful, searchable meta-
data values that would not otherwise exist in your catalogs without manual data 
entry. Example: say you have a field for Cost Per Use. Another field, Times Used, 
tracks how many times you’ve used the particular asset. A third field, Total Cost of 
Use, uses a simple multiplication formula to offer a sum of the total costs associ-
ated with the asset.
Workflow monitoring and guidance Field formulas can also set values in asset 
records that are later used as “flags” by managers, Live Filtering or Scheduler 
actions for further consideration. 
Metadata Write-back Flexibility The flexibility of the Cumulus architecture 
makes it possible (and easy) to use metadata taxonomies and field types that 
cannot be written back to assets because of the “string only” limitation of most 
metadata standards. You can circumvent this limitation in many cases by using 
formulas in conjunction with Cumulus’s Field Linking. By adding special “meta-
data write back” fields to your catalogs, you can add formulas that concatenate 
the contents of several fields (or fields with data types incompatible with write-
back operations, such as string lists) and “field link” them for write-back to your 
assets. 
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Category information not conventionally available Categories don’t have auto-
matic creation or modification date fields associated with them. In addition, 
there is no conventional way to determine which user created a category, or last 
modified its metadata. Field formulas make it possible (and easy) to track all this 
information and more. 
Generate printer-friendly reports Setting up formula-filled fields that you use on 
print templates offers you a great way to output metadata in formats suitable for 
review by others. Formulas enable you to combine metadata fields that would 
otherwise be “report hostile,” such as string lists, Booleans, and labels and ratings, 
into strings that fit nicely onto printed pages. Formulas also enable you to manip-
ulate metadata that you intend to export from Cumulus for use in other systems.

Syntax Overview
A field formula is an expression that returns a single value, which can be of type 
number, real, boolean, string, date, date only or time only. The constant value null 
can also be returned to represent an empty field value.
When applying operators on two values of different types, one or both values are 
converted into a compatible type. Example: (“Cumulus ” + 7.5) results in the 
string “Cumulus 7.5” because 7.5 is converted to a string before the + operator is 
applied. 
If an error occurs, the field’s value is set according to settings you determine 
while authoring the formula. (See “Multiplying the values of two catalog fields,” 
below, for details.) If no error occurs, the resulting value is automatically con-
verted to match the field’s type.
The arithmetic operators available are a subset of those available in program-
ming languages such as C, Java, or Java Script.

Formal Syntax
expression = bool_expression [ "?" expression ":" expression ]

bool_expression = { "!" bool_expression } | { comparison [ { "||" | "&&" 
} bool_expression ] }

comparison = expression { "<" | "<=" | "==" | "!=" | ">=" | ">" } 
expression

calculation = expression { "+" | "-" | "*" | "/" | "%" } expression

factor = function | value | true | false

function = identifier "(" [param [ "," param ] ] ")"

Function Reference
The Cumulus formula editor includes an in-line help reference that describes 
each function and how it can be used. The functions available may increase with 
each release of the software, so to be sure the information available is up to date, 
no function overview is provided in this guide. 
See “In-line Help,” below, for details.

Formula Examples
The following formula examples rely on specific catalog fields. If using these for-
mulas in your catalogs, make sure you substitute the same field names with fields 
from your own catalogs.
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Adding text labels, formatting output and rounding numeric values
Catalog field: disp_Duration (String)
"Length: " + String(fieldValue("Duration") , "%.1f")+ " seconds"

Duration field value: 3.467
Output: “Length: 3.5 seconds”
This formula takes the real value in the catalog’s Duration field, rounds it to a sin-
gle decimal place, and surrounds the resulting value with text strings. 
The "%.1f" portion of this formula will be familiar to those who have worked 
with the printf function available in many programming languages. Cumulus 
supports the following printf formatting options:

In addition, you may use the new line escape character "\n" within a string to 
force a line break where needed:
"Vertical: " + fieldvalue("Vertical Pixels") + "\n" +

"Horizontal: " + fieldvalue("Horizontal Pixels")

Multiplying the values of two catalog fields
Catalog field: disp_Megapixels (String)
fieldvalue("Horizontal Pixels") * fieldvalue("Vertical Pixels") / 
(1024*1024) + “ megapixels”

Horizontal Pixels field value: 3456
Vertical Pixels field value: 2304
Output: “7 megapixels”
This formula multiples the values of the Horizontal Pixel and Vertical Pixel fields, 
divides that value by 1,048,576 in order to get the number of megapixels in an 
image, and appends that value with a text string that describes the result.

If-then decision making
Catalog field: disp_Orientation (String)
(fieldvalue("Horizontal Pixel") == null || fieldvalue("Vertical Pixel") 
== null) ? "N/A" : ((fieldvalue("Horizontal Pixel") > 
fieldvalue("Vertical Pixel")) ? "Landscape" : (fieldvalue("Horizontal 
Pixel") < fieldvalue("Vertical Pixel") ? "Portrait" : "Square"))

Horizontal Pixels field value: 2400
Vertical Pixels field value: 1200
Output: “Landscape”
This formula compares values found in the Horizontal Pixel and Vertical Pixel 
fields. If the Horizontal Pixel value is larger, the image is determined to be “Land-
scape.” If smaller, it’s “Portrait.” If the two values are the same, the image is 
“Square.”

Data Type Supported Example

String s %-20.20s

Integer d, I, o, u, x, X %d

Real e, E, f, g, G %5.2f
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The Field Formula Editor
The field formula editor can be found under the Field Values tab of both the Cat-
egory and Record Field Properties windows.

When using a field formula, a field’s value cannot be edited directly by users. For 
this reason, the window uses radio buttons to permit either “user generated” or 
“formula based” values.
The main text area of the formula editor is where you’ll define your formulas. The 
interface elements of the editor are: 

Construct your formulas in the text field provided. Take advantage of the Fields 
and Functions drop-down lists to save time and help you avoid syntax errors 
introduced by simple typos. 
Choose your preferred option for error handling. An error occurs when for what-
ever reason your formula cannot be executed. Errors can include syntax issues in 
the formula itself, or problems evaluating field data used in the formula.
When you click OK to dismiss the Field Properties window, your formula is saved 
and activated. 

NOTE: The order in which fields are calculated cannot be determined abso-
lutely. For this reason, take care when creating formulas that are dependent 
on other field values also based on formulas. If needed, consider “wrapping” 
one field’s formula into the formula of another field, thereby forcing the order 
of calculation. Example:
Field "A" formula: fieldvalue("B") * 1.5
Field "B" formula: fieldvalue("Image Height") + 3.0
This may result in unexpected results if field "A" is evaluated before field "B". The 
solution is to include the field "B" formula in the formula of field "A":
Field "A" formula: (fieldvalue("Image Height") + 3.0) * 1.5

Formula Editor

1 The formula editing field 
2 List containing all catalog fields
3 List containing all functions
4 Option for not changing field value on for-

mula error
5 Option for clearing field value on formula 

error.
6 Option for using a fallback string value on 

formula error 

Under the Field Values tabs of the Field Properties windows for records (left) and 
categories (right) lies the field formula editor. The record formula here produces 
the field display shown in the image at the start of this section. The category for-
mula uses the user data record information to fill the “Last Modified By” category 
field with the logged-in users name and email address.

1

2
4

6

3

5
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In-line Help
An in-line function and syntax reference is built into the formula editor. This fea-
ture provides a handy reference that will save you time and help you avoid syn-
tax errors.
Three types of in-line help are available:
• Syntax reference – See an example of the syntax used with a function.
• Usage reference – See information about the purpose of a function, the value 

it returns, and a usage example.
• Autocompletion – See a menu list of functions whose names match charac-

ters you’ve typed.
To activate in-line help:

1. Click to place your cursor within the function’s name in the formula editing 
field.

2. Type CTRL p (syntax reference) or CTRL q (usage reference). The usage refer-
ence help window that appears may be resized as needed.

Both windows disappear when another key is pressed or the mouse is 
clicked in the Formula editing field itself. (Hint: Escape, Shift, CTRL or ALT are 
good keys to use to dismiss the window because they don’t introduce any 
new characters into the Formula field.)

3. For function name autocomplete assistance, type the first few characters of 
a function’s name and press CTRL-Spacebar to see a list of functions whose 
names match the characters you’ve typed.

Field Linking 
Some asset formats (e.g., JPEG) can store metadata. Cumulus can read, store and 
manage this metadata by linking it to record fields. The record fields are provided 

Place your cursor right after a function name and type CTRL-p for a quick syn-
tax reference, or CTRL-q for an in-depth overview of the function (shown).
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Linking Option
by the Cumulus application, the Asset Storage modules, Metadata modules, and 
the filters. 
You can decide when the linking should happen (when cataloging assets and/
or updating records), and whether changes to the metadata should be written 
back to the asset. Changed metadata can only be written back if this function is 
supported by the file format, the filter and Asset Storage module used for access-
ing the asset.
If the record field’s type is String, you can also decide whether the linking applies 
to all or only the first matching asset field. If the Read All option is activated, the 
values of the linked fields are read consecutively. Under Link Matching Fields, all 
fields which “feed” the field are listed – fields that have the same GUID (Globally 
Unique Identifier) or name and type. If the Read All option is activated, Cumulus 
will fill the record field with the data from all activated modules. If a module is 
deactivated, its data are “ignored” by Cumulus. 

NOTE: Field Linking Checks for Field Types
In addition to its own type, a field may be linked to certain other field types 
only.
– Integer fields accept: String, Boolean, Real
– Real fields accept: String, Boolean, Integer
– Boolean fields accept: String, Integer, Real
– Date fields accept: String
– String List fields accept: String
– String fields accept: Boolean (true, false), Integer, Real, Date, String List (exact 
string matching)
– Binary fields accept: Audio, Picture

Automatic Creation of Folder Categories 
The fields linked to Categories record field are responsible for the automatic cre-
ation of folder categories in a catalog Under which tab (master category) such a 
folder category is created, is defined under Category Target. You can change the 
default target by clicking into the field and selecting another tab..

If you don’t want automatically created folder categories in a catalog, you have 
to deactivate the corresponding modules. 

s of a String Field

Field Linking of the Categories Field
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To avoid the automatic creation of folder categories you have to change the 
default linking of the Categories field:

1. Make sure the collection window containing the catalog is the active win-
dow in Cumulus.

2. Select Cumulus / Edit > Preferences. 

3. Click Catalog Settings.

The Catalog Settings window is displayed. If the active collection window 
contains more than one catalog, select the catalog you want to edit under 
Catalogs.

4. Click Record Fields.

5. Select the field named Categories and click the Properties button. 

6. Click Field Linking.

7. Select the module which to be deactivated (the one that should not create 
categories during the cataloging process. e.g. Windows or Mac OS File Sys-
tem AssetStore).

8. Click Deactivate. 

9. Click OK. This brings you back to the fields list. 

10. Click Apply to save your changes. If you now catalog assets employing this 
module, no directory categories will be automatically created and assigned 
to the record.

Adding Fields
To store information in addition to or different from the default settings, you can 
add fields to the catalog either by activating them from the list of fields that 
Cumulus supports or by defining a custom field.
To add a record or category field:

1. Make sure the collection window containing the catalog is the active win-
dow in Cumulus.

2. Select Cumulus / Edit > Preferences. 

3. Click Catalog Settings.

The Catalog Settings window is displayed. If the active collection window 
contains more than one catalog, select the catalog you want to edit under 
Catalogs.

4. Click Record Fields or Category Fields. This displays a list of the current 
record or category fields included in the catalog.

5. Click the Add Field button. This opens the dialog Add Field. 
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This dialog provides three tabs. Two of them can be used to add fields that 
Cumulus supports, but that are not currently in the catalog. You can either 
select the field to be added from an alphabetically sorted list or from a tree 
structure that lists the fields sorted by the module that provide the fields. 

• The Modules tab, displaying nodes: Catalogs, Catalog Templates, Mod-
ules and Languages.
– The Catalogs nodes expands to a list of all catalogs open in the active col-
lection. Clicking the plus sign in front of a catalog’s name displays all fields 
of that catalog that are not included in the catalog you want to edit. Either 
select the name of a catalog to add all contained fields, or select the indi-
vidual fields you want to add.
NOTE: If the Catalog node includes the catalog that you are editing 
itself, this catalog contains table fields (e.g. Asset Usage History). Table 
fields introduce a second level into the catalog, as they themselves con-
tain fields, which may or may not be contained in the top level, or in 
any other table field, too. At any level of the catalog – top level or table 
field level – the Catalog node offers the fields, that in fact belong to this 
catalog, but not to the current level.

– The Catalog Templates nodes expands to a list of all available catalog 
templates. Clicking the plus sign in front of a catalog’s name displays all 
fields of that catalog template that are not included in the catalog you want 
to edit. Either select the name of a catalog template to add all contained 
fields, or select the individual fields you want to add.
– The Modules node expands to a list of all Cumulus modules that provide 
fields. Clicking the plus sign in front of a module’s name displays the fields 
supported by the respective module that are not included in the catalog 
you want to edit. Either select the name of a module to add all fields sup-
ported by that module, or select the individual fields you want to add.

– The Languages node expands to a list of all languages configured for 
string field values. Clicking the plus sign in front of a language name dis-
plays the fields that support values in the respective language that are not 
included in the catalog you want to edit. Either select the name of a lan-
guage’s to add all respective fields, or select individual fields to be added.
Additionally, all language independent fields that are not included in the 
catalog are listed and can be added.
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• The Fields tab displays a list of all the fields that are not yet included in the 
catalog.

The third tab, the Custom Field tab, enables you to define your own custom 
fields so you can store information in addition to fields that Cumulus sup-
ports. See “Creating a Custom Field,” below, for details.

6. Select the field(s) you want to add.

7. Click OK. This brings you back to the fields list. 

8. Click Apply to save your changes.

NOTE: If you want this field to be shown in a view, you have to customize the 
corresponding view set and add this field. (See Client User Guide, section “Add-
ing a Field to a Record View”, for details.)

Creating a Custom Field
To set up a catalog to store information in addition to fields that Cumulus sup-
ports, you can define your own custom fields.

NOTE: Same Custom Field for Multiple Catalogs
If you have created a custom field for one catalog, you can easily copy this field 
to another catalog. If multiple catalogs are opened in the same window, 
Cumulus will display the custom record fields of all these open catalogs in the 
list of the Fields tab. You can select a custom field of another catalog and add 
it to the current catalog. We recommend using this way of adding the same 
custom field to several catalogs, as only then will the field have the same GUID 
(Globally Unique Identifier) in different catalogs. And only when the GUID is 
the same, a custom field can be used for searching in different catalogs. 
Another advantage is that fields of the type String List already include the 
entries that have been made. 

With a standard Workgroup Edition you can create custom record fields only. An 
Enterprise Edition or an corresponding add-on product enables you to create 
custom category fields, too.
To add a custom field:

1. Make sure the collection window containing the catalog is the active win-
dow in Cumulus.

2. Select Cumulus / Edit > Preferences. 

3. Click Catalog Settings.

The Catalog Settings window is displayed. If the active collection window 
contains more than one catalog, select the catalog you want to edit under 
Catalogs.
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4. Click Record Fields or Category Fields. This displays a list of the current 
record or category fields included in the catalog. 

5. Click the Add Field button. This brings up a dialog in which you can add a 
new field. 

6. Click the Custom Field tab. 

7. Enter a name for the field and select the type of field. (For information on 
field types, see “Field Types” in the Client User Guide.)

8. Click OK. The new field is added to the list of fields included in the catalog. 

9. Define the field properties. 

• In the list you can activate certain options
– Sorting
– Contain Search 
– User Editable: If this is not checked, the field contents cannot be modi-
fied.

• In the Field Properties dialog you can define more options for the field. 
Select the field’s entry in the list and click the Properties button. The 
options available from the Field Properties dialog depend on the field type. 
For details, see “Overview: Field Properties,” p. 35.

10. Click OK to close the Field Properties window. This brings you back to the 
fields list.

11. Click Apply to save your changes.

If you want this field to be shown in a view, you have to customize the corre-
sponding view set and add this field. (See “Adding a Field to a View” in the Client 
User Guide for details.)

Editing a String List Field 
To edit the entries of a String List field, the Field Properties dialog for the field 
must be displayed. The String List Editor tab lets you view and edit the terms of 
the selected String List.

Each term has an ID and can be stored in multiple languages. This is only impor-
tant when working in a multilingual environment. If you want users who open 
the catalog with another language version of Cumulus to see the term in this lan-
guage, you have to store the translation of this term. Depending on the language 
version of Cumulus, the term in the corresponding column will be displayed.
The String List Editor tab lets you edit an existing entry, add a new term or delete 
an existing term by using the corresponding buttons. Save any changes you 



50 CUMULUS® –  ADMINISTRATOR GUIDE
make with the OK button of Field Properties window. They are valid as soon as 
you click the Apply button to save your Catalog Settings.
To edit a term of a String List field, just select its entry in the list and double-click 
the term you want to edit.
To create a new term for a String List field:

1. Click Add. 

2. Enter the new term in the dialog that appears and click OK.

The new term appears in each language field of the list. 

If you are working in a multilingual environment, you can now double-click the 
field for a language and enter the translation for the term. A user will only have 
the terms of one language displayed. The language a user gets displayed initially 
depends on the language defined during the installation, but can be changed by 
the user anytime.
You can edit a term of a String List field at any time:

1. Select the entry for the term you wish to edit.

2. Double-click the term in the language you want to edit in and type the new 
term in the field.

The term will be changed in all records that use it when you have saved the 
changes and closed the Properties window.

You can define the sorting of the terms of a String List field. You can select differ-
ent sorting modes for a String List field:
• Alphabetical (default sorting mode) 

The terms of the String List field will be displayed sorted alphabetically 
according to the rules of the language of the application (e.g the Cumulus 
Client). This sorting mode is useful for e.g. keywords.

• Content
The terms of the String List field will be displayed as sorted in this list – inde-
pendent from the language defined for the user. This sorting mode is useful 
for e.g. status descriptions. Use the arrow buttons to the right of the list to 
change the order of the entries.

• Language Specific
This mode allows you to define different sort orders for different languages. 
This sorting mode is useful for e.g. country selection where depending on 
language, different countries should appear on top of the list.
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The sorting mode displayed for the String List field in the Select Mode field is the 
active mode, once you click OK for the Field Properties dialog.
If you want to define a sorting mode other than alphabetical: 

1. Select the Sorting Mode.

2. In case you decided on the Content sorting mode, use the arrow button on 
the right to define the order of the terms.

3. In case you decided on the Language Specific sorting mode, select a lan-
guage and then use the arrow button on the right to define the display 
order of the terms of the selected language. Repeat this for each language.

You can delete an entry that you no longer need and replace it with another 
entry. 
To delete an entry:

1. Select the entry you wish to delete.

2. Click Remove. 

Cumulus prompts you to assign a new entry to those records or categories 
and displays a list of terms (in the language that is defined for you as 
Cumulus user).

3. Select a replacement entry from the list and click OK. The new entry is 
assigned to all records previously associated with the deleted entry. This 
may take a while, depending on the number of records that require reas-
signment.

Preparing Catalogs for Special Purposes
Cumulus catalogs can serve various purposes. For some special purposes cata-
logs require special preparations. 

Optimizing Standard Metadata Format Support
Cumulus supports the standard metadata formats IPTC, EXIF and XMP. To pre-
pare a catalog to support these standards Cumulus offers wizards. See “Prepare 
Catalog” in the Client User Guide, for details
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Configuring Web Links
The Cumulus Client offers a function that enables users to get Web link URLs for 
selected records, their assets, thumbnails or previews (Asset > Configure Web 
Link URL.) The links will work only if your Cumulus installation includes Cumulus 
Web Client or Sites and the catalogs containing the records are set to be pub-
lished in the Internet (Catalog Settings > General). The catalogs must:
• contain the following record fields (provided by the Cumulus application 

module): 
– Asset URL enabled (allows users to get links for the assets)
– Preview URL enabled (allows users to get links for the previews)
– Thumbnail URL enabled (allows users to get links for the thumbnails)
Note that if a catalog does not contain one of the corresponding fields the 
respective links cannot be created by any user. 

And also following prerequisites are needed:
• The function is available to users only if at least one Base URL for Web Access 

is defined in the Cumulus Server Settings (Server Console > Remote Admin> 
Settings). (See “Cumulus Server Settings,” p. 83,for details.)

• In order to be able to configure Web link URLs, a user must have permission 
to write metadata for the catalog containing the respective records. 
• If using the User Manager in advanced mode the following Application 

Permissions for records:
– Modify Items 

• If using the User Manager in simple mode the following permissions:
– Write Metadata

• The configuration file of the Cumulus Web Client, web.xml, must be edited. 
(You can find the file in the subfolder WEB-INF of the webclient folder inside 
the webapps folder of your Web application server folder, e.g.: C:\Program 
Files\Canto\Cumulus Web Solutions\apache-tomcat-7.0.26\webapps\webclient\WEB-
INF\web.xml.) Edit it as follows:
• To specify the Cumulus Server that opens the given catalog, replace the 

parameter value for the parameter 
com.canto.cumulus.web.directurl.server 
with the IP address or name of the appropriate server

• To specify the (technical) user that is used to login on that Cumulus Server, 
replace the parameter value for the parameter 
com.canto.cumulus.web.directurl.user 
with the name of that user.
HINT: This user must be able to open the respective catalog!

• To specify the password of that user, replace the parameter value for the 
parameter 
com.canto.cumulus.web.directurl.password 
with the password, or leave it empty if no password is required.

Securing Catalogs 
To prevent an unforeseen technical mishap from damaging or destroying your 
catalogs you should have a strategy. Cumulus offers the following mechanisms 
to preserve catalog data in case of a failure:
• Backing up 
• Journaling 
• Mirroring
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Canto recommends you to backup your catalogs regularly and in addition, to 
avoid losing changes made to a catalog after the most recent backup, employ 
either catalog journaling or mirroring as a second mechanism. Which mechanism 
is best depends on your needs. 
The advantage of journaling is that you can immediately continue working after 
a failure. 
Use mirroring for a catalog that is intended to serve as a ‘caching engine’ which 
for example saves data into an external SQL-compatible database Or with a sec-
ond Cumulus Server, you can use mirroring for failover functionality and load bal-
ancing. The disadvantage of mirroring is that rebuilding a catalog from its mirror 
database might be very time consuming. (For a description on how to rebuild 
catalogs from mirrors, see “Repairing Catalogs,” p. 64.)

IMPORTANT! Do not employ journaling and mirroring for the same catalog! Use one 
of the mechanisms depending on how the catalog is used. 

For backing up your catalogs regularly, Canto recommends you to use the 
Cumulus Backup Manager and in addition, to have rotating backups, you should 
include the catalog files in your regular system backup provided by your server 
platform. (For a description on how to use the Backup Manager, see “Backup 
Manager,” p. 75.)

TIP: Avoiding Improper Shutdowns of the Cumulus Server
To avoid improper shutdowns of the Cumulus Server always stop the 
Cumulus Server before you make any changes to the operating sys-
tem that might cause a shut down of the system (e.g. updates). Shut-
ting down the Cumulus Server might take a while depending on the 
number and size of catalogs managed by the Cumulus Server. Do not 
interrupt the shutdown process!

Windows only: When stopping a Cumulus Server under Windows 
check that the Cumulus Server service has stopped. You can check this 
either via the Services Control Panel using the Refresh function (F5) or 
via the Task Manager (no Cumulus Server.exe in the processes list.)
UNIX only: When you are stopping a Cumulus Server under UNIX and 
stop-cumulus.sh runs into a time-out, use status.sh to check that the 
Cumulus Server has stopped.

The next sections give more details on the journaling and mirroring mechanisms 
and describe how to activate them.

Journaling Catalogs
Journaling Cumulus catalogs improves data security. A journaling catalog logs 
changes to a journal (special circular log files) before actually writing them to the 
catalog. Such a journal is used to repair any inconsistencies that occur as a result 
of an improper shutdown of the Cumulus Server or the computer running the 
Cumulus Server. In the event of an improper shutdown, a given set of changes 
may have either been fully committed to the catalog (i.e., written to the hard 
disk), in which case there is no problem, or the changes will have been marked 
as not yet fully committed, in which case the system will read the journal, which 
can be rolled up to the most recent point of data consistency. Every time a 
Cumulus Server opens a catalog the journals will be read and executed.
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SPECIAL TECH INFORMATION:  Cumulus Catalog Journal
A Cumulus catalog journal consists of 5 circular log files named as the 
catalog file with the extension .redo. These log files are saved along 
with the catalog file in the same folder. Each of these files has an initial 
size of 20 MB and the files can become quite large. The required space 
differs; as rule of thumb: twice the size of the catalog file is recom-
mended. 

IMPORTANT! Copying or Moving Journaling Catalogs
When copying, moving or backing up a catalog externally, the journal of the catalog 
(all 5 *.redo log files) must be included, e.g. copied or moved along with the catalog 
file. 

IMPORTANT! Using Backup Files Created by Cumulus
If you want to replace a damaged catalog file of a journaling catalog with a backup 
file created by Cumulus, you must delete the journal of the catalog (all 5 *.redo log 
files) before you copy and/or rename the backup file. 

You activate journaling for a catalog in the Catalog Settings ( Cumulus / 
Edit > Preferences > Catalog Settings > General.)

Database Mirroring
Mirroring enables you to use the Cumulus database as a ‘caching engine’ that for 
example saves data into an external SQL-compatible database. In this role, a 
Cumulus catalog serves as a permanent cache.
Saving the data in an SQL database offers the advantage that any SQL analyses 
are possible. However, changes made to the catalog data from within the SQL 
database are not copied back to Cumulus and therefore should not be made. 
When a mirrored catalog is rebuilt, the SQL database serves as master. Each cat-
alog requires its own SQL database.
Canto provides a plug-in that includes support for different SQL database sys-
tems. (The support for Oracle is available with Cumulus Enterprise only.) If you 
require support for another database system, contact Canto. Each database sys-
tem requires it own JDBC driver. The JDBC drivers for most systems are pre-
installed; except one: The official JDBC driver for MySQL must be downloaded 
from the MySQL website (www.mysql.com). Currently the driver is available 
under: 
http://dev.mysql.com/downloads/. The driver must be copied to the appropriate sub-
folder of the esp folder in your Cumulus Server installation folder. The subfolder 
dbmirror contains a folder named lib. Copy the downloaded driver into this lib 
folder (e.g to ..esp/dbmirror/lib).
Cumulus catalogs of a second Cumulus Server installation can also serve as mir-
roring target databases. For more information, see “Using Cumulus Catalogs as 
Mirroring Target Databases,” p. 56.
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A catalog is set up for mirroring on the Mirroring tab of a catalog’s settings 
( Cumulus / Edit > Preferences > Catalog Settings.) 

PRECONDITIONS: To set up a catalog for mirroring, you must have the appropri-
ate Administrator permissions (Permissions > Administrator Permissions > 
Manage Mirroring (option for the Modify Catalog Settings permission.) 
If you want to use mirroring, you should activate it directly after you have 
installed Cumulus, or after new catalogs are created. Note that once you activate 
the mirroring option for a catalog, the initialization can take some time, depend-
ing on the size of the catalog. (And the process cannot be paused – if interrupted, 
it must be started from the beginning.)

NOTE: Never set up multiple catalogs for mirroring at once! 
Start the process for a subsequent catalog only after the previous catalog has 
been completely processed. 

If mirroring is activated, the events to be saved in the SQL database are written 
in a task queue. For safety reasons, each task is saved in a temporary internal file. 
This file is deleted after the task is successfully processed. Storage locations for 
the queues and safety files are defined in the server.xml file found in the conf 
folder in the Cumulus Server installation folder. You define the basic or “root” 
folder for the files. This folder will house the subfolders for the queues—one sub-
folder for each queue (named as the unique identifier given for the queue). The 
default storage location is the Cumulus Server installation folder. If you want to 
use mirroring, you should define the storage location directly after you install 
Cumulus. The collection of these files can become quite large, requiring ample 
storage space. The required space depends on the SQL database system and the 
amount of data stored in each asset. There is a difference between the initial pro-
cess and normal operation. As rule of thumb: twice the size of the mirrored cat-
alog file is recommended. 
Note that if you have a catalog mirrored to a SQL database, you should back up 
the target database and not the original Cumulus catalog. For information on 
how to repair a mirrored catalog using the target database, see “Repairing Cata-
logs,” p. 64. 

Example dialog for setting up mirroring. The fields for defining the database 
depend on the selected database system. 
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Error Management
Basic mirroring errors are written to the system log of the Cumulus Server (e.g. 
when mirroring could not be started.) Errors that occur while mirroring is running 
are logged as configured in the log4j.xml file, which is found in the conf folder 
in the Cumulus Server installation folder. Canto recommends you have one log 
file for all mirroring events and set up email notification for all errors that occur 
while mirroring. 
If the SQL database addressed by mirroring is not available, an error will be 
logged and the Cumulus Server will try to process the current task again and 
again. As soon as SQL database is available again, the process is resumed auto-
matically. However, if it cannot be resumed, the size of the task queue will grow 
with any change performed on the catalog.

TIP: Finding the Short ID of a field.
To find out the IDs of a field you can have them displayed in the list of 
fields in the Record Fields tab or the Category Fields tab of the Cata-
log Settings (Edit > Preferences > Catalog Settings). 

BACKGROUND INFORMATION:  Performance
The performance depends on the SQL database system in use. During 
normal runtime testing, Canto did not experience performance delays 
or differences between different SQL database systems. The time 
needed for the initial process, however, depends on the SQL database 
in use. The time needed for the initial process is also influenced by the 
cache size available for the Cumulus Server (can be configured in the 
Server Console: Remote Admin > Settings > Optimization.)

Using Cumulus Catalogs as Mirroring Target Databases
Cumulus catalogs can also serve as mirroring target databases. This requires a 
second Cumulus Server installation. Then one Cumulus catalog can be mirrored 
to another Cumulus catalog of the other Cumulus Server installation. This offers 
failover functionality and load balancing. A target Cumulus catalog at the sec-
ondary Cumulus Server is set to read only. With read-only applications (e.g. Web 
Publisher Pro) it can be used as a read-only replica and take load from the primary 
Cumulus Server. Note that Cumulus Triggers only work in the original catalog. 

NOTE: Mirroring Cumulus 6 Catalogs
If you mirror a Cumulus 6 catalog, the target catalog will always be a 
Cumulus 7 catalog. 

When using Cumulus as target database system, the following data are required 
to define the database serving as mirror: 
• Server – IP address of the computer hosting the Cumulus Server
• User – Login name of the Cumulus Administrator of the Cumulus Server used 

as mirror. 
• Password – Password of the Cumulus Administrator of the Cumulus Server 

used as mirror.
• Database Path – Path of the Cumulus catalog file 

NOTE: You can either enter the path of an existing catalog or have a new 
one created by entering its path. 
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Setting up a Catalog for Mirroring
Before you activate mirroring for any catalog, the location for queues and the 
task safety files should be configured. The location is defined in server.xml file, 
which is found in the conf folder in the Cumulus Server installation folder.
The initial process setting up a catalog for mirroring takes some time, depending 
on the size of the catalog file and the SQL database system in use. During this 
time, other users are blocked from accessing the catalog. For this reason, Canto 
recommends you deactivate the sharing option for this catalog before you start 
the initial process. 
To set up a catalog for mirroring:

1. Make sure the collection window containing the catalog is the active win-
dow in Cumulus.

2. Select Cumulus / Edit > Preferences. 

3. Click Catalog Settings.

The Catalog Settings window appears. If the active collection window con-
tains more than one catalog, select the catalog you want to edit under Cata-
logs.

4. Click Mirroring. This displays the current settings for the selected catalog. 

5. Activate the Use Database Mirroring option.

The fields for the mirroring target database are activated.

6. Select the database system you want to use. Depending on the selected 
database system, the fields for defining the actual database are displayed. 

7. Enter the data required. You must define a different target database for each 
catalog to be mirrored.

Example: With a MySQL 5 database, the following data are required:

• Server – IP address of the server hosting the SQL database
• Database – Name of the SQL database 
• User – Login name of the SQL database user 
• Password – Password for the SQL database user
NOTE: If the target database is another Cumulus catalog, you can either 
enter the path of an existing catalog or have a new one created by enter-
ing its path. 

8. Click OK to start the mirroring. The field below the definition fields informs 
you on the status of the mirroring.

NOTE: If you want to set up multiple catalogs for mirroring, don’t start the 
process for the next catalog before the current catalog has been com-
pletely processed. 

To stop the mirroring for a catalog, deactivate the Use Database Mirroring 
option and confirm the action by clicking Apply or OK. Before you stop the mir-
roring you should consider that starting it again, will start the mirroring for the 
entire catalog from the beginning again. 
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New Catalogs
New catalogs can be created by the Cumulus Administrator only. The Cumulus 
Administrator is also responsible for providing catalogs to Client users. 

Creating Catalogs

To create a new catalog you can log on to the Cumulus Server from any Cumulus 
Client and tell the Server where the catalog is to be stored and what you want to 
call it.
To create new catalogs for your workgroup:

1. Log on as Cumulus Administrator to the Cumulus Server (see “Logging On 
as Cumulus Administrator,” p. 16).

2. In the Catalog Access window, click New.

The Create New Catalog window appears.

3. Click Browse.

The Browse window appears:

4. From the Look In drop down menu, select the location where the new cata-
log shall be stored. (Only locations approved by the Cumulus Administrator 
are accessible).
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5. In the File Name field enter a name for the new catalog, then click OK.

The Browse window is closed. In the Location field of the Create New Cata-
log window, the location and the name of the new catalog are displayed

6. From the Select a Template drop down menu, select a   template.

7. Click OK.

The new catalog now appears in the catalog list of the Catalog Access window.

Catalog Templates
You can define templates that you can use to create new catalogs, prepare exist-
ing catalogs for specific usage or even update older catalogs. There’s no faster 
way to get new catalogs up and running, or to consistently replicate updates 
made to one catalog on another catalog. Create new, pre-configured image 
databases, video catalogs, PDF archives and more, from a single menu item – no 
more redundant catalog tweaking necessary!
PRECONDITIONS: To create and edit Catalog Templates, you must have the 
appropriate permissions (Server Permissions > Catalog Template Permissions.) 

Creating and Editing a Catalog Template
To create a new Catalog Template you can save the settings of an existing cata-
log as Catalog Template or duplicate a template.
To create a new Catalog Template by duplicating an existing one and adapting 
its settings:

1. Select Cumulus / Edit > Preferences. 

2. Click Catalog Templates.

3. Under Template, select the Catalog Template to be used as a basis for the 
new one.

4. Click the Duplicate button. The Name and Settings dialog opens.

5. Enter a name for the new template, and optionally

• Activate the Allow Sharing option, if you want this view set to be available 
to other users.

• Activate Copy display names only, if you also want to take over the lan-
guage-specific display names from the original (not recommended for 
new catalog templates).

• Activate Copy description only, if you also want to take over the descrip-
tions specified for other languages from the original (not recommended 
for new catalog templates).

6. Click OK. The Catalog Template window is displayed.

7. Define the new Catalog Template. 

8. Click Apply to save your changes.

To create a new Catalog Template by saving the settings of an existing catalog 
as Catalog Template:

1. Select Cumulus / Edit > Preferences. 

2. Click Catalog Settings.

3. Under Catalog, select the Catalog to be used as a basis for the new Catalog 
Template.
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4. Click the Save as Catalog Template button. The Name and Settings dialog 
opens.

5. Enter a name for the new template, and optionally

• Activate the Allow Sharing option, if you want this view set to be available 
to other users.

• Leave Copy display names activated, if want to take over the display 
names specified for other languages from the original.

• Leave Copy description activated, if you want to take over the descriptions 
specified for other languages from the original

6. Click OK. 

To change an existing Catalog Template:

1. Select Cumulus / Edit > Preferences. 

2. Click Catalog Templates.

3. Under Template, select the template you want to edit. The settings for the 
selected template are displayed in the Catalog Template window.

4. Make your changes. 

5. Click Apply to save your changes.

The Catalog Template Window
The Catalog Template window controls several important factors that come into 
play while managing assets. The options are divided into the following sections:
• General – Options for Catalog Templates

– Keep Category Names Unique – Prevents the creation of new categories 
that share names with existing categories.
– Use Journaling – Activates journaling for the catalog. (See “Journaling Cat-
alogs,” p. 53)
– Use Template for Catalog Creation – Makes the template appear in the 
Get Catalog Template dialog when creating a new catalog. So do not acti-
vate this option, if you want to use a Catalog Template for preparing other 
catalogs only. 

• Record Fields – Displays the record fields that a new catalog will contain. You 
can add or delete fields and customize selected fields. This allows you to 
organize the information that can be stored on an asset in its record. Remem-
ber, metadata retrieved from assets while cataloging can only be stored if the 
corresponding record fields are included in the catalog. For details on how to 
add and configure record fields, see the corresponding descriptions in the 
chapter “Catalog Settings,” p. 28.

• Category Fields – Displays the category fields that a new catalog will contain. 
You can add or delete fields and customize the fields. For details on how to 
add and configure category fields, see the corresponding descriptions in the 
chapter “Catalog Settings,” p. 28.
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TIP: Using Catalog Templates to Update Older Catalogs
You can use Catalog Templates to provide specific catalog fields for 
other catalogs. When adding fields to a catalog, click on Modules and 
you are also offered the fields of Catalog Templates.

Catalog Maintenance 
Taking regular care of your catalogs ensures not only the best performance, but 
also your data security.

Catalog Size and Performance
The biggest factor affecting catalog size is the number of records in the catalog. 
There is no hard limit on the number of records that a catalog can hold, but cat-
alog files cannot be larger than one terabyte.
As multiple catalogs can be opened in one window, an advantage of this is that 
it makes it easier to search for an asset. Workgroups with large catalogs can now 
split them into multiple catalogs and be able to open and search them in one 
Window. The beauty of smaller catalogs is that, the time required to repair, 
restructure or reorganize a catalog is reduced tremendously. Furthermore, if a 
particular catalog is being repaired or restructured, the assets in the other cata-
logs will be unaffected and can still be accessed.
Search times, however, are not affected by catalog size. 

Record Size
The actual number of records you can fit into the catalog size limit depends on 
the individual records’ sizes. Factors that determine a record’s size include:
• The type of asset the record represents. Different asset types have different 

information that needs to be stored to identify them, so their records use 
varying amounts of catalog space. For example, a video clip uses space for 
frame rate and total frame number fields that a simple image doesn’t require.

• The amount of text in the record’s Notes field. All those characters in the 
Notes field have to be stored somewhere! If you add 1k worth of text, you add 

Catalog Templates can be used to update 
existing catalogs or prepare them for spe-
cific usages.
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1k to the record size. Multiply that times a thousand or so records and you 
have added an entire megabyte to your catalog’s size.

• The record’s thumbnail size and quality. Larger and higher quality thumb-
nail images take up more space. (See “Catalog Settings,” p. 28, for information 
on thumbnail settings.)

Typically, your catalogs will never reach the maximum size. If they do, you’ll need 
to divide them. (See “Dividing Catalogs,” p. 66.)

Speeding Up Cataloging
As a catalog grows, the time required to catalog new assets increases. There are 
a few tricks for Asset Handling Sets that you can do to increase performance 
when cataloging large amounts of assets at once:
• Choose Catalog Duplicates on the Cataloging tab. This option prevents 

Cumulus from having to “think” too much about what it is cataloging. (See 
Client User Guide “Overview: Asset Handling Sets” for details.)

• Deactivate any asset formats that you don’t need.  (See Client User Guide 
“Asset Format Support” for details.)

Compressing Catalogs
Compressing a catalog when it comes close to its maximum size. You can check 
the actual and maximum catalog size in the Catalogs Settings. 

NOTE: Deleted Records in Cumulus versions prior to 8
When records are deleted from catalogs, with Cumulus versions prior to 8 they 
could optionally remain a part of the catalog in case you need to retrieve 
them. These not-quite deleted records take up space. You can delete them per-
manently by compressing the catalog. 

To compress a catalog:

1. Make sure the catalog you want to compress is the active window in 
Cumulus. If you have more than one catalog opened in the active window, 
you will be asked to select the catalog.

2. Select File > Administration > Compress Catalog. (Only active if the catalog 
is not yet compressed as much as possible.) You are warned that compress-
ing the catalog will permanently remove the deleted records.

3. Click OK to compress the catalog.

Backing Up Catalogs
The value and usefulness of a Cumulus catalog increases exponentially as the 
catalog grows. To prevent an unforeseen technical mishap from damaging or 
destroying your catalogs (and your work schedule), consider regular and fre-
quent backups.
It’s important to remember that backing up a Cumulus catalog does not back up 
the catalog records’ associated asset files. Make sure that all your important files 
are included in your regular backups.
There are different ways of backing up a catalog:
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• Any backup software program
• With the Cumulus Backup feature
• With the Cumulus Backup Manager
The first way may be the quickest and most convenient, particularly if you already 
use a backup software program. A Cumulus catalog, being just another file on 
your computer, can be copied to other volumes, or included in a network or 
automated backup. Catalogs should be closed before they are copied to other 
volumes to ensure that all changes are safely saved. However, you can back up 
an open catalog, if you employ the Cumulus Backup feature. The Cumulus 
Backup Manager is included in the Cumulus Server Console. For a description on 
how to use the Backup Manager, see “Backup Manager,” p. 75. 
To back up a catalog using the Backup feature:

1. Make sure the catalog you want to back up is the active window in Cumulus. 
If you have more than one catalog opened in the active window, you will be 
asked to select a catalog.

2. Select File > Administration > Backup Catalog. The Backup window opens. 

3. In the Backup File Name field, either 
– enter the name and path for the backup catalog (using the path and file 
naming conventions of the operating system your Cumulus Server is 
installed on)
OR
– click Browse to select a location for the backup catalog and then enter the 
name for the backup catalog. (The area you are allowed to browse is defined 
in the Cumulus Server Settings).

NOTE: The name for the backup catalog file can be the same name as the 
original catalog file with the file name extension .bak. You may also 
choose the file name extension .ccf. There is no difference in format, but 
then you may need to choose a different name or a special backup loca-
tion to avoid confusion with the original catalog. 

4. Click OK. The catalog is saved in the format selected.

Preparing Catalogs for Special Metadata
If you want to capture IPTC, XMP or EXIF data from assets (and to write back such 
data to assets), the catalog(s) managing these assets and the Asset Handling 
Set(s) to be used must be prepared. Cumulus provides special functions for this. 
File > Administration > Prepare Catalog opens a submenu with options for pre-
paring catalogs to manage different standard metadata formats. For more 
details, see Client User Guide, section “Prepare Catalog.”

Copying Catalogs
The Backup function described above is Cumulus’ mechanism for copying cata-
logs in their ready-to-use state. You can also use the conventional ways of copy-
ing files on your computing platform to make copies of Cumulus catalogs. 
Remember, copying catalogs does not copy the associated asset files. 
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Repairing Catalogs
If a catalog becomes damaged, Cumulus may be able to rebuild it. When you try 
to open a damaged catalog, Cumulus asks to repair it. You can also initiate the 
repair process for local catalogs from within the program by selecting File > 
Administration > Rebuild Catalog. For repairing remote or mirrored catalogs, 
use the Rebuild button in the Catalog Access window when logged in as 
administrator (File > Connect To.)
Catalogs are most commonly damaged by an abnormal termination of the 
Cumulus Server that, for example was caused by an improper shutdown or a sys-
tem crash.
After choosing the rebuild function, a dialog opens that asks whether you really 
want to do this. If you used the Rebuild button in the Catalog Access window, 
you are offered two options. If you choose Rebuild, the catalog is rebuilt on the 
information found. If you choose Rebuild from Mirror, a dialog will open that lets 
you enter the information required to identify the mirror. 

NOTE: You can use the Rebuild from Mirror option if you need to create a 
new catalog that is to hold the data from the mirror. 

If a mirrored catalog is damaged and even the information on mirroring is 
destroyed, a dialog opens that offers the same two options Rebuild from Mirror 
and Rebuild. Click the button for the appropriate option.

If you choose Rebuild from Mirror, a dialog opens that lets you enter the infor-
mation required to identify the mirror.

Enter the required information and click OK. Then Cumulus will rebuild the cata-
log with the data from the mirror and – if there is one – from the queue.

Where to Get the Queue ID?
Each mirrored catalog has an XML file (*.ccm) that contains the mirroring infor-
mation. This file is stored in the same folder as the Cumulus catalog. It provides 
the information on the queue ID under CUID. In the following example the 
queue ID is {FF9E643F-11BB-4E95-9B62-6BAFE841A5F8}.
<?xml version="1.0" encoding="UTF-8"?>

<ns:record xmlns:ns="http://www.canto.com/XML/ns/Package/
1.0">
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<ns:guid

ns:key="MMod">{FAB9CC52-C721-4720-A2D4-3450EABA88F2}</
ns:guid>

<ns:int32 ns:key="UseM">1</ns:int32>

<ns:guid
ns:key="CUID">{FF9E643F-11BB-4E95-9B62-6BAFE841A5F8}</ns:guid>
<ns:record ns:key="MCnf">

<ns:string ns:key="Serv">dell470</ns:string>

<ns:string ns:key="DBas">test</ns:string>

<ns:string ns:key="User">thomas</ns:string>

<ns:binary

ns:key="Pass">8106DF418C242DD52F0D31C1E9012969BE05FF0C</
ns:binary>

</ns:record>

</ns:record>

Renaming Catalogs
Cumulus catalogs actually have two names:
• One is the name of the catalog file, as you see it from your computer’s desk-

top. This is called the catalog file name.
• The other is the name of the catalog, as seen in the catalog window’s title bar. 

This is simply called the catalog name.
When a catalog is first created, the catalog name defaults to the same name as 
the catalog file. Newly created catalogs are named the same as their file names 
by default, but the catalog name can be changed at any time. 
Before you rename a catalog, be aware that a catalog’s name is an internal refer-
ence within Cumulus. The catalog name is the name users will see when con-
necting to catalogs, and it also appears at the top of catalog windows. It’s 
important to remember after renaming a catalog, that you must update the per-
missions of any users (or roles) that have restricted catalog access that includes 
access to the renamed catalog. This is because restricted catalog access permis-
sion is based on the names of catalog, so users will not be able to access 
renamed catalogs until those newly renamed catalogs are added back into the 
list of accessible catalogs for that user (or role). 
Note that catalogs cannot be renamed while set to use the Cumulus Vault in 
Always and Exclusive mode.
To change a catalog name (what you see in the catalog window):

1. Make sure the collection window containing the catalog is the active win-
dow in Cumulus.

2. Select Cumulus / Edit > Preferences. 

3. Click Catalog Settings.

The Catalog Settings window is displayed. If the active collection window 
contains more than one catalog, select the catalog you want to edit under 
Catalogs.

4. Click General. You’ll see a field labeled Name.

5. Enter a new name for the catalog in the Name field and click OK. The 
change is saved and the window closes.

You change a catalog’s file name as you would any other file. 
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Deleting Catalogs
Unlike deleting records, deleting catalogs is not undoable. (Unless you have a 
disk utility program that makes recovering deleted files possible.) Cumulus has 
no built-in mechanism for deleting catalogs. Delete catalogs as you would any 
other file on your computer. Remember that assets are not deleted with catalogs. 
Catalogs must be closed to be deleted.

Dividing Catalogs
At some point you may wish to divide the contents of one catalog into smaller 
catalogs. Reasons for doing so include:
• The catalog has grown close to its maximum size (e.g. 1 terabyte).
• Your computer can no longer accommodate the number of records in the 

catalog effectively (processor or RAM limitations).
• The contents of the catalog have become too diverse to be usefully catego-

rized in one catalog.
Like many operations in Cumulus, there is more than one way to divide a catalog. 
The first way is best suited to smaller numbers of records.
To divide a catalog using drag and drop:

1. Make sure the catalog from which you wish to divide is the active window in 
Cumulus.

2. Create or open the catalog you wish to move records into in a separate win-
dow. Arrange the catalog windows so that you can see both.

3. Search for the records you wish to move to the new catalog, using any of 
Cumulus’ search options. 

4. Click on or near a thumbnail in the original catalog and select Edit > Select 
All to select the records. (At this point you could cut and paste the records 
between the catalogs as one way of moving them, which would save you 
the step of deleting the old records in the old catalog.)

5. Click on the thumbnail of any of the selected records and drag the set into 
the new catalog window. The records are copied. The copied records’ cate-
gories are created in the new catalog. 

NOTE: Cumulus doesn’t consider copying records from one catalog to 
another as “cataloging assets.” Therefore, the Asset Handling Sets have no 
effect on this action. 

6. You can optionally delete the records from the old catalog by first clicking 
on the old catalog’s window to activate it, and then selecting Edit > Delete 
before the selection of records has changed.

To divide a catalog containing a very large number of records, it may be easier to 
export the records from the old catalog and import them into the new catalog. 
(See “Importing and Exporting” in the Client User Guide.)
After the export/import process is over, you can delete the records from the old 
catalog, as described above.

Merging Catalogs
Merging catalogs requires some forethought in order to be done properly. If 
both catalogs contain identical category structures, the process is easy and can 
be done in different ways:
• Drag and drop records between catalogs.
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• Using Cumulus’ export and import features.
“Dividing Catalogs,” above, describes each process.
But if the category structures of the two catalogs differ, there are a few extra steps 
to take. (See “Importing and Exporting” in the Client User Guide.)

Migrating Catalogs
Catalogs from versions prior to Cumulus 6 cannot be migrated within 
Cumulus 8. If you need to migrate Catalogs from versions prior to Cumulus 6, 
please contact your Cumulus support. 
When you first open a Cumulus 6 or 7 catalog with Cumulus 8, it is prepared to 
be used with Cumulus 8. You can immediately start working with it. 
However, you need to explicitly migrate a Cumulus 6 or 7 catalog file to 
Cumulus 8 if 
• Integer or Long Integer field values are used for sorting
• the individual permissions for records or categories feature was used (e.g 

with Cumulus Enterprise.)
The explicit migration can be done in two different ways:
• Using the Migrate button provided in the Catalog Access window. The cata-

log will be migrated in place.
• Using the Migrate Catalog menu item of the Administration menu pro-

vided by the File menu. This way allows you to migrate catalogs that are not 
yet managed by the Cumulus Server and can be stored anywhere in your net-
work. Canto recommends you to use this way for catalogs prior to Cumulus 7 
because with Cumulus 7 the internal data structure of catalogs was opti-
mized for managing large amounts of data (catalog size up to1 TB) and only 
this way of migration optimizes a catalog’s internal data structure for manag-
ing large amounts of data.

The explicit migration of a Cumulus 6 or 7 catalog to Cumulus 8 takes time: the 
larger the catalog file, the more time required for the conversion. Canto recom-
mends starting by using the catalogs as they are and then migrating them one 
by one during work-off-hours. Note that once a catalog has been opened with 
Cumulus 8, it can no longer be used with older versions of Cumulus.
A catalog’s type and size can be viewed in its Catalog Settings window 
( Cumulus / Edit > Preferences > Catalog Settings > General tab.)

Migrating a Cumulus 6 or 7 Catalog via the Administration Menu
Catalogs created with Cumulus 6 or 7 can be easily migrated to Cumulus 8. How-
ever, Canto recommends you always make a backup catalog and then use this 
backup version of the catalog for migration.
To migrate a Cumulus 6 or 7 catalog:

1. Select File > Administration > Migrate Catalog. A dialog for selecting a cat-
alog appears. 

2. Select the Cumulus catalog you want to migrate and click Open. 

3. Select a name and location for the migrated Cumulus catalog and click 
Save. A progress bar appears to indicate the status of the conversion.

Once the progress bar disappears, your catalog has been migrated to the 
current Cumulus catalog format and saved in the location you selected.
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NOTE: If problems occur during a catalog migration, try repairing the catalog 
using your former Cumulus version. Choose the Repair option under the 
Administration menu and then try the migration again. 

Using Server Console Modules
The Server Console combines administration tools for Cumulus Workgroup and 
Enterprise. Some of the Server Console modules are specially designed for cata-
log management. You need the appropriate Administrator permissions to use 
these modules.

Logging of Catalog Activities
The Log Manager module presents a number of options from which you can 
enable a log file for a catalog and define its content.
PRECONDITIONS: To manage a log file for a catalog, you must have the appro-
priate Administrator permissions (Permissions > Administrator Permissions > 
Manage Log Files.) 
To enable and define the logging of a catalog:

1. Select File > Administration > Server Console, or connect to the Web 
Server Console via a Web browser.

2. The Server Console application is started. Log on as Cumulus Administrator 
to the Cumulus Server that manages the catalogs you want to have logged.

3. Select Log Manager. The Log Manager Properties window opens.

In the field Default Log Folder you may enter another folder to serve as the 
default folder for log files.

4. In the field Catalog, select the catalog you want to have logged. You can 
only set the logging properties for catalogs for which you have the appropri-
ate Administrator permissions: Manage Log Files.

5. Then define the logging properties for the selected catalog.

• Click Enable Logging if you want the logging to be active. 
• In the field Log Folder you may enter another folder other than the default 

folder to serve as the folder for the log file(s) of the current catalog. 
• If you want a separate log file for each day, enable Daily Log File. Daily log 

files have the advantage that you can delete those you no longer need.
• Select the columns you want the log file to contain as well as their 

sequence by clicking the arrow buttons. To delete a column just click the 
minus option in the list: –

• Select the events you want the log file to contain by check marking them.
6. Click Save Changes. The catalog’s activities will be logged in a file named 

after the catalog. If you enabled Daily Log File the date is added to the 
name (year-month-day).

The Activity Monitor
You can monitor catalog activity from the Activity Monitor window. This window 
shows:
• the activity on the Cumulus Server



MANAGING CATALOGS –  USING SERVER CONSOLE MODULES 69
• information about any logged-in user, e.g. host address, catalog(s) the user is 
connected to, time of login, duration of session, etc.

Additionally, you may 
• disconnect users from a catalog 
• send a message to selected users
PRECONDITIONS: To monitor a catalog’s activity, you must have the appropriate 
Administrator permissions (Permissions > Administrator Permissions > Moni-
tor activity.) 
To access the Activity Monitor:

1. Select File > Administration > Server Console, or connect to the Web 
Server Console via a Web browser.

2. The Server Console application is started. Log on as Cumulus Administrator 
to the Cumulus Server that manages the catalog you want to monitor.

3. Select Activity Monitor. The Activity Monitor window opens.

The activity bar at the top of the window indicates the activity on the Cumulus 
Server. The list below displays which users are connected to which catalogs. You 
can only monitor catalogs for which you have the appropriate Administrator per-
missions: Monitor Activity.
The list of connected users consists of multiple columns. The one for names of 
the users currently connected to the catalog, the one for the names/IP addresses 
of the computers from which they’re connecting, the names of the catalogs they 
are connected to and when the connection was started are displayed by default. 
You can also use the Activity Monitor to disconnect users from the current cata-
log.

Disconnecting Users from a Catalog
Before you configure catalog properties or perform catalog maintenance tasks, 
you should disconnect all users currently working with the catalog.
To disconnect users from a catalog:

1. In the Activity Monitor window select the user(s) to be disconnected and 
click Disconnect User.

A dialog appears for you to specify how long Cumulus should wait before 
disconnecting, and to write an instant message to these users, letting them 
know why they’re being disconnected.

Sending a Message to Selected Users
You may send messages to a single user or to multiple users at once. To send a 
message:

2. In the Activity Monitor window select the user(s) to which you want to send 
a message and click Send Message. 
The Send Message window appears.

3. Enter the text of your message and click OK. The message is sent.

The message is displayed in an information window on the desktop of the 
selected user(s). The user must click OK to close the information window.
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Archiving Information
Many organizations maintain several catalogs: one catalog for production assets 
and a second catalog to manage archives. With Cumulus you can also take your 
assets off-line, update the file references, and still be able to search and retrieve 
them. 
In general, archiving assets involves the following steps:

1. Copy and/or move the assets you wish to archive to the other media. 

2. Merge the records you wish to archive into an archival catalog by first copy-
ing the categories and then the records. For more information, see “Merging 
Catalogs,” p. 66.

3. Update all asset references in the archive catalog. 

4. If desired, delete the records you archived from your production catalog.

The Importance of Updating Asset References
Cumulus tracks the location of media assets through asset references. Whenever 
you move an asset, you must update the asset reference to reflect the new loca-
tion. 

About Archiving on CD-ROM
Like other read-only media, creating an archive on CD-ROM requires that all infor-
mation be set up correctly in advance. When creating archives on CD-ROM, 
remember the following:
• Create a temporary “staging” volume/drive and give it the same name as the 

final CD-ROM disc.
• Copy and/or move the catalogs and assets you wish to archive to the staging 

volume/drive. 
• Update all file references. The file references within each record must point 

to the assets located on the staging volume/drive.
• Burn a new CD that contains the contents of the temporary volume/drive. 

Remember that the CD must have the same name as the staging volume/
drive.

Creating Hybrid CD-ROMs
Differences between the Windows and Mac OS operating systems present some 
distinct challenges when archiving to external media such as CD-ROM. To avoid 
problems in locating information on hybrid CD-ROMs, remember to use one of 
the following file system combinations:
• a hybrid CD-ROM containing an ISO 9660 file system with Joliet extension as 

well as a Mac OS HFS file system
• an ISO 9660 CD-ROM without extensions 
Because of operating system naming restrictions, the use of other file system 
combinations can lead to problems when finding files on either platform.



Server Console
Cumulus Server Console combines utilities for different administrative

tasks. This chapter describes the Cumulus Server Console and covers

some of the administrative actions that are performed with the Server

Console utilities. 
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Overview
Cumulus Server Console combines different administration utilities to provide 
easy access to them:
• The Activity Monitor

Displays information on the Cumulus Server activity and users connected to 
the selected catalog. Allows you to disconnect users.

• Backup Manager
Enables you to define rules for the automatic backup of catalogs and your 
Cumulus configuration files.

• FileSystem Companion Manager
Enables you to configure instances of the Cumulus FileSystem Companion, 
an optional component which listens to file system events and converts 
them into Cumulus actions.

• File System Versioning
Enables you to set up and configure asset versioning for any Central Asset 
Location on your file system.

• Log Manager
Allows you to activate the logging process for selected catalogs and set up 
log properties.

• Mail Manager
Enables you to configure Cumulus to work with your email server, to choose 
sending Cumulus Server notifications, and see the queue of mails to be sent.

• Remote Admin 
Displays the Cumulus Server status and lets you stop or start the Server. The 
options of these modules let you view and edit the current Server settings 
and license status and provide a utility to ease the configuration of the File-
Sharing.Info file.

• Report Manager
Enables you to configure and generate reports based on catalog statistics or 
on Cumulus Server activity.

• Scheduler Manager
Enables you to define and schedule tasks to be automatically performed by 
Cumulus. 

• Set Manager
Enables you to export and import shared Cumulus items (Sets, Templates, 
etc.). And enables you to unload all individual sets.

• User Manager 
Enables you to specify users and their access rights to certain catalogs and 
functions.

• Vault Server
Displays the current Cumulus Vault Server Setup and lets you configure and 
administer the Vault Server.

• Sites Configurator (Web Server Console only!)
For a description see the Cumulus Sites Administrator Guide.

The Cumulus Server Console can be accessed either via the Server Console appli-
cation installed along with your Cumulus Client, or as the Web Server Console via 
a Web browser from anywhere, if the Web Server Console (which is a part of the 
Cumulus Web Solutions) is installed on your Cumulus system.  In any case, you 
need the appropriate permissions to access and work with the Server Console.
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Accessing the Server Console
Both the Server Console Application and the Web Server Console provide almost 
the same look and feel and comprise the same configuration options and mod-
ules. The Web Server Console additionally offers the Sites Configurator module. 
(For adescription of the Sites Configurator, see the Sites Administrator Guide.)

Opening the Server Console Application
To open the Server Console application:

1. Start the Cumulus Client application on the machine that you installed the 
Server Console application on.

2. Select File > Administration > Server Console.

The Login window opens.

3. Enter the name or the IP address of the Cumulus Server you want to admin-
istrate.

4. Enter the name and the password of the Cumulus Administrator or the user 
who has the permissions to perform the required administrative tasks.

5. Click Connect.

The modules of the Server Console application are loaded.

Opening the Web Server Console
To open the Web Server Console:

1. Open a Web browser and enter the address of the Web Server console into 
the address field:
<servername or IP address>:8080/serverconsole
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The Web Server Console login window is displayed.

2. Optionally, select a different language.

3. Enter the name or the IP address of the Cumulus Server you want to admin-
istrate.

4. Enter the name and the password of the Cumulus Administrator or the user 
who has the permissions to perform the required administrative tasks.

5. Click Login.

The Web Server Console page is loaded.

NOTE: Both the Server Console Application and the Web Server console pro-
vide almost the same look and feel and offer identical functions and modules.

Next to the server name, the name of the logged-in administrator is displayed in 
brackets: localhost (cumulus).
The Server Console offers its own menu bar. The Server menu lets you connect 
to additional Cumulus Servers that you want to administrate or to quit the con-
nection to a selected Cumulus Server. The Action menu offers the functions 
available for the currently selected item. These functions are also revealed with a 
right/alternate mouse click on items.
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Select the item on the left that represents the module you need to perform your 
administrative task on. Some modules offer multiple options. These are denoted 
by an icon on its left. Click this icon to reveal the options. 
In order to work with these modules you need the appropriate Administrator 
permissions for each of these modules. These permissions are set in the User 
Manager module for each user. As the Server Console modules Log Manager and 
Activity Monitor refer to tasks for catalog management, these permissions are set 
in the Permissions section. Since the Server Console modules User Manager and 
Backup Manager refer to administrative tasks concerning the Cumulus Server, 
these permissions are set in the Server Permissions section.
The following sections cover the Backup Manager, the Scheduler Manager, 
Report Manager, Set Manager, and Remote Admin utility. For a description on 
how to use the 
• Activity Monitor, see “The Activity Monitor,” p. 68 
• Log Manager, see “Logging of Catalog Activities,” p. 68 
• User Manager, see “User Manager,” p. 101
• Vault Server, see “Configuring Vault,” p. 131.

Using Server Console for Multiple Cumulus Servers
If you have a Cumulus installation with more than one Cumulus Server, Server 

Console lets you administer these multiple Servers. Select Server > Connect to 
connect to another Cumulus Server. The panel on the left  then provides an 
entries for each server and its accessible modules. Next to each server name, the 
name of the logged-in administrator is displayed in brackets.

Backup Manager
PRECONDITIONS: To work with the Backup Manager you must have the appro-
priate Administrator permissions for the Cumulus Server: Backup Administrator
The Backup Manager allows you to automatically backup your Cumulus config-
uration files and catalogs – if the catalogs are based on the Cumulus database 
engine. 
You can define jobs for the backup. These jobs include options for:

Server Console with 
multiple Servers
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• Items to be backed up – You can either have a backup of your Cumulus con-
figuration files, of all catalogs that are available at your Cumulus Server or just 
of selected catalogs.

• Destination for the backup files
• Time data when the backup should be performed
When you backup your Cumulus configuration files, a ZIP archive with all config-
uration files inside the conf folder will be created and stored at the chosen des-
tination. Unless you activate the option Append time of backup to file name, 
this ZIP file will be overwritten by the next backup copy that is made due to the 
defined backup job.
When backing up catalogs, a catalogs does not have to be closed for the backup. 
The backup can even be made while clients are connected. When backing up a 
catalog, a temporary file is created for the catalog – the moment the backup was 
started. This temporary file will be saved as a BAK file to the selected destination. 
It is saved under the catalog file name with the extension BAK. Unless you acti-
vate the option Append time of backup to file name, this BAK file will be over-
written by the next backup copy that is made due to the defined backup job.  

When scheduling backups, remember to take into account the time that 
Cumulus needs for creating and saving the catalog backup files. 
Email confirmations can be sent automatically after catalog back-up operations 
conducted by the Backup Manager, if the Mail Manager is set to send notifica-
tions.

IMPORTANT! It’s important to remember that backing up a Cumulus catalog does 
not back up the catalog records’ associated asset files. Make sure that all your impor-
tant files are included in your regular backups. 

When defining the destination for the backups, the Select Destination Folder dia-
log opens. It allows you to navigate in the Remote File Browser Sections that are 
defined in the Cumulus Server Settings of the Remote Admin module.
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FileSystem Companion Manager
The Cumulus FileSystem Companion is an add-on which listens to file system 
events and converts these to Cumulus actions in a smart way. This allows 
Cumulus to automatically catalog assets and to create, update or delete records 
based on changes in the file system.

Optional feature! May not be available with your Cumulus configuration.

The FileSystem Companion is available for Windows and Linux file servers only 
(which however may be accessed from any client platform). It runs as a separate 
service, called an instance, on the respective server machine. Each of the 
instances of the service has its own configuration xml file specifying the unique 
name of the instance, the address of the Cumulus Server and the technical user 
which is used to connect to that Cumulus Server.
Beyond these basic settings, the instances of the Cumulus FileSystem Compan-
ion are configured via the FileSystem Companion Manager of the Cumulus 
Server Console. This comprises the specification of the folder(s) to be watched as 
well as the catalog, Asset Handling Set and Permission Template to be used, cer-
tain time out values and a list of items to be ignored by an instance of the 
FileSystem Companion. Last but not least, these instances can be activated/
deactivated via the FileSystem Companion Manager.

IMPORTANT! The FileSystem Companion and the watched folders must be 
physically located on the same machine. 
Do not use the FileSystem Companion with network shares mounted into the 
file system because this can result in erroneous behavior.

The following table shows which file system event results in which Cumulus 
action:

However, there is no one-to-one relation between a file system event and a 
Cumulus action. Cumulus puts file system events in a queue and processes them 
with a configurable delay, thus allowing to collect multiple events for a file in a 
given time and finally applying an appropriate Cumulus action that is the result 
of a number of file system events. This time out, or delay, is helpful e.g. if an appli-
cation creates, renames and/or deletes temporary files while processing an asset.
For example, if there a sequence of file system events like: CREATE, UPDATE, 
UPDATE, DELETE, the resulting Cumulus action would be IGNORE, because it is 
impossible to create a record before the newly created asset is deleted again.
As a special case, RENAME operations on the file system are always executed 
immediately in Cumulus, without any delay.

Configuring FileSystem Companion Instances
The FileSystem Companion Manager displays a list of existing configurations. 
You can create new configurations, as well as edit, delete and activate/deactivate 
existing ones. If the name of an existing FileSystem Companion instance and the 
name of a configuration match, the settings specified in the configuration take 
effect for the respective instance.

File System Event Resulting Cumulus Action

CREATE catalog created asset

UPDATE update existing record or catalog asset if no record is found

DELETE delete existing record

RENAME rename existing record as well
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The following Information is displayed for each instance:
• Status – Running/Not Running/Deactivated
• Name – Name of the instance. Should match the name of an existing 

instance of the FileSystem Companion
• Folders – Number of and path to folders to be watched, and name of the cat-

alog to which the file system events are synchronised 
• Event Queue Size – Number of assets for which file system events are wait-

ing to be processed
The following columns provide information on inconsistencies found by the 
resync process running in the background. Usually, these inconsistencies are 
solved automatically within a certain amount of time.

• Missing Records – number of assets with no corresponding records
• Missing Assets – number of records with no corresponding asset
• Checksum Problems – number of reference inconsistencies 
Existing or new instances are configured via the Edit Instance Configuration win-
dow.
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Folders – a list of folders to be watched by the instance. The following informa-
tion is displayed for each folder:
• Folder – Absolute path to the folder to be watched. All folders below this 

folder will be watched, too
NOTE: This leads to a (technical) source category tree which is visible on 
the All tab of the Category pane. This category tree must not be modified 
manually!

• Catalog – Name of the catalog to which file system events from the specified 
folder are synchronised. Catalogs can be selected via d drop-down list
NOTE: It is not possible to apply system events from different folder paths 
to the same catalog!.

• Asset Handling Set – Name of the Asset Handling Set to be used with the 
Cumulus action. Can be selected via a drop-down list

• Permissions Template – Name of the Permissions Template to be applied. 
Can be selected via d drop-down list

Settings – In this section, several time out values can be specified. 
• Activity time-out – Minimum delay between the receipt of a file system 

event and its conversion into a Cumulus action. 
NOTE: Usually, the actual time between a file system event and the result-
ing Cumulus action is larger than this value, depending on the load on 
the machine and the number of file system events coming in.

• Timeout for record resync runs – Resync thread waits at least that amount 
of time between checking for records without asset and assets without 
record

• Timeout for category resync runs – Resync thread waits at least that amount 
of time between checking the technical FileSystem Companion category 
structure for categories without matching folders on disk.

• Timeout for delaying actions in resyncs – Resync thread waits at least that 
amount of time after it has detected an inconsistency (for example a record 
in the catalog with missing asset) and before the according cleanup function 
is executed (in this example, deleting the record).

Exclusion List – a lists of files, file types and folders which are to be ignored by 
the FileSystem Companion. 
These settings must be notated in regular expressions!
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File System Versioning
Cumulus supports asset versioning for assets stored in an asset versioning sys-
tem like Cumulus Vault (see “Configuring Vault,” p. 131), as well as for assets 
stored in a Central Asset Location on your file system.
The proper way to modify a versioned asset and to create a new version is to 
check the asset out first, then edit it, then check it in again. However, with file sys-
tem based asset storage – and in contrast to Vault based asset storage – an asset 
may be revealed and modified directly within the file system, i.e. without previ-
ously been checked out from Cumulus. Cumulus therefore allows to check in 
and create a new version of a modified asset that has not been checked out 
before.

Prerequisites
Versioning of assets can be set up for any catalog which employs a file system 
based Central Asset Location (Edit > Preferences > Catalog Settings > General 
> Use Central Asset Location). 
The following prerequisites must be met to make file system based versioning 
work for a catalog:
• The special fields for versioning (contained in the catalog template Fields for 

Asset Versioning Control) must be included in the catalog. 
• The respective Central Asset Location must be configured as a Versioning 

Location (via the File System Versioning section of the Server Console).

Some Technical Background
Cumulus stores the versions of assets in hidden folders within the central asset 
location so that they can’t be revealed by simply browsing the file system. Only 
the current version of an asset is always visible in the file system.

NOTE: In order to prevent the accidental destruction of a current version of an 
asset, Cumulus always keeps a second copy of that version in a hidden folder. 
Every time Cumulus generates a new version from a changed, but not 
checked-out asset, this hidden file becomes the penultimate version.

Cumulus can generate new versions of changed assets every time the respective 
records are updated. Records can be updated either manually (via Metadata > 
Update Record) or automatically, e.g. via the auto cataloging function for source 
categories, or a scheduler action.
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Configuring the File System Versioning
File system based versioning of assets can be configured via the Server Console.

The following settings can be configured:
• Create new version when record is updated (and asset was modified): This 

takes effect both with manual and automatic updates of the record.
If this option is not activated, new versions must be explicitly created via the 
Asset > Check In menu command.

• Reduce creation of new versions. Minimal time gap between versions: If 
activated, at least the specified number of minutes must go by before a new 
version is created, even if the asset has been changed in the meantime. – 
Depending on the system load, the length of the task queue, etc, the effec-
tive gap may exceed the specified value.
This is useful to avoid clutter whenever an application creates frequent 
updates of a file. 
NOTE: This setting only affects the creation of versions via an update 
record process. It does not affect the creation of new versions via checking 
in assets!

• Restrict numbers of versions to be kept to: If activated, only the specified 
number of versions are kept.

• Always keep oldest version: If activated, the oldest version – the “original” 
file – is never deleted.

To configure a central asset location for asset versioning:

1. Click Add Location. 

A window appears displaying any central asset location defined in any cata-
log that is not yet configured for versioning.

2. Select the desired location, then click OK.

A window appears asking whether all not yet versionable assets in the 
selected location shall be made versionable:
Yes: Existing assets in the central asset location are made versionable.
No: Existing assets are not made versionable; but new assets are always cre-
ated as versionable. – You may transform not versionable assets to version-
able ones anytime later via the Prepare Assets in Location button
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3. Select the desired option. The location and the catalog to which the respec-
tive assets are cataloged are is displayed in the Versioning Locations list.

You may stop asset versioning for a location anytime via the Remove Location 
button. If you do so, you may also disable versioning for currently versioned 
assets (i.e. make them unversionable) and remove all existing versions.

Mail Manager
PRECONDITIONS: To work with the Mail Manager you must have the appropriate 
Administrator permissions for the Cumulus Server: Mail Administrator
The Mail Manager lets you configure Cumulus to work with your email server. It 
enables you to define and test your email server settings, choose to send Cumu-
lus Server notifications, and see the queue of mail to be sent. Cumulus Server 
notifications include messages generated by the Cumulus Scheduler and Cumu-
lus Server (e.g. syslog system messages, error messages or informations on suc-
cessfully performed processes such as catalog backups.)

rview: Mail Manager 
erver Console module Mail Manager module provides access to the central Cumulus mail configuration 
gs and the mail queue.

splays the central Cumulus mail configuration 
tings.

splays the list of messages to be sent. Provides 
ttons for deleting selected messages or refresh-
 the list
r
llowing settings define the mail server 
yed for sending emails from within Cumulus 

s configuration. 
dress of the SMTP Server employed.
TP Port. It the port is set automatically accord-
 to the security settings. (Port 25 is the SMTP 
ndard TCP port )

curity level for mail server communication. 
tions are:
one: no security level defined
ecure SMTP (SSL): Secure Sockets Layer 
tart-TLS – Transport Layer Security (TLS) 
r setting the security level ask your mail server 
ministrator. 
me of the mail server user account (used for 
thentication at the mail server)
ssword of the mail server user account
ail address of the sender - either used for all 
ils sent or only for mails without a From 

dress. 
tions for the From address. If the option For 
ils without From address is activated, the 

dress of the sender will be used by default.

Notifications
The following settings define whether and how notifications are sent:
10 If activated, notifications generated by the Cumulus Server and 

Scheduler are sent as mail messages to the email addresses 
defined below. 

11 Defines the level of notifications that shall be sent via mail. Levels 
of notification include information, warning and error. The more 
severe levels are always included.

12 Mail address of the recipients of the notification. You can enter 
multiple addresses separated by commas.

13 Saves your settings and closes the window.
14 Sends a test mail messages employing the current settings.

1 2

3
4

6

7

8

9

10

5

11

13

12

14
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TIP: 
The notification emails or other automatically generated email mes-
sages (e.g. URLs) might be very short and therefore might be identified 
as unwanted email messages (E-mail spam or junk). Canto recom-
mends you to send test mails and – if necessary – to request the recip-
ients to include the From address in the safe senders lists of their local 
emails clients. 

Remote Admin
You use the Remote Admin module to stop or start the Cumulus Server and to 
configure Cumulus Server Settings, such as the identity of the Cumulus Admin-
istrator, the TCP/IP port number of the Server, and time-outs for various actions. 
You also use the Remote Admin module to activate your Cumulus installation 
and/or additional options, and to  view and, if necessary, modify, license informa-
tion.
You need to be logged in as the Cumulus Administrator to work with Remote 
Admin.
The Remote Admin function can be performed via the Server Console  or via its 
Web front-end from any computer. The following describes the version offered 
by the Server Console. 

Cumulus Server Status
Once you click the Remote Admin entry in the Server Console, the Cumulus 
Server Status is displayed. You can start and stop the Cumulus Server.

Cumulus Server Settings
To reveal the Cumulus Server Settings click the + icon on the left side of the 
Remote Admin entry. Then click on the entry Settings. The Cumulus Server Set-
tings will be displayed. The Server Settings options affect global Cumulus Server 
behavior.
If you want to change the settings, edit the settings and click Save Changes to 
send them to the Cumulus Server application. See “Overview: Cumulus Server 
Settings,” p. 84, for an overview of the setting options available.



84 CUMULUS® –  ADMINISTRATOR GUIDE

Ove
Gene
1 Us
2 Pa
3 Cl
4 D

fo
m

5 D
th
la

6 M
pe
to
If 
TI
ta

7 D
fo
in

8 Th
(h
Re

9 Cl
a 
se

10 To
bu

11 Ba
lo
so
cr
in
re
W
le
th
W
fo
na

12 Cl
th
Ba
fo
[N

13 To
14 Li

im
lis
as
Va
ua

15 Cl
yo
en
de
rview: Cumulus Server Settings 
ral
er name of the Cumulus Administrator.
ssword for the Cumulus Administrator. 

ick to change the password for the Cumulus Administrator. 
isplays and lets you change the name of the guest account 
r the Cumulus guest connection login. The name you enter 
ust be an existing Cumulus user account.
isplays and lets you change the language of the messages 
e Cumulus Server sends. Click the arrow button to select a 
nguage.
aximum age for Cumulus users’ passwords. After time 
riod entered has passed since the last change, the user has 
 change it. Cumulus will request this change automatically. 
you enter the value “0”, passwords will never expire. 
P: If you want to set the password to “never expire” of a cer-
in user only, you can do this with the User Manager.

isplays the path to the folder containing the temporary files 
r catalog mirroring. The path is relative to Cumulus Server 
stallation unless an absolute path is entered.
e Remote File Browser Section defines the starting point 

ighest point in the hierarchy of the file system) for the 
mote File Browser dialog within Cumulus. 

ick to add another Remote File Browser Section. Then enter 
name for it. To set the path for the new section, click in the 
ction’s entry in the column Path and enter an existing path.
 remove a section, mark the section’s entry and click this 
tton.
se URLs For Web Access define the Web addresses to cata-

gs that are published on the Internet with Cumulus Internet 
lutions (Web Client or Sites). Such an address is needed to 
eate correct URLs for records, assets, preview or thumbnails 
 order to access them via Web link. The URL creation can be 
quested by the Cumulus Client employing the Configure 
eb Link URL function. This function is available only if at 
ast one Base URL is defined here. (Fore more information on 
e requirements to make this function work, see “Configuring 
eb Links,” p. 52.) Cumulus can manage multiple addresses 
r multiple Web applications. They are identified by the 
mes you give them.

ick to add another Base URL. Then enter a name for it. To set 
e Web address, click in the Base URL’s entry in the column 
se URL and enter the address of the Web application in the 

llowing format: [http://[Web server IP address]:[Port No.]/
ame of Web application folder]
 remove a Base URL, mark its entry and click this button.

st of server machines running Cumulus Servers. This list is of 
portance in a multi-server environment only. The servers 

ted here are employed when cataloging, resolving/creating 
set references from other platforms, communicating with 
ult and for license check. You can either enter servers man-
lly or have them detected by the system.

ick to have servers detected by the system. Depending on 
ur network environment this may take a while. Once your 
tire system was checked and the list is completed, the 
tected list will replace the current list. 
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License
To reveal the License information, click the + icon on the left side of the Remote 
Admin entry. Then click on the entry License. The license information for your 
Cumulus installation will be displayed.

Registering And Activating Additional Licenses
Newly purchased options or additional licenses can easily be activated. In the 
License information pane, click on Activate Cumulus, then log in to your Cus-
tomer Portal Account. Activate the appropriate checkboxes, then click OK. 
For more information on activating and registering Cumulus, see the Installation 
Guide.

FileSharing Info Settings
The FileSharing.Info file is used by Cumulus Servers to build: 
• UNIX asset references based upon Mac OS X or Windows file system asset ref-

erences

ick to add another server manually.
 remove a server from this list, mark its entry and click this 
tton. For best performance Canto recommends you check 

is list regularly and remove all servers that are not available.
activated, the server locations for assets that can be deliv-
ed via Server/Client Asset Transfer are restricted to the 
lder(s) (including subfolders) specified here. 
efault: activated.
ick to specify a new folder.
 remove a folder from the list, mark its entry and click this 
tton.

Time outs
21 When the Server disconnects a Client (e.g., for shutdown

waits for a certain amount of time (e.g., 1 minute) plus th
specified number of seconds before closing the Client con
tion.

22 The Server expects to get the next request from a Client w
the specified time.

23 Number of seconds the Server waits for Clients to discon
on shutdown.

24 When the Server sends data to a Client, the data must be
transferred within the specified number of seconds or th
Server automatically disconnects the Client.

IP
u can define a custom TCP/IP port number (in the field to 

e right) for Server and Clients. It is recommended using 9287 
is is registered for Cumulus). 

you use any other number, you must set up the port number 
ed by Sites, the Web Client,  and the Vault Server (if installed 
 a machine other than the Cumulus Server) accordingly. 
u will also have to inform all Cumulus Clients to use the 
anged port number in the Connect To Server dialog (e.g. 
3.123.123.123:9288 or ServerName:9288) OR change the 
rt number in each Client’s XML file - found in the conf folder 

 the Cumulus Client installation folder. Under Mac OS X, you 
en this folder by opening the installation folder of your 
mulus application and then pressing the CTRL key and 

lecting the Cumulus application icon simultaneously to get 
e context menu for the application. In this menu select 
ow Package Contents, then open contents and finally 
en Mac OS.

OTE: If you use any other number, you may have to change 
ur firewall settings accordingly.

efines the number of bytes sent as a block by the network 
terface card. Change the standard value of 16384 for special 
rposes only.

27 Defines the number of bytes received as a block by the n
work interface card. Change the standard value of 16384
special purposes only.

28 Size of a message that the server will send as one block. T
default value “0” should be used with any local network 
then the messages will be sent as one block by the server
should only change this value if you have a Cumulus inst
tion that includes Clients with a slow connection (e.g. mo
or ISDN). If you change the fragmentation size under UN
Mac OS X, the value should be half (or less) of value set fo
send buffer.

Optimization
29 If not enabled, Cumulus automatically determines the o

mum size of the RAM cache for catalogs administered by
Server. If enabled, you can define a custom cache size (in
field Cache Size). For 32 bit Cumulus Server, the maximu
cache size is 1961 MB.

30 Enterprise Servers only: Number of threads that can reply
Client request at the same time. Four threads are sufficien
a Cumulus standard installation. Increase this figure for 
multi-core processors or multi-processor machines only. 
imum is 50.

31 Confirms the changes and sends them to the Cumulus Se
application.

rview: Cumulus Server Settings 
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• Mac OS X asset references based upon UNIX or Windows file system asset ref-
erences 

It contains information on how a Windows, UNIX or Mac OS X asset reference 
should be converted to a corresponding UNIX or Mac OS X reference. The infor-
mation stored in this file must be adapted to your Cumulus configuration. 
Remote Admin provides a utility to ease the configuration of the FileSharing.Info 
file. The utility provides different tabs:

For the volumes from which assets are cataloged, you need to add entries for the 
FileSharing.Info that contain the required information.

NOTE: HELIOS EtherShare and HELIOS PCShare
If HELIOS EtherShare is installed on the machine that runs the Cumulus Server, 
you do not need to update the Macintosh section settings of the FileShar-
ing.Info file manually; Cumulus does this automatically. 
If you have also installed HELIOS PCShare, you do not need to update the Win-
dows section settings manually. The HELIOS EtherShare and HELIOS PCShare 
tabs display the information that is provided to the FileSharing.Info by this 
software.

To add the information on the platform volume from which assets are cataloged, 
click the tab for the appropriate platform and click the Add button. A dialog opens 
that asks for the information needed to create the correct platform asset reference 
based upon the asset references already provided. 

• Volume Path – volume path of the share point in the notation of the plat-
form (e.g. UNIX notation: /shares/volume)

• Server Name – Name of the file server. This can be the IP address or the real 
server name (DNS-resolvable name).

• Zone Name – AppleTalk zone name as it appears to Mac OS X clients 
(Mac OS X only)

• Volume Name – Name of the volume on the file server
• Encoding – The encoding for the Macintosh section definitions should 

always be set to UTF-8. The encoding for the Windows section definitions 
should always be set to WinLatin1.

Make sure you enter the server names and volume names (case sensitive) exactly 
as they are displayed for the appropriate platform in an Asset Reference field of 
the Cumulus Information window/view. This field also shows what you should 
enter as server name (the IP address or the real server name). The volume names 

Dialog for entering information to 
create a reference based upon a 
Mac OS X reference.

Dialog for entering information to cre-
ate a reference based upon a Windows 
reference.
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entered must match exactly the names of the volumes themselves. (Note that 
spaces must not be escaped by quotes.) Make sure you don’t enter a UNIX server 
name.
After the FileSharing.Info is edited, the records must be updated to get valid 
entries for the missing platform asset references. Use a Cumulus Client (Mac or 
Windows) to update the records (Metadata > Update Records > Update now). 
Use an Asset Handling Set that has the File System AssetStore for the missing 
platform asset references activated. After doing so, the Asset Reference field in 
the Information window/view will show the following UNIX path for a cataloged 
asset: 
//MyServer/MySharedVolume/MyFolderStructure/MyAsset 
Without correct FileSharing.Info entries, a UNIX reference would look something 
like this: 
MyServer:/home/LoginName/MySharedVolume/MyFolderStructure/MyAsset 
This is a non existing path and Cumulus cannot resolve it.

The entries on the Cumulus FileSharing.Info Macintosh and Cumulus FileShar-
ing.Info Windows tab of Remote Admin FileSharing.Info Settings window can be 
edited or deleted. To edit an entry, select the desired entry and click Edit. To 
delete an entry, select the desired entry and click Delete.
To save the changes you made in the Remote Admin FileSharing.Info Settings 
window, select Actions > Save.

Additional Notes
• Best Guess

If the Unix File System AssetStore is activated, during cataloging, the Cumu-
lus Client tries to create a corresponding UNIX asset reference and sends a 
request to the Cumulus Server. Using the FileSharing.Info file, the Cumulus 
Server answers this request. If a UNIX asset reference could be created, it is 
stored with the cataloged asset. If the Cumulus Server cannot create a UNIX 
asset reference, it stores instead a “best guess” reference such as: /usr/home/
images/picture.jpg. 

• Asset Handling Sets
When working in a cross-platform environment, Canto recommends using 
Asset Handling Sets that have the Asset Storage modules for all three differ-
ent file systems activated: Mac OS File System, UNIX File System and Win-
dows File System.

• Cumulus Internet Solutions and Local Access
If you run Cumulus Web Client, Sites, Web Publisher Pro (WPP) or Internet Cli-
ent Pro (ICP) on a computer other than your Cumulus Server, you might need 
a configured FileSharing.Info file on the computer running the Cumulus 
Internet Solution. The FileSharing.Info file is needed in case the Cumulus 
Internet Solution accesses assets that were cataloged locally from the same 
computer the Cumulus Internet Solution is running on. In this special case, a 
properly configured FileSharing.Info file must be copied to the etc (UNIX) or 
conf (Windows) subfolder of the installation folder of the Cumulus Internet 
Solution.
If you use a Cumulus Java Classes installation different from the one in the 
Cumulus Internet Solution installation folder, the configured FileShar-
ing.Info file must be copied to the etc (UNIX) or conf (Windows) subfolder of 
that Cumulus Java Classes installation folder.

• Applications based on Cumulus Java Classes
If you use an additional application with your Cumulus installation, and this 
application is running under UNIX or Mac OS X on a computer other than 
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your Cumulus Server, you might need a FileSharing.Info file on this com-
puter. In this case the configured FileSharing.Info file must be copied to the 
etc (UNIX) or conf (Windows) subfolder of the Cumulus Java Classes installa-
tion folder used by the application.

Report Manager
Cumulus can generate reports based on catalog statistics (number of previews, 
print outs, mail to, etc.) and reports based on Cumulus Server activity, such as 
successful and failed search results, client connection rates, and more.

Optional feature! May not be available with your Cumulus configuration.

The Report Manager enables you to configure reports customized to your needs. 
The created reports can be exported. For example, reports can help you “fine-
tune” your metadata values, because you can see exactly what users are search-
ing for. When a search fails, now you can see the term used. Reporting helps you 
ensure your system is tuned to perfection and that you’re getting the most out 
of it. 

Requirements
Generating usage evaluation reports is based on the record field Asset Usage His-
tory. This field has to be added to each catalog where you want to track usage. 
Once added you configure it and mark the activities you want to be tracked in 
the catalog.
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TIP: Asset Usage History Field
The asset usage tracked by this field can also be viewed in the Client 
application. Divide the Record pane with a sup-pane and select the 
Asset Usage History filter. 

Generating time related reports (search term and licensing reports) is based on a 
special Cumulus catalog. Its catalog name is $Statistics and its catalog file name 
is Statistics.ccf. This manual refers to it as the Statistics catalog. 
The Statistics catalog has to be managed by your Cumulus Server, meaning it has 
to be included in the Catalog Access list. It must not be shared nor published to 
the Internet.
It is possible to open the Statistics catalog with a Cumulus Client, but this is not 
recommended. There is only one reason to open the Statistics catalog with a 
Cumulus Client: If you want to have more fields than the default configuration 
offers, you can add record fields to the Statistics catalog. 

Working with the Report Manager
PRECONDITIONS: To use the functions of the Report Manager you must have 
the appropriate Report permissions for the Cumulus Server: Create, modify, 
delete reports. (Server Permissions  > Report Permissions)
To generate a report you create a report configuration and then use it to gener-
ate a report on demand. 

Required for usage evaluation tracking is 
a configured Asset Usage History record 
field. 
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Once you have created a report configuration, it is saved and listed under Con-
figured Reports. To generate a report you select its entry and click the Generate 
Now button. 

Configuring Reports
Reports are easy to configure. You can select from different report types: 

The options available for the report configuration depend on the selected report 
type.

Usage Reports
Remember that all usage reports require a configured Asset Usage History 
record field in the catalog tracked. Only usage types activated in the fields prop-
erties can be tracked and used for reports.
• Top Successful Search Terms

Search terms of queries that had a result. The report contains the frequency 
as well as the search term that the user entered sorted by the frequency. Note 

Example of a report configuration for tracking asset usage
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that only textual search operations are taken into account (e.g. in string or 
string list fields.)

• Top Unsuccessful Search Terms
Search terms of queries that led to no results. The report contains the fre-
quency as well as the search term that the user entered sorted by the fre-
quency. Note that only textual search operations are taken into account (e.g. 
in string or string list fields.)

• Top Asset Usage
Select the asset usage kind that should be reported (e.g. “Download”). The 
report shows the names of the assets that were used and the usage type, 
sorted by usage frequency. 
The results are displayed in a table that can be sorted by number of occur-
rence, date, etc. The table contents can be saved into a tab-separated text file 
to be imported into Microsoft Excel for evaluation and presentation.

• Top File Formats
This report shows the number of assets and the total asset data size per file 
format for each selected catalog. The purpose is to get an overview of how 
many assets of each format the catalogs contain and how much disk space 
they are occupying.

Under Asset Usages you will find all usage history options – even those currently 
not activated for the corresponding catalog. This enables you to generate 
reports even for usages that are no longer tracked in the catalog. However, make 
sure that for a report you only activate asset usages for such usages the corre-
sponding catalog can provide tracked data for.

Time Related Reports
Remember that time related reports require the Statistics catalog.
• Assets Added

Depending on the time period the list contains assets that were added to the 
selected catalogs.

• Checkouts
This report lists all combinations of user + asset along with the number of 
checkouts and checkout times during the given date range.

• Number of Searches
Depending on the time period, the list contains the number of queries being 
performed. The interval is either minute, hour, day or month depending on 
the length of the period.

• Number of Asset Usages
Depending on the time period, the list contains the number of asset usages 
(e.g. “Download” and “E-Mail”). The interval is either minute, hour, day or 
month depending on the length of the period.

• Client License Usage
Depending on the time period the list contains the number of users logged 
on as well as the number of licenses being used. The interval is either minute, 
hour, day or month depending on the length of the period.
The results can be displayed either in a table or in a graph. They can be saved 
into a tab-separated text file to be opened by MS Excel or in a graphics file 
(e.g. PNG).

• Generic Asset Query
This type of report returns a list of assets that match the given date range and 
also an optional server-side query. You can select the date field for the range 
and also sort the result by a given field.
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Generating Reports
To generate a report you select its entry and click the Generate Now button.
The generated reports can include text tables and images, which can be 
exported for use and analysis in spreadsheets, presentations and other pro-
grams. The Save As button lets you save the reports in formats that can be 
imported by other applications. 

TIP: 
The Cumulus Scheduler can run your configured reports at times you 
define. For more information see “Generating Reports,” p. 92

Editing or Removing Report Configurations
To edit or remove report configurations select the report’s entry and then click 
the appropriate button. 

Scheduler Manager
The Cumulus Scheduler enables you to define and schedule tasks to be automat-
ically performed by Cumulus. It will save you time and increase your productivity 
by automating frequent tasks. The Scheduler enables you to run time consuming 
functions during off-peak hours, and also enables you to automate routine tasks. 
In combination with the Cumulus Trigger feature, the Cumulus Scheduler makes 
a powerful tool to automate business processes and save wasted resources.
The Cumulus Scheduler consists of the Scheduler Manager and the Scheduler 
Server Application. The Scheduler Server Application be installed separately (on 
the computer that you want to perform the tasks; for details see the Installation 
Guide.) The Scheduler Manager lets you set up tasks that are to be performed by 
the Scheduler Server Application.

Setting Up a Scheduler Task
The set up for a Scheduler task includes:
• The Scheduler Action to be performed 
• The catalogs on which the Scheduler Action should be performed
• When the Scheduler Action should be performed
The Scheduler Actions are selected from a list and can be configured. The Sched-
uler Actions available depend on the Cumulus Server you are connected to. 
Available actions are stored in a special folder. 
How to install and configure the Scheduler Server Application is described in the 
Installation Guide.
The Scheduler Manager utility is included in the Cumulus Server Console. To 
work with the Scheduler Manager, a user /role must have the appropriate Sched-
uler Task Permissions (part of the Server Permissions of the respective user/
role).

Report on Client License Usage as a graph
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To set up a Scheduler Task with the Scheduler Manager: 

1. Select the File > Administration > Server Console, or connect to the Web 
Server Console via a Web browser.

2. The Server Console  is started. Log on as Cumulus Administrator (or the user 
who has the Scheduler Administrator permission) to the Cumulus Server 
that manages the catalogs you want to have Scheduler Tasks performed on.

3. Select Scheduler Manager. A window opens that lists all Scheduler Tasks.

4. To set up a new task, click the Create button. This dialog opens 

5. Select the Scheduler Action you want to be performed. 
If the selected action can be configured, the Configure button is activated 
and you can configure the action to your needs. (For more information see 
“Provided Scheduler Actions,” p. 94.)

6. Determine ’where’ the action is to be performed. Click Add to choose the 
catalogs. The list of catalogs is displayed that are managed by the Cumulus 
Server you are connected to. Select the desired catalogs in the list and click 
OK. 
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7. Determine when the action is to be performed. Under Schedule define:

• date and time for the first run. 
• the Repeat Interval. You can choose to have it repeated on specific days or 

use cron notation for more specific time data. If you decide on certain days, 
simply activate the check box(es) for the corresponding day(s). Cron nota-
tion should be used by specialists only. 

8. Decide whether and about what you want to be notified via email concern-
ing the run of the Scheduler task under Notifications:

NOTE: Notifications are sent only if the Notification option is activated in 
the Mail Manager. Also check there whether the email address of the 
intended recipient is included. 

9. Click OK to save your settings. Your new Scheduler Task is added to the list.

10. To activate the task, click the Activate button. – On activated tasks, the but-
ton changes to Deactivate.

All activated tasks are performed by the Scheduler Server Application at the time 
defined in the task. You need only make sure that the Scheduler Server Applica-
tion is running and that the computer running it is online and can access the 
Cumulus Server. 
From time to time you should check the status of the tasks, as it cannot be 
granted that they could be executed.
Use the Run Now button to execute any Scheduler task immediately. This is very 
handy when testing, when you don’t want a task to run at intervals, or when you 
need a task to run just once.

Provided Scheduler Actions 
Most of the Scheduler actions that Cumulus provides are the basis for powerful 
workflow possibilities. 

Note that some of the provided actions belong to optional features which may 
not be available with your Cumulus configuration.

Autocatalog Assets
You can configure the Cumulus Scheduler to autocatalog assets from any loca-
tion on your network, at any interval you need. There’s no need to leave a 
Cumulus Client application running, because the Cumulus Scheduler will handle 
it all. More so than drop-folder cataloging, this capability can serve as a basis for 
interfacing Cumulus with other systems that produce documents, such as 
invoicing systems or software that produces on-demand PDFs (or other formats). 
Within minutes of those files being produced, they can be safely cataloged into 
Cumulus and available to you from anywhere.
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This Cumulus Scheduler action also provides an email cataloging technology. 
Cumulus can check a standard POP3 email account and retrieve and catalog any 
email it finds. Email text is extracted into an asset record, and all attachments are 
cataloged and linked to the email record. 

Select the option to catalog emails from a POP3 account, enter the data of your 
POP3 Server and you can have emails cataloged automatically.

Copy, Move or Delete Assets
This action moves assets to archive locations, or deletes temporary or obsolete 
assets – all automatically, all based on metadata values. It even enables you to 
use Cumulus as the distribution system that moves files created by other systems 
to the locations you need.

You can define metadata values in your catalogs that direct the Cumulus Sched-
uler to copy, move or even delete assets. 
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Export Records
This action exports records found by a query to an xml file. 

You can select which metadata fields shall be exported from the found records, 
as well a s a Metadata Template to be applied before the export. You can also 
choose whether the resulting file is to be compressed or whether an XSL trans-
formation is to be applied.

Generate Usage and Statistic Report
Cumulus reports can be scheduled to occur at intervals you define, ensuring 
their contents are up to date and accurate. You can determine which reports you 
want run, choose when you want them run, and choose the catalogs to report 
on. You can also choose the output format and the destination for the output. 
The options available for the output format depend on the report type 
employed.

Select one of the reports you defined with the Report Manager and then have 
the Scheduler generate it at times you define for this Scheduler task.

TIP: 
You can use the Scheduler’s autocataloging to automatically catalog 
each new report back into Cumulus.
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Set Manager
The Set Manager enables you to export and import shared Cumulus items such 
as View and Asset Handling Sets as well as Templates, Actions, Collections and 
Queries. You can select the items before the Import/Export process is started. 
Another function enables you to unload all individual sets of all disconnected 
users in order to force a refresh when the users connect to the Cumulus Server 
again. This function lets the Cumulus Client application reload the individual sets 
of a user.
To use the Set Manager you need to be Cumulus Administrator.
To import or export Cumulus items (shortly called: sets) with the Set Manager:

1. Select the File > Administration > Server Console, or connect to the Web 
Server Console via a Web browser.

2. The Server Console  is started. Log on as Cumulus Administrator to the 
Cumulus Server that manages sets you want to export or that you want to 
import sets to. 

3. Click the button for the function you want to perform. 

4. Follow the on-screen instructions. 
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Managing Users
As a user administrator you have the job of managing user access to

catalogs. Not only does Cumulus let you define whether each catalog

is shared by your workgroup, but also how each catalog is shared by

each user. In this chapter, you will learn how to set up Client users, how

to make catalogs available to Client users, and how to define specific

user permissions.
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User Management
The Cumulus user management enables you to specify users and their access 
rights to certain catalogs and functions. 
Cumulus permissions are based on an additive concept. This means that a new 
user does not have any permissions by default. This minimizes the risk of grant-
ing permissions accidently but implies that you have to grant any new user at 
least the minimum permissions a user needs to work with Cumulus. 

NOTE: Migrating from Cumulus 6
Permissions have been based on this additive concept since Cumulus 6.5. 
Hence when updating from Cumulus 6 to Cumulus 6.5 or higher, the newly 
introduced Cumulus permissions (e.g for sets, action, queries and templates) 
have to be added to the properties of each user of your former Cumulus 6 
installation.

The Users Catalog
The user management is based on a special Cumulus catalog. Its catalog name 
is $Users and its catalog file name is Users.ccf. This manual refers to it as the 
Users catalog. 
The Users catalog has to be managed by your Cumulus Server, meaning it has to 
be included in the Catalog Access list. It must not be shared nor published to the 
Internet.
Canto has developed a special module to manage users with this catalog. The 
name of this module is User Manager (available via the Server Console.) 
It is possible to open the Users catalog with a Cumulus Client, but this is not rec-
ommended for user management. There is only one reason to open the Users 
catalog with a Cumulus Client: The user data are stored in record fields. If you 
want to have more fields than the default configuration offers, you can add 
record fields to the Users catalog. If you do this, always use the version of the 
Cumulus Client application that fits the version of your Cumulus Server.

Modes
Cumulus is intended to meet the needs of many different customers. This is why 
the Cumulus user management offers different modes. Whether you settle for 
user-based or role-based mode defines the method by which permissions are 
assigned. For both methods a simple and advanced view is offered for granting 
the permissions.

User- and Role-Based Mode
Cumulus provides two different modes for the method of managing users:
• the user-based mode where you assign the permissions to each user
• the role-based mode where each user can be assigned to roles that include 

certain permissions (Note that this is an optional feature which may not be 
available with your Cumulus configuration.)

The user-based mode was designed for a smaller number of users to be admin-
istered. You assign permissions and catalogs to each user individually.
The role-based mode was developed for a large number of users to be adminis-
tered. You can create roles that you use to assign a common set of permissions 
and catalogs to multiple users. Organizing users by defining roles makes it easier 
to manage access rights. With this strategy, rather than assigning permissions to 
each user for each object, you assign permissions to a few roles and then add 
users to the appropriate role. When using Cumulus, users are granted permis-
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sions based on any roles to which they belong.
When you create a user account for a new user, you add that account to the 
appropriate role. Then, the user has the permissions associated with that role. 
Also, changing permissions is easier: rather than having to change permissions 
for each user, you change the permissions assigned to the role. 
If you work with the role-based mode and you have a LDAP server, you can 
define mappings from LDAP groups to Cumulus roles. By using this mapping you 
no longer need an entry for this user in the User Manager. (See “Cumulus Roles,” 
p. 129, for further information.)
You have to decide which mode you want to work with. Once you have switched 
to the role-based mode you cannot switch back to the user-based mode. Both 
modes offer the same range of functions – except that the role-based mode 
offers roles to “bundle” users. So in case you have Cumulus users that can easily 
be “bundled” or split into different groups, we recommend that you employ the 
role-based mode. And we do not recommend that you start with the user-based 
mode and then switch to the role-based mode, otherwise each user you have 
defined will be converted to be a role.
The user-based as well as the role-based mode works with the Users catalog and 
the User Manager module to manage users with this catalog.

Simple View and Advanced View
The user-based as well as the role-based mode can be used in either the simple 
or the advanced view. The simple view subsumes several permissions whereas 
the advanced view lets you assign permissions in a very granular manner. For 
more information, see “Simple View: Catalog Permissions,” p. 106, and “Advanced 
View: Permissions,” p. 107.
The simple view enables you to set user or role permissions for a single catalog, 
or your entire Cumulus Server with just a few mouse clicks. You can switch to the 
advanced view when you need to make more granular changes. Both modes are 
always available, so you don’t have to choose just one.

NOTE: Migrating from Cumulus 6
When migrating from Cumulus 6 Canto recommends you to use the 
advanced view for checking and updating the permissions.

User Manager
To work with the User Manager you need to have the appropriate Administrator 
permissions for the server: User Administrator.
The User Manager is one module of the Cumulus Server Console. To start the 
User Manager:

5. From within the Cumulus Client, select File > Administration > Server Con-
sole, or connect to the Web Server Console via a Web browser.

6. Log on to the Cumulus Server you want to administrate as Cumulus Admin-
istrator or as user who has the permission: User Administrator.

The modules of the Server Console application are loaded.

7. To reveal the User list click the + icon on the left side of the entry User Man-
ager. Then click on the entry Users. The list of users will be displayed. 
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The Users List

The first step is to set up the users you wish to give access to working with your 
Cumulus installation. If you want to import user data from Cumulus 5 catalogs, 
see “Importing Users and Permissions from Cumulus 5 Catalogs,” p. 121. If you 
want to import user data from a Cumulus Internet solution, see “Importing User 
Data from Cumulus Internet Solutions,” p. 122.

Creating Users
A new user does not have any permissions by default. We recommend that you 
create “typical” user accounts that fit the needs of your organization first and 
then duplicate these user accounts to set up the real users. However, when using 
this method, remember to keep such users up-to-date, e.g. when adding new 
catalogs. Create as many of these account “templates” as you need. 

TIP: User Settings
Administrators have no access to each user’s preference settings, so 
users must make user setting changes on their own. If you want to 
provide a default set of User Settings for each newly created user, also 
configure the User Settings of your “typical” user accounts as you 
need. 

To add a new user to the Users list:

1. Click the Create button. 
OR
Select your “typical” user and click the Duplicate button.

IMPORTANT! 
Check whether this user’s properties are up-to-date – especially the catalogs 
that she/he is allowed to access. 

A dialog is opened.

2. Enter the Login name for the new user and click OK. The name must be 
unique.

The properties window for the new user is opened.

Only if you want to have the user always be identified by the UUID provided 
by the Cumulus Built-in authenticator and stored in the Users catalog, acti-
vate the Unique User ID option. (For more information on the Unique User 
ID, see “User Identification,” p. 105.)
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3. Activate the Login Active checkbox if you want to allow the user to work 
with Cumulus immediately after you have closed the user’s properties win-
dow.

4. Select the authentication method. You can choose different methods for dif-
ferent users of your Cumulus installation. The provided choice of authentica-
tion methods is:

• Built-in – The Cumulus built-in authentication will be used exclusively. 
Advantage: Independent from the system you are using.
With this authentication method only, different options for changing the 
password are available.

• System – The user password will be authenticated by the system. Advan-
tage: Password must be changed once only.

• LDAP – If you are employing LDAP (Lightweight Directory Access Protocol) 
the user password will be authenticated by LDAP. Advantage: Password 
must be changed once only. (See “LDAP Authentication Method,” p. 127, 
for details on how to use this method with Cumulus.)

5. Click the  button to enter a password for the new user.

NOTE: Don’t forget to inform your new user about this login name and 
password. 

6. Enter the data for the new user in the corresponding fields of the General 
and Additional Fields sections. (See “Overview: User Properties – General & 
Additional Fields,” p. 104, for more information on the sections and fields). 

7. If working in user-based mode: Set the permissions for the new user. (See 
“Simple View: Catalog Permissions,” p. 106, or “Advanced View: Permissions,” 
p. 107, for more information.) 

If working in role-based mode: Assign the user to a role. On the Role tab click 
the Add button to get a list of available roles. Select the role(s) you want to 
assign to the user and click OK.

NOTE: Due to the additive permissions concept, the permissions a user 
has got are the sum of the permissions given to all roles the user is 
assigned to. 

8. Click OK to save the defined properties.

Duplicating, Editing and Deleting Users
For duplicating, editing and deleting users select the user’s entry and then click 
the appropriate button. Duplicating a user works the same way as creating a new 
user except that when duplicating the properties of the duplicated user are cop-
ied for the new user – all properties except the login name.
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User Properties
A Cumulus user’s properties include her/his contact information and, in the user-
based mode, the permissions she/he has for functions and catalogs. The User 
Properties window has several sections that provide access to the information 
stored on a user. These sections are:
• General – Login information and basic personal information 
• Additional Fields – Additional contact information on the user
In simple user-based mode additionally:
• Permissions – Global permissions and catalog permissions
In advanced user-based mode additionally:
• Catalogs – Cumulus catalogs the user is allowed to access
• Permissions – Permissions the user has on these catalogs
• Server Permissions – Permissions the user has for functions and objects man-

aged by the Cumulus Server.
In role-based mode additionally:
• Roles – Roles the user is assigned to
The following overview describes the General and Additional Fields sections 
only. 

erview: User Properties – General & Additional Fields
 User Properties window has several sections that provide access to the information on the selected user. 

eral Section 
General section contains the basic information on a user.

ust be activated to enable the user to log on.
isplays the user’s login name; the name must be unique.

f activated, user will always be identified by the UUID. For more 
nformation, see “User Identification,” p. 105.

isplays the selected authentication method.
lick this button to have the available authentication methods 
isplayed. For more information on authentication methods, see 

Creating Users,” p. 102.
isplays the encrypted password. (Note that the placeholder stars 
re shown even if no password is set, e.g. when creating a new 
ser.)
lick this button to enter or change the password. 
OTE: Don’t forget to inform the user about her/his password.
isplays the date when the password was last modified. This date 
long with the maximum password age defines when the user 
as to change her/his password. The value for the maximum 
assword age is defined in the Cumulus Server Settings (see 

Overview: Cumulus Server Settings,” p. 84).
hould contain a valid e-mail address. If the E-Mail Address field 
oes not contain an address, the user cannot make use of any of 

he e-mail functions of Cumulus Web Client or Sites.
f this field does not contain a value the user’s login will not expire.
lick this button to select an expiration date for the user’s login.
nable the desired option for changing the password. (Only avail-
ble with the Cumulus built-in authentication method.)

NOTE: The Password never expires option overwr
the maximum password age set for Cumulus users’
passwords in the Cumulus Server Settings (see “Ove
view: Cumulus Server Settings,” p. 84).

13 Switches the permissions management from Advan
View to Simple View and vice versa. The Advanced v
provides three tabs for the permissions manageme
where as in simple view the user or role permissions
subsumed and offered on one tab. For details see “S
ple View and Advanced View,” p. 101.

5
6

2

8

9

7

3

1

4

12

13

1110



MANAGING USERS –  USER PROPERTIES 105

Add
The 
cata
14 S

c
l

15 S
N
u
P

16 C

Ov
User Identification
Cumulus uses a Unique User ID (UUID) for user identification. A UUID consists of 
a definition of the authenticator and a unique ID from the authenticator. The 
authenticator is required to provide a unique ID. 
In the User Manager, a user’s properties are enhanced by a Unique User ID (Gen-
eral tab). If this option is enabled, the user will always be identified by the UUID 
provided by the Cumulus Built-in authenticator and stored in the Users catalog.

The UUID is used when record and category permissions are checked. If you 
employ the Cumulus Built-in authenticator the Unique User ID option must be 
activated to enable the user to connect to the Cumulus Server. If you employ a 
different authenticator (e.g. LDAP), it might provide own UUIDs. If you want to 
use these UUIDs, you must deactivate the Unique User ID option in the Cumulus 
user’s properties. 

NOTE: Changing the Authentication Method!
If you change the authenticator and use its UUIDs, the permissions set for a 
user are no longer valid. They must be set again for the ’new’ user (identified by 
the UUID of the other authenticator.) 

itional Fields Section 
fields displayed in this section depend on the record fields on the 
log displayed in alphabetical order (A-Z).
hould contain an address. If the Shipping Address field does not 
ontain an address, the user cannot make use of any of the Cumu-

us Web Client CD delivery functions.
aves the information on the user and closes the window. 
OTE: Depending on configuration, it may last up to 30 minutes 
ntil the changes become valid for the Cumulus Web Client, Web 
ublisher Pro or Internet Client Pro web application(s).
loses the window without saving any changes.

erview: User Properties – General & Additional Fields

14

15 16
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Simple View: Catalog Permissions
In simple view the user or role permissions are subsumed to global permissions 
or permissions on catalog base. 

You can either grant a user global permissions or grant “individual” permissions 
for catalogs. Once you grant a user the global permission, the user has this per-
mission for any catalog – no matter whether the permission is given for the cat-
alog or not.
Global permissions are:
• Read Metadata – User can view catalogs and the metadata of all record and 

categories.
• Write Metadata – User can edit the metadata of all record and categories, e.g. 

can catalog assets and add metadata to records.
• Delete Records & Categories – User can delete records (and their assets) as 

well as categories.
• Manage Sets & Templates – User can create, edit and delete sets, templates 

and actions (all items defined for the Cumulus application in the Preferences 
window – except Catalog Templates and Catalog Settings). 

• Administrator – User can perform all administrative tasks and use the accord-
ing utilities (e.g. User Manager, Backup Manager). For example, the user can 
create catalogs and configure them via the Catalog Settings in the Prefer-
ences window; furthermore the user can set up Catalog Templates. The user 
is also allowed to configure Cumulus Vault, define Scheduler tasks and gen-
erate reports.

Catalog permissions:
• Read – short for Read Metadata (description see above)
• Write – short for Write Metadata (description see above)
• Delete – short for Delete Records & Categories (description see above)

IMPORTANT! 
Minimum Permissions 
In simple view the minimum permissions required for a user to work with 
Cumulus are: Read for at least one catalog. Or if catalog specific permissions 
are not required, Global Permission Read Metadata. 
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TIP: 
You can use the simple view in conjunction with the advanced view – 
make “broad stroke” permissions settings in simple view and then fine 
tune them exactly as you need in advanced view.

Advanced View: Permissions
Cumulus provides an enhanced permissionsmanagement. Each user’s or role’s 
properties include several permission sections:
• Catalog Access – Cumulus catalogs the user is allowed to access.
• CatalogPermissions – Permissions the user has for these catalogs.
• Server Permissions – Permissions the user has for functions and objects man-

aged by the Cumulus Server.

NOTE: Permission changes made to the account of a connected user will not 
take effect until that user logs out and back in again. Keep this in mind when-
ever you’re testing permissions options on your Server. 
If you don’t log out of your test account, you might think your changes are not 
taking effect. 

IMPORTANT! Minimum Permissions
In advanced view the minimum permissions required for a user to work with 
Cumulus are: the Application Permissions Open Catalog with any Cumulus 
Client, View Item for Records and access to at least one catalog, one Record 
View Set and one Category View Set. 

Catalogs
The permissions for a user’s access to catalogs are defined in the Catalogs section 
of the Properties window for the user or role. 
You can allow a user to have access to all catalogs that are managed by the 
Cumulus Server or restrict the access to selected catalogs.

Access to All Catalogs
If the Restrict Catalog Access option is not enabled, the user is allowed to access 
all catalogs that are managed by the Cumulus Server and enabled for sharing. In 
this case 
• all catalogs added to the Cumulus Server are automatically available to this 

user 
• the permissions set in the Permissions section are valid for all catalogs.
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Restricted Access to Selected Catalogs
If the Restrict Catalog Access option is activated, you can set the permissions 
either for all of the allowed catalogs or individually for each of the allowed cata-
logs. 

Before you consider activating the Restrict Catalog Access option, you should 
be aware of the following. In this case, each newly created catalog which you 
want this user to have access to must be added to the list of catalogs.

IMPORTANT! 
Restrict Catalog Access Option
Any user should have access to at least one shared catalog!

Catalog Permissions
A user’s permissions for catalogs are defined in the Catalog Permissions section 
of the Properties window for the user. The catalog permissions refer to the cata-
logs defined in the Catalogs section of the Properties window.
A user’s permissions for catalogs can be set collectively for all allowed catalogs or 
individually for selected catalogs. However, note that the permissions individu-
ally set for selected catalogs are always added to the permissions that are set for 
all allowed catalogs.

Once you have clicked on the Catalog Permissions section of a user’s properties, 
you select the catalog you want to set the permissions for. Set the permission for 
All Allowed Catalogs first and then select the catalog for which you want to set 
the permissions individually. 



MANAGING USERS –  ADVANCED VIEW: PERMISSIONS 109
Application Permissions
The Application Permissions define the user’s general permissions for functions 
on catalogs, records, categories and assets as well as the user’s permissions when 
accessing Cumulus via Web.  

NOTE: If you give one of these permissions for All Allowed Catalogs, the user 
will have this permission for all catalogs managed by your Cumulus Server. 

IMPORTANT! Minimum Application Permissions
The minimum Application permission required for a user to work with 
Cumulus is Open Catalog. 
With Enterprise or the Extended Permissions add-on, these Application permis-
sions can be expanded by individual Record or Category permissions. If you want 
to make use of this feature, you can follow two different concepts:
• You assign the Application permissions as needed in general and use the 

individual Record or Category permissions to add permissions for selected 
records and categories due to special purposes.

• You reduce the Application permissions to a minimum of permissions (even 
none) and use the individual Record or Category permissions to set permis-
sions on the record/category level. This concept offers the advantage that 
you can remove permissions for specific users/roles on the record/category 
level. You can even use a Permissions Template to do so. If following this con-
cept, Canto recommends you to set up a special Permissions Template used 
for cataloging that assigns the permissions you would like a ’normal’ user to 
have.

For more information on individual Record or Category permissions, see the Cli-
ent User Guide.
The following section describes which permission is needed to perform which 
function.

Permissions for Entire Catalog
These permissions govern the user’s access to the selected catalog itself.
• Open Catalog with any Cumulus Client – needed to gain access to the cat-

alog in order to open it; e.g with a Cumulus Client application to get the cat-
alog displayed in the Catalog Access window. “Any Cumulus Client” includes 
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the Cumulus Client application, Cumulus Web Client, Sites, HELIOS Compan-
ion, and any individually programmed application based on Cumulus Java 
Classes. 
NOTE: The catalog access can be restricted to certain Cumulus Client ver-
sions and variations. See “Client Groups,” p. 122, for further information. If 
you have set up any Client Groups, the options for the Catalog Permis-
sions will be enhanced with an entry Open Catalog with for each 
defined group. 

• Modify Catalog Category Permissions – needed to define permissions for 
categories that represent catalogs (optional.)

• Manage Catalog Triggers – needed to create, edit and delete own triggers 
for catalogs. 

Permissions for All Records and Categories
These permissions govern the user’s access to the records or categories of the 
selected catalog. 
• View Item – With Enterprise or the Extended Permissions add-on only: allows 

a user to see all records/categories – even if Live Filtering is active. 
• Create Item – needed to catalog assets/create categories and to import 

records/categories.
• Modify Items – For records: needed to modify records (manually or via auto-

mation) and to update records (as this includes modifying the records). This 
permission is also needed for checking assets in or out with any version con-
trol system, e.g. Cumulus Vault. 
A user who is allowed to modify records, may additionally be allowed to 
change the asset reference that is included in the record. The permission for 
modifying the asset reference must be given explicitly by assigning the Mod-
ify Item Reference permission.
For categories: needed to rename, modify and move categories and for the 
synchronization and auto-cataloging functions. 

• Delete Items – needed to delete records/categories.
• Modify Item Permissions – With Enterprise or the Extended Permissions 

add-on only: needed to edit individual record/category permissions.
• Manage Item Triggers – needed to create, edit and delete own triggers for 

records/categories.

Asset Permissions
Certain functions require accessing the assets directly. The following permissions 
grant this access for the assets cataloged to the selected catalog:
• Delete Assets – needed to delete assets.
• Transfer Assets – needed for any function where accessing the asset directly 

is required but where the Cumulus Client (native or Web) user cannot access 
the assets directly. In other words, this permission is needed for Server/Client 
asset transfer and for Cumulus Web Client, and Sites. If Server/Client asset 
transfer is employed, this permission is needed to get a preview displayed. 
With any version control system, e.g. Cumulus Vault, this permission is also 
needed for copying, moving or previewing assets.

• Asset Versioning – needed to use any version control system, e.g. Cumulus 
Vault. Along with this permission the Modify Records permission is always 
needed to check assets out or in.
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Web Permissions (needed for Cumulus Internet Solutions only)
These permissions govern the user’s access to assets when the user employs a 
Cumulus Internet Solution as client to work with the selected catalog. 
• Collect Asset for CD– needed with Cumulus Web Client to have the function 

Collect for CD-ROM available in the Collections Basket.
• Download Asset – needed with Cumulus Web Client and Sites. Along with 

this permission the Transfer Asset permission is always needed to download 
assets.

• Show Original Asset– needed with Cumulus Web Client and Sites to have 
the original asset displayed with the Show Original command. Along with 
this permission the Transfer Asset permission is always needed to have the 
original assets displayed.

• Email Assets – needed with Cumulus Web Client for e-mailing assets. Along 
with this permission the Transfer Asset permission is always needed to email 
assets.

Subtable Permissions
The Application Permissions also define a user’s permissions for Table fields. The 
User Comments feature is based on such a subtable. This means that the permis-
sions for this feature are managed with the permissions granted for the corre-
sponding field: User Comment Thread. To make full use of the User Comments 
feature, a user needs the view, create, modify and delete permissions. 

Tracking an asset’s usage history is also based on a Table field: Asset Usage His-
tory. If you want a user to be able to see an asset’s usage history, you have to 
grant the view permission to that user.

Permissions for the User Comment Thread field. Required to enable a 
user to make full use of the User Comments feature are view, create, 
modify and delete.
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Administrator Permissions
The Administrator Permissions refer to administrative functions for catalogs.

NOTE: If you grant one of these permissions for All Allowed Catalogs, the 
user will have this permission for all catalogs managed by your Cumulus 
Server. 

• View Catalog Settings – The user is allowed to view the selected catalog’s 
settings in the Catalog Settings window of the central Cumulus Preference 
window. 

• Modify Catalog Settings – The user is allowed to make modifications for the 
selected catalog in the Catalog Settings window of the central Cumulus Pref-
erence window. A user who is allowed to modify the catalog’s settings, may 
additionally be allowed to set up and modify a central asset location for the 
selected catalog. The permission for modifying the central asset location 
must be given explicitly by assigning the Modify Central Asset Location per-
mission. The permission for setting up mirroring for the catalog must be 
given explicitly by assigning the Manage Mirroring permission.
NOTE: Canto recommends that you allow only one user to have access to 
this or have one person responsible per catalog. If several users have the 
permission for modifying the Catalog Settings you might get into trouble 
when they modify at the same time, as the first user accessing the Catalog 
Settings and saving changes blocks those with access to the Catalog Set-
tings from saving their changes. 

• Manage Log Files – The user is allowed to start the Log Manager module and 
set up a log file for the selected catalog.

• Monitor Activity – The user is allowed to start the Activity Monitor module 
and to view the list of users connected to the selected catalog. The user is 
also allowed to disconnect users from the selected catalog.

• Trigger Administrator – needed to create, edit and delete all triggers of all 
users

Additional Permissions
This section gives you the possibility to include permissions that are used by 
additional EJaPs, Internet solutions and solutions based on Cumulus Java Classes. 
For details as to which permission should be included, ask the producer or pro-
grammer of the additional software.

Set, Action, Query and Template Permissions
For the selected catalog, you can restrict the user’s access to selected items of 
one type (sets, actions, queries and templates). If you restrict the user’s access to 
a selection of shared items of this type, the items not selected will not be avail-
able for the user. 
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NOTE: If you grant one of these permissions for All Allowed Catalogs, the 
user will have this permission for all catalogs managed by your Cumulus 
Server. 
If the Restrict Access option is not enabled, the user is allowed to access all 
shared items of the selected type that are enabled for sharing. 
To restrict a user’s access to a selection of shared items only, enable the Restrict 
Access to option. Use the Add button to set up the selection.
If the Restrict Access option is enabled, you have to add items. Otherwise the 
user has no access to any item of the selected type in the catalog.

Before you consider activating the Restrict Access option, you should be aware 
of the following: each newly created item which you want this user to have 
access to must be added to the list.
If the user is working with a multi-catalog collection (a collection that includes 
records from more than one catalog), the new impact of the Restrict Access 
option has the following consequences when selecting sets, actions, queries and 
templates: The user can only choose items that are available for him/her for all 
catalogs included in the collection. In other words, only such items that belong 
to the intersection of the permissions that the user has for all catalogs included 
in the collection. If the user opens another catalog in an existing collection, the 
selection of available sets, actions, queries and templates might change. 

NOTE: Be careful when using this permission feature. Erroneous configura-
tions for Record and Category View Sets can prevent the user from seeing any 
records/categories. 

IMPORTANT! Restrict Access Option
A user needs at least access to one Record View Set, one Category View Set and 
one Asset Handling Set. Without these permission granted, a user cannot open 
a catalog. 

TIP: Checking Assigned Sets, Templates etc.
The Server Console Action menu offers a Check Users Catalog func-
tion for the User Manager item. This function searches for settings 
(sets, templates etc.) that are assigned to users (or roles) in the Users 
catalog but no longer available with your Cumulus installation. If any 
settings are found that are assigned but not available, the function lets 
you remove the assignments from all users (or roles) in the catalog.
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Migration
The permissions for sets, actions, queries and templates are new since Cumulus 
6.5. You have to add these permissions to the properties of each user of your for-
mer Cumulus 6 installation.
In Cumulus 7, this Restrict Access option for the items listed above has been 
moved from Server Permissions to Catalog Permissions. This enhances the 
impact of the option: now the restricted access can be set on a catalog-by-cata-
log basis.
The only Restrict Access option available under Server Permissions belongs to 
Collections Permissions because collections can span across catalogs.

Server Permissions
A user’s permissions referring to the Cumulus Server are defined in the Server 
Permissions section of the Properties window for the user. The permissions 
defined in this section do not refer to any catalog but to the settings managed 
by the Cumulus Server. 

User Permissions
These permissions define what the user is allowed to modify on her/his own user 
settings in the User Settings window of the central Cumulus Preference window.
The permissions refer to the different sections of the User Settings window. 

If you are working in role mode, the User Permissions section additionally pro-
vides the possibility to replace certain user settings of all users belonging to a role 
with the settings of a defined user. Thus you can easily achieve that all users 
belonging to a certain role have, for example, identical search and sort settings.
All you have to do is to create a new user, specify his/her user settings according 
to your ideas, then take this user to have the appropriate settings applied to all 
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other users belonging to the role. Changing the settings of your template user, 
affects the settings of these users accordingly as soon as they log in (again).

If certain user settings are replaced by the settings of a specific user, the mem-
bers of the role are no longer allowed to change their respective user setting by 
themselves. If, for example, the Replace Search & Sort Settings with settings of 
is activated (as seen in the screenshot above), the Modify Search & Sort User 
Settings option is deactivated automatically.

IMPORTANT! Be careful with users belonging to more than one role!
If different roles have defined user settings replacement for the same parts of 
the user settings, but from different template users and with different values, 
the result for a user belonging to several roles is a purely random replacement!

Run-as Permissions
The Run-as permissions define as which other user(s) a user may act.
The Run-as function (File > Administration > Connect to Server As) is useful e.g. 
for substitution purposes, or for an administrator who needs to test the configu-
ration of users or roles.

Administrator Permissions
You can assign the following administrator permissions:
• Browse for Users – The user is allowed to employ the Add User button to 

search for users when setting up Triggers with Mail Notification for other 
users and – optional only – individual permissions for records/categories and 
Permissions Templates. With Enterprise this permission is also required to be 
able to search for users with the Restrict Edit to the following Users and 
Roles or the Restrict field visibility to the following users and roles options 
in the properties of a record or category field.

• User Administrator – The user is allowed to work with the User Manager.
• Backup Administrator – The user is allowed to start the Backup Manager 

module and define rules for the automatic backup of catalogs.
• Vault Administrator – The user is allowed to administer the Vault Server.
• Mail Administrator – The user is allowed to work with the Mail Manager and 

configure Cumulus to work with an email server. 
• Global User Administrator – The user has global user administrator permis-

sions.
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• Department User Administrator Permissions (if Global User Administrator is 
not activated)– The user may have department-specific user administration 
permissions which can be set in this table.

• Keep in mind that the effective permissions may differ from the assigned per-
missions! For example, assigning read-write permission to a top-level depart-
ment results in read-write permissions for all subordinate departments, no 
matter what permissions they are assigned to individually. If Global User 
Administrator is activated, the Effective Permission is always Read Write.

NOTE:
Department-specific user administrator permissions only operate if Global 
User Administrator permissions is deactivated.

Additional Permissions
This section gives you the possibility to include permission that are used by addi-
tional EJaPs, Internet solutions and solutions based on Cumulus Java Classes. For 
details as to which permission should be included, ask the producer or program-
mer of the additional software.

Set, Action, Query and Template Permissions
These permissions define how the user is allowed to work with:
• Record View Sets
• Category View Sets
• Asset Handling Sets
• Asset Actions
• Metadata Templates
• Print Templates 
• Permissions Templates (optional) 
• Sub-Pane Filters 
• Collections
• Scheduler Jobs
• Record Queries
• Category Queries (optional)
The permissions you can set for all these items are similar. For each type you can 
define whether the user is allowed to manage her/his own sets, actions, queries 
and templates. The permission manage includes creating, viewing, modifying 
and deleting.
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NOTE: Collection Permissions
The permission Manage User Collections is also required for saving the con-
tents of the Collection Basket pane or the Cumulus Web Client / Sites Collection 
Baskets. 

For shared items you can define the permissions:
• Create
• View (in the Preferences window)
• Modify
• Set Default
• Delete
• Manage
You can set these permissions for all shared items.

Live Filtering™ 

Optional feature! May not be available with your Cumulus configuration.

You can have certain users to have a “filtered view” on a catalog. The view of a 
user or a user group can be limited to preselected categories and/or records. For 
example the asset access for the sales staff can be limited to final, approved 
material, while the work in progress in the Marketing department should not be 
visible. 
If you want to restrict a user or a role to seeing and working with only certain cat-
egories and/or records, you can do so by means of Categories and/or Records Fil-
ter. These filters are defined via saved search queries. If you restrict the access to 
a catalog through a filter, the user’s access to the catalog is restricted to the 
search result of the query employed as filter. Each time the user opens the cata-
log, a search employing the selected query is performed. That way the user gets 
a current result of the search query you defined to work with.
To restrict the access to a catalog through filters:

1. Open the user’s or role’s properties.

2. Select the Permissions section

3. Select the catalog(s) you want to set the Live Filtering for under Permissions 
for.

The Live Filtering icon will be enabled and can be selected.
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4. Click the Live Filtering icon.

5. If you want to restrict the access to selected categories, enable the Use Cat-
egory Live Filtering option. Then select the query to be used. For a centrally 
stored shared query use the Use Query button. For any other exported 
query use the Use File button.

6. If you want to restrict the access to selected records, enable the Use Record 
Live Filtering option. For this option you can select one of the following 
ways of filtering records:

• Automatically Use Resulting Categories for Record Live Filtering
The user will only see the records that are assigned to categories that have 
been found by the query used for Category Live Filtering.

• Use Record Query
The user will only see the records found by the selected record query. For 
a centrally stored shared query use the Use Query button. For any other 
exported query use the Use File. 

7. When you click the Use Query or Use File button a dialog for selecting the 
corresponding query will open.

NOTE:  If you cannot open the default folder for storing queries, it may 
be due to its folder properties. If the folder properties are set to Hidden, 
this folder cannot be addressed by the Select dialog. Then you either have 
to change the folder properties or save the queries to another location 
that you can access.

8. Select the query you want to apply as filter and click OK/Select. The query is 
saved with the filter and the search conditions of the query are displayed. 
Note that the data of the query is saved with the filter and if you change the 
query later on, the filter will not be changed accordingly.

NOTE: If you want to use an exported query file, make sure that the query 
you select matches the corresponding Live Filtering option:
– For Live Filtering Categories, use a query saved with the Find Cate-
gories window.
– For Live Filtering Records, use a query saved with the Find Records 
window.
It is a good idea to name the queries so you have a hint. 

For Live Filtering Records additional options are offered. Under Live Filter-
ing Options, you can define if the records displayed for the user include 
records from categories above and/or below the found categories. This is 
important only if your defined Record Live Filtering includes categories as a 
filtering condition (either based on the result of Category Live Filtering or 
using a record query that searches in the Categories record field). 

9. Click OK to save the user’s properties.

The Live Filtering access restrictions are valid for the user next time the user 
logs on to the Cumulus Server. 

To undo a Live Filtering restriction, disable the corresponding option. The query 
will not be active any more and all records/categories will be available for the 
user next time the user logs on to the Cumulus Server. 

Live Filtering and the Additive Permissions Concept
Remember that Cumulus permissions are based on an additive concept. By 
default, Live Filtering works in accordance with this concept. 
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Multiple Roles
If a user is assigned to multiple roles, her/his permissions are the sum of the per-
missions of these multiple roles. So if assigned to multiple roles with different 
Live Filtering restrictions, the user has access to the sum of the search results 
defined by the queries applied to those roles.

Queries and View Permissions 
A user who is allowed to open a catalog but not to view its records or categories 
will nevertheless be able to see the records/categories found by the queries 
assigned to her/him by Live Filtering. 

Individual Permissions for Records and Categories Precede Queries
A user who by individual permissions for records/categories is allowed to view 
records/categories will always see them – regardless of the results of Live Filter-
ing queries. Individual permissions for records /categories have priority.

Working with the Role-Based Mode
Optional feature! May not be available with your Cumulus configuration.

Before you start working with the role-based mode, you should set up a role con-
cept that fits the company needs. 
You can create roles that you use to assign a common set of permissions and cat-
alogs to multiple users. A role includes:
• Catalogs – Cumulus catalogs an assigned user is allowed to access.
• Catalog Permissions – Permissions an assigned user has for these catalogs 

(including Live Filtering options).
• Server Permissions – Permissions an assigned user has for functions and 

objects managed by the Cumulus Server.

Switching to Role-Based Mode
Once you have decided to work with the role-based mode, you have to switch to 
this mode. 

NOTE:
This switch cannot be undone. 

1. Highlight the User Manager entry in the left panel of the Server Console. 

2. Select Actions > Switch to Role-Based Mode. A warning is displayed.

3. Click Yes. A message informs you that you have to disconnect from the 
Server in order to have the role-based mode activated. 

4. Click OK.

5. Select Server > Disconnect. 



120 CUMULUS® –  ADMINISTRATOR GUIDE
6. Select Server > Connect. Log on to the Cumulus Server again as Cumulus 
Administrator or the user who has the permission (User Administrator). Now 
the role-based mode of the User Manager is active.

If the you have switched to role-based mode of the User Manager, the User Man-
ager entry in the Server Console offers a new option: Roles

To reveal the Roles click the + icon on the left side of the User Manager entry. 
Then click on the entry Roles. The list of roles will be displayed. 
The first step when working with the role-based mode is creating roles.

Creating New Roles
To create a new role:

1. In the Roles list, click the Create button...

2. Enter a name for the new role and click OK.

NOTE: If you want to use the automatic role mapping between LDAP 
groups and Cumulus roles, the role name needs to match the value of an 
attribute of the corresponding LDAP group. (For details on how to map 
roles and LDAP groups, see “Cumulus Roles,” p. 129.) 

The properties window for the new role is opened. 
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NOTE: The Department section is displayed only if you have set up 
departments. Departments is an optional feature which may not be 
available with your Cumulus configuration. 

3. Set the permissions for the new role in the Catalogs, Permissions and Server 
Permission sections. (See “Advanced View: Permissions,” p. 107, for more 
information on the sections). 

4. Assign users to this role either 

• by clicking the Add button to assign users managed by the Cumulus User 
Manager, or

• by mapping of LDAP groups to this role if you want to assign users man-
aged by your LDAP server only. For information on how to map roles and 
LDAP groups, see “Cumulus Roles,” p. 129.

5. Click OK to save the defined properties.

Duplicating, Editing and Deleting Roles
For duplicating, editing and deleting roles select the role’s entry and then click 
the appropriate button. Duplicating a role works the same way as creating a new 
role except that when duplicating, the properties of the duplicated role are cop-
ied for the role user.

Actions for User Manager
The Actions menu for the User Manager module provides several administration 
utilities. 

Importing User Data
The User Manager offers functions to import data from Cumulus 5 Catalogs and 
Cumulus Internet Solutions.

Importing Users and Permissions from Cumulus 5 Catalogs
After you have added your Cumulus 5 catalog to the Catalog Access List of your 
current Cumulus installation, you can use a function that imports all information 
on user rights included in the Cumulus 5 catalogs into the User Manager. 
If the user is known (identified by the Login name), the function will add the cat-
alog to the list of catalogs for the user (section Catalogs in the user’s properties) 
and import the permissions for this catalog (section Permission).



122 CUMULUS® –  ADMINISTRATOR GUIDE
If the user is not known, the function will create a new user for each user who had 
permissions for the Cumulus 5 catalog and then will add the catalog and its per-
missions to the new user.
Use Actions > Import C5 - Catalog Permissions to import users and permissions. 
Enter the login data for the Cumulus Server managing the catalog and select the 
catalog.

NOTE: If working with the role-based mode of the User Manager and using 
the Import C5 - Catalog Permissions function, a role will be created for 
each permission of the Cumulus 5 catalog and each user who had this permis-
sion for the Cumulus 5 catalog will be assigned to the corresponding 
role.Cumulus 5 & Cumulus 6 User Permissions

This is how the Cumulus 5 user permissions are transferred to Cumulus 6 user 
permissions:
• Open this Catalog – Open Catalog
• Modify Category List – Create Categories, Modify Categories, Delete Catego-

ries
• Modify Records – Create Records, Modify Records
• Delete Records – Delete Records
• Transfer Asset – Transfer Assets, Checkout Assets, Collect Assets, Delete 

Assets, Download Assets, Email Assets

Importing User Data from Cumulus Internet Solutions
Use Actions > Import ICP/WPP Users Catalog to import the user data from a 
Cumulus Web Publisher Pro 1.0 or Internet Client Pro 2.0 $Users/$UsersAnd-
Groups catalog.
Use Actions > Import XUSR Files to import the user data provided by Cumulus 
Web Publisher Pro or Internet Client Pro.

Client Groups
Client Groups are a means to restrict access to Cumulus to certain applications 
(e.g. Cumulus Client, Web Client, Sites, QXP Companion, etc) or versions of appli-
cations.
For each defined Client Group an entry Open Catalog with is added to the avail-
able Catalog Permissions of a user or role.
Additionally, you may Force Read Only Catalog Access for any defined client 
group. If the user opens a catalog with a Cumulus product that is contained in 
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such a client group, only read access is possible, regardless of any other permis-
sions set for the user. 

NOTE: Force read Only Catalog Access and Cumulus Sites
The force read only option is especially interesting if applied to client groups 
that include Cumulus Sites in their definition. Unlike any other Cumulus Client, 
Cumulus Sites does not require a Cumulus license when accessing a catalog in 
read only mode. Thus, visitors from the internet may browse your Cumulus 
catalogs without generating additional charges.
To work with Client Groups:

1. In the left panel of the Server Console window, click on the entry 
User Manager. 

2. Select Actions > Edit Client Groups.

The Edit Client Groups window is opened. It lists the existing Client Groups.

Use the appropriate buttons for creating, duplicating, editing, renaming or delet-
ing a Client Group. A Client Group is defined by its name and the application 
products that are assigned to it. 

Example of the Catalog Permissions tab with additional options 
for  Client Groups.
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Click the Add button in the Products window to add a product.

A list offers a range of Cumulus products that can be included. The list will also 
offer other products if they are registered and activated with the Cumulus Server.

NOTE: Updating! 
Remember to update the products assigned to Client Groups as well. 

Departments

Optional feature! May not be available with your Cumulus configuration.

IMPORTANT! 
If you have the Department feature activated in addition to your already run-
ning Cumulus system, you must restart the Cumulus Server in order to make 
this feature available to the users.

With Cumulus departments, users and roles may be grouped together, e.g. 
according the organizational structure of a company. Then specific administra-
tors (sub-administrators) may be defined who are in charge of the users/roles of 
a department, or several departments, but can not interfere with users/roles of 
departments they are not in charge of.
Sub-administrators can grant or revoke permissions to the role(s) assigned to the 
department(s) they are in charge of, but only if they have the respective permis-
sions themselves. For example, there might be a role called ”picture editor” with 
the permission of editing metadata and which belongs to the department 
“Research”. The administrator in charge can revoke the editing metadata permis-
sions from the picture editor role only if the administrator role (or any other role 
he or she acts in) itself has the editing metadata permission.
Defining departments does in no way interfere with user permissions and cata-
log access, which is controlled as always by the role(s) assigned to a user, nor 
does it influence the assignment of users to roles or vice versa.
The department feature is available in role-based mode only.
To create departments:

1. Log in to the Server Console as administrator.
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2. In the left pane of the Server Console, click on User Manager, then select 
Actions > Edit Departments. 
A dialog appears allowing to create new departments and to edit or remove 
existing ones.

3. Click Create to add a new department, then enter a name for the new 
department and click OK

You may create as many departments and sub-departments as you need.

4. When you are done, click OK.

Checking the Users Catalog
This utility scans the Users catalog for inconsistencies. It checks whether all cata-
logs, sets and templates that are assigned to users/roles are available. If an item 
is found that is assigned but not available, it is recognized as invalid and you will 
be asked whether the according assignments should be deleted. You can have 
Cumulus do this item for item or just ask you once for all items. Be careful when 
deleting assignments for catalogs: Cumulus considers catalogs as available only 
if they are opened with the Cumulus Server. 
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Copying User Settings
When the Users entry is selected in the User Manager module, the Actions menu 
offers another option: Copy User Settings. This option allows you to copy user 
settings from one user to another. The User Settings for the Cumulus application 
as set in the Preferences window are then copied.

1. In the left panel of the Server Console window, click the entry User Manager 
and reveal its options. Then click on Users.

2. Select Actions > Copy User Settings. A dialog opens to select the user you 
want to serve as template.

3. Enter search criteria to find the desired user by her/his name. (The Cumulus 
built-in authentication will search login name, first, middle and last name.) 

4. Click Find. The found users are listed. (Note that by default the result list can 
include a maximum of 50 entries.) 

5. Select the user you want to use as template and click OK. 
The next step is to collect the users/roles you want to apply the settings to.

6. Click Add User or Add Role to find those you want to inherit the settings.

• Clicking Add User opens a dialog to find and select users. 
Enter search criteria to find the desired user by her/his name. (The Cumulus 
built-in authentication will search login name, first, middle and last name.) 
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Then click Find. The found users are listed. (Note that by default the result 
list can include a maximum of 50 entries.)

• Clicking Add Roles opens a dialog that lists the roles. 
7. Select the users/roles you want to inherit the settings and click OK. They are 

transferred to the list of the Collect Users window.

If a role is listed, the settings will be applied to all users assigned to the role.

8. Click OK to apply the settings to the users addressed in the window.

LDAP Authentication Method
This section describes the way the new LDAP Authenticator plug-in for the 
Cumulus Server version 6.5 or later works. 
If you want to employ LDAP for user authentication with your Cumulus installa-
tion, you need profound LDAP knowledge to configure the set up for the co-
operation between your existing LDAP server configuration and the Cumulus 
user management properly. In order to employ LDAP for user authentication 
with your Cumulus installation, you don’t need to change your existing LDAP 
schema or contents to add information needed for Cumulus.
The Cumulus LDAP Authenticator can be used in the following scenarios:
• The user is already included in the $Users catalog of Cumulus and the pass-

word should be checked using an existing LDAP server configuration. 
• The user is already included in the $Users catalog of Cumulus and the E-Mail 

Address field of her/his properties should be filled using an existing LDAP 
server configuration.

• The user who should work with Cumulus is already included in an existing 
LDAP server configuration and no separate entry (user record in the $Users 
catalog) should be created for the user (with the role-based user manage-
ment only).

The LDAP Authenticator is part of the Cumulus Server installation. It is configured 
through the LDAP.xml file in the conf folder (located in the Cumulus Server 
installation folder). The Server installation provides two example files that are pre-
configured for ActiveDirectory and OpenDirectory LDAP schemes. It is best to 
start making a copy of the example that fits your LDAP installation and rename it 
to LDAP.xml. The provided pre-configured files contain detailed comments on 
the configuration items. If you use any other LDAP scheme than ActiveDirectory 
and OpenDirectory (e.g. eDirectory), you have to adapt the structure to the struc-
ture of your LDAP scheme. 
The LDAP.xml file contains the LDAP host name and also the distinguished 
name (DN) of a user that is allowed to read the necessary LDAP information. The 
file also contains the password of this user in clear text so you should set up file 
permissions so that the LDAP.xml cannot be read by unauthorized users.
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You can also specify whether to use Secure Socket Layer (SSL) communication 
with the LDAP server.

User Password Authentication
The LDAP Authenticator can check the user password for authentication. The 
LDAP Authenticator is used only if the field Authentication Method in a user’s 
properties is set to LDAP. Then LDAP will check the password a user logs in with, 
against a login name that matches the Login Name field of the user’s properties 
stored in the $Users catalog. With the role-based mode of the User Manager, it is 
always used if the user has no record in the $Users catalog.
The LDAP Authentication module uses the simple LDAP authentication method.
To employ the LDAP authentication method for a user’s password you have to 
configure the following items of the LDAP.xml file:

<ns:authenticator> 
<ns:search>

The example LDAP.xml files are syntactically correct for ActiveDirectory and 
OpenDirectory LDAP schemes. However, they contain placeholders. In order to 
make your version of the LDAP.xml work, you have to replace these placeholders 
with real values only. If you use any LDAP scheme other than ActiveDirectory and 
OpenDirectory, you have to adapt the structure to the structure of your LDAP 
scheme also.

User Fields 

Optional feature! May not be available with your Cumulus configuration.

The LDAP Authenticator can provide field values for the user record (user prop-
erties) to be used in any client application for customized solutions. In the 
LDAP.xml file you can specify which field corresponds to which LDAP user node 
attribute. The field can be either an existing field from the $Users catalog in 
Cumulus or you can define your own field by specifying a new unique ID for it. 
(To specify a new unique ID, you should use the function provided by your oper-
ating system, e.g. for Linux use the command uuidgen -t or for Mac OS X use the 
command uuidgen.)
In any Cumulus Internet solution, you can display the field value using the stan-
dard <cumulus:fieldValue> JSP tag with the unique ID of the field.
If the user has a record in the $Users catalog of Cumulus, the field values from this 
record have precedence over values from the LDAP Authenticator.
To have LDAP Authenticator providing field values you have to configure the fol-
lowing items of the LDAP.xml file:

<ns:authenticator> 
<ns:search>
<ns:fields>

The example LDAP.xml files provide one by one mappings of LDAP attribute val-
ues to Cumulus field values. The examples include those attributes included in a 
standard ActiveDirectory and OpenDirectory LDAP installation that have corre-
sponding Cumulus fields in the $Users catalog. If you want your mapping to 
include another attribute from a user node, you have to add it as a new field ele-
ment to your LDAP.xml file. If you use any LDAP scheme other than ActiveDirec-
tory and OpenDirectory, you have to adapt the structure to the structure of your 
LDAP scheme and replace the pre-configured field elements by field elements 
fitting your LDAP scheme.
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Cumulus Roles

Optional feature! May not be available with your Cumulus configuration.

If you work with the role-based mode of the User Manager, you can define map-
pings from LDAP groups to Cumulus roles. By using this mapping you no longer 
need an entry for this user in the User Manager (a user record in your $Users cat-
alog). All you need is to define Cumulus roles and assign permission to them. 
Assigning users to these roles is done using the role mapping of the LDAP 
Authenticator. All role assignments done by the LDAP Authenticator module are 
added to the roles already assigned to the user through a record in the $Users 
catalog.
The LDAP Authenticator supports different kinds of role mappings:
• Automatic mapping of all LDAP groups to Cumulus roles by matching one of 

the group's attributes (e.g. the group's name)
This is the easiest way of mapping LDAP groups to Cumulus roles. All you 
need to do is give your Cumulus roles names that correspond to an attribute 
of an LDAP group. For example you can name your Cumulus roles so that 
they match the "cn" attribute of your LDAP groups.

• Manual mapping of groups to a Cumulus role
You can define additional mappings of specific LDAP groups to a specific 
Cumulus role so that a user is assigned that role if he or she is a member of 
any or each of the given LDAP groups. For example you can define a map-
ping to assign all users to the "CumulusAdmin" role if they are members of 
both the "Administrators"  and the "Backup Operators" group.

To have LDAP Authenticator supporting role mapping you have to configure the 
following items of the LDAP.xml file:

<ns:authenticator> 
<ns:search>
<ns:roles>

<ns:role-mapping>
The example LDAP.xml files are syntactically correct for ActiveDirectory and 
OpenDirectory LDAP schemes. However, they contain placeholders for the 
names of Cumulus roles and LDAP groups. In order to make your version of the 
LDAP.xml work, you have to replace these placeholders with real values only. If 
you use any LDAP scheme other than ActiveDirectory and OpenDirectory, you 
also have to adapt the structure to the structure of your LDAP scheme.
Automatic mapping can be used if the names of your Cumulus roles correspond 
to attribute values of your LDAP groups. The easiest way is to use the cn attribute 
of the LDAP group node to match the Cumulus role name. 

Manual role mapping is based on rules that define which LDAP group member-
ships are mapped to a Cumulus role membership. These rules are defined using 
<ns:role-mapping> elements. 
The membership conditions inside a <ns:role-mapping> element are combined 
by “and”. A user will be assigned to a role only if the user fulfils all conditions. See 
also the following example:

Example for automatic role mapping using the cn attribute 
to match the Cumulus role name.
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If you want to use “or” combinations, you simply add new <ns:role-mapping> 
elements for the same Cumulus role name. All role mapping elements are com-
bined using “or”. A user will be assigned to a role if the user fulfils the conditions 
of at least one <ns:role-mapping> element. See also the following example:

Security Aspects
The LDAP.xml configuration file needs to specify a user that is able to read the 
LDAP server's information. This user only needs read access to the LDAP parts 
you specify in your LDAP.xml file (typically the users node and possibly the 
groups node). As you also need to specify this user's password in the LDAP.xml 
file, you need to make sure the file cannot be read by any unauthorized user.
The LDAP Authenticator module does not make any changes to the LDAP server. 
It only reads information from it.

Example for the “and“ combination: a user will be a member of the Cumulus role “Admins” only if the 
user fulfils all conditions – being a member of both of the LDAP groups “Administrators” and “Backup 
Operators” .

Example for the “or“ combination: all members of the LDAP group “Administrators” as well as
all members of LDAP group “Backup Operators” will be members of the Cumulus role “Admins”.



Configuring Vault
Cumulus® Vault is a revision control system that gives your workgroup

added data security and up-to-the-minute information on the status

of each asset. As its name suggests, Vault enhances the security of your

team’s assets – controlling who accesses them, how and when (via

check in and check out). It also gives you more ways of working with

your assets in Cumulus, providing version retention and tracking, at-a-

glance version information, and integration into the existing Cumulus

environment. Additionally, Cumulus Vault enables Client users to

access assets independent of platforms. Another Cumulus Vault fea-

ture enables you to set up Vault exclusive catalogs. All assets added to

such a catalog are handed over to Vault and their asset storage loca-

tion is Vault exclusively. 

This chapter addresses the Administrator. It covers activating and

administering the Vault Server as well as configuring Cumulus cata-

logs to be controlled by Cumulus Vault. Information on using Vault to

check assets in and out as well as on managing asset versions are pro-

vided in the Client User Guide.
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How Cumulus Vault Works
As the Cumulus Vault Administrator, it’s up to you to configure Cumulus Vault to 
meet the needs of your workgroup. But before you jump in, it’s good to get a 
basic idea of how your Cumulus catalogs interact with Vault. And if you don’t 
want to miss out on any of the technical details, you can read “Behind the 
Scenes,” p. 133, to find out what’s going on in the background.
Cumulus Vault can control and monitor access to all assets. Think of it as the 
Cumulus librarian. Users check assets out for editing and check them back in 
again when they’re through. Every time an asset is checked out, Vault automati-
cally gives the user the latest version to ensure that revisions remain up-to-date.
Vault allows only one user at a time to check out an asset, preventing multiple 
edits that can result in conflicting – and confusing – versions. If another user 
attempts to check the asset out, Vault informs the would-be editor which user 
has the file. When a user checks an asset back in, Vault saves the updated file as 
a new version without overwriting previous versions. It keeps all back revisions, 
making it possible to track changes to an asset during the production cycle – a 
concept referred to as a revision control system. It also provides information on 
all versions: Who made the changes? When? With Vault, these questions are easy 
to answer, making last week’s edits just as accessible as today’s.
Cumulus Vault consists of the Vault Server and Vault Client software.

Vault Server
Cumulus Vault is a revision control system that controls and tracks the access to 
your team’s assets. Vault also provides a place to store your team’s assets, in all of 
their versions.
As Vault Administrator, you define where Vault keeps your workgroup’s assets by 
configuring the Vault Server. This location can be wherever you want it to be, 
with one restriction: the physical location must be a local disk on the computer 
running the Vault Server. It’s up to you to create the folder that will actually house 
the assets. You then tell the Vault Server to store the assets in this Vault Server 
Storage location. You may even tell the Vault Server to store the assets in auto-
matically created subfolders. And when setting up catalogs to work with Vault, 
you can create special folders inside the Vault Server Storage folder, so called 
Vault Folders. 
For information on setting up the Vault Server, see “Configuring the Vault Server,” 
p. 135.

Vault and Catalogs
Every Cumulus catalog can work with Cumulus Vault. For those that do, either all 
of its assets are stored in Vault – and are subject to its control – or only selected 
ones. Cumulus Vault enhances the possibilities of using a central location for a 
catalog. As the Cumulus Vault Administrator, you define for each catalog 
whether and how it is going to interact with Vault.
The first step is to prepare a catalog to work with Vault, which is done by adding 
special version control fields to the catalog. The fields that belong to Cumulus 
Vault are Check out Location, Check out Date, Check out User and Version His-
tory. They enable Clients to check an asset out to a particular location and pro-
vide information describing who checked out which version when. For 
information on adding these version control fields to catalogs, see “Preparing 
Catalogs for Vault,” p. 138.
The next step is to set up the catalog to hand over its assets to Vault whenever 
they are cataloged. You can either tell the catalog to hand over all assets, or let 
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each user decide whether the assets they’re cataloging should be placed under 
Vault’s control. You then specify Vault as the central location for the catalog. 
(Central Location is Cumulus-speak for a location to which Cumulus copies 
assets during the cataloging process; e.g. a folder on your file server or an FTP 
server.) For information on specifying Vault as Central Asset Location for a cata-
log, see “Linking Catalogs to Vault,” p. 140.
A further consideration is whether users have the permissions required to check 
assets out of and into Vault. For information on these permissions, see “User 
Access to Vault,” p. 143.
Once assets are stored in Vault, users can retrieve them by checking them out, a 
procedure that locks the associated record in the catalog for other users. When 
an asset is checked back in, Cumulus moves it as a new version to Vault, and 
unlocks and updates the associated record in the catalog. Previous versions of 
the asset are retained in Vault so that users can view their histories or access 
them, if they become useful again.

Vault and Asset Handling Sets 
Once you decide to employ Cumulus Vault, you should adjust the Asset Han-
dling Sets that your workgroup uses. At least the Asset Handling Sets must have 
the Asset Storage module Cumulus Vault activated. And if you have set a catalog 
to let each user decide whether cataloged assets should be placed under Vault’s 
control or not, the Copy to Central Asset Location option must be activated also. 
In addition, Asset Handling Sets include the Vault settings for version handling. 
For more information setting up Asset Handling Sets for Vault, see “Configuring 
Asset Handling Sets for Vault,” p. 142.

Behind the Scenes
From a technical perspective, Cumulus Vault is an Asset Storage module that 
interacts with the Cumulus application. Asset Storage modules manage the 
access to an asset’s location (where it’s stored on a file system) and provide 
Cumulus with information on the asset. In the case of Vault, this information is 
provided in the form of the version control fields (Check out Location, Check out 
Date, Check out User and Version History).

When you specify Vault as a Central Location, Cumulus works with the assets 
placed there only via the Vault Asset Storage module. This module enables check 
out, check in and version tracking by means of the special version control fields 
mentioned above.

Cumulus Vault is one of the Asset Storage modules that interact 
with the Cumulus application. It controls and monitors access to 
assets. With Cumulus Vault the access to the assets is managed by 
TCP/IP. This provides another advantage of Cumulus Vault: Client 
users can access the original assets independent of platforms. 

File System Module

… Module

Vault Module

Cumulus

TCP/ IP

AssetsAssets

Vault Server
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When an asset is cataloged to Vault, an entire folder for the asset is created in the 
folder you specified as the Central Location for the catalog. This folder has the 
same name as the asset itself and contains two files for each asset version: one is 
the asset itself ( with the extension .data) and the other is an information file 
( with the extension .info) containing the contents of the version control fields 
described above. Except for the file extension, each of these files has the same 
name: a serial number starting at one for the first cataloged version. Note that 
when assets are cataloged to Vault, no corresponding folder category will be 
automatically created under the Sources tab (and $Sources).
Every time a user checks an asset out of Vault, Cumulus copies the latest version 
– based on its serial number – to the location the user specifies. It then locks the 
associated record in the catalog so that no other users may check the asset out.
When the asset is checked back in, Cumulus moves the updated version back to 
that asset’s folder in Vault. It renames the latest version, raising the previous serial 
number by one. It then re-catalogs that version to update the associated record 
in the catalog. Finally, Cumulus unlocks the record so that other users may access 
the asset.
Cumulus Vault Servers fully support the storing and versioning of resource forks, 
file types and file creators.

Installation
The Vault Client software is included in the Cumulus Client software. The Vault 
Server software is included in the Cumulus Server software. 

Vault Server on Another Computer
The Vault Server does not have to be on the same computer running the Cumu-
lus Server. You can decide to have the Vault Server running on ar computer other 
than the Cumulus Server. The computer you select for the Vault Server will not 
only manage Client access to Vault but also physically store all versions of all 
assets controlled by Vault, so it should have enough storage space available. You 
can also have the Vault Server running on a different computer, and it will still 
communicate seamlessly with your Cumulus Server. 
If you decide to have the Vault Server running on a computer other than the 
Cumulus Server, you have to install the Cumulus Server software on that com-
puter. 
When selecting the computer for the Vault Server, keep in mind that not only will 
it store all assets – and all versions – under Vault’s control, but also that every Cli-
ent will need continuous TCP/IP access to it for checking these assets in and out.
Whichever route you choose, this documentation refers to the installation as a 
Vault Server. 
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How to Make Vault Work
In order to make Vault work with your Cumulus configuration, you have to per-
form the following tasks:
• Specify the Cumulus Vault Administrator. You use the User Manager module 

of the Server Console for this. 
• Activate Vault and configure the Vault Server meeting your requirements. 

You use the Vault module of the Server Console for this.
• Set up your Cumulus catalogs to work with Vault. Using the Catalog Settings 

of the Preferences window, you prepare the catalog by adding special ver-
sion control record fields and linking the catalog to Vault. 

• Last but not least configure the Asset Handling Sets used by your workgroup. 

Configuring the Vault Server
You configure the Vault Server by telling it where to store the assets that are to 
be controlled by Cumulus Vault. Only the Cumulus Vault Administrator can con-
figure the Vault Server, meaning that there has to be a user account that func-
tions as the Vault Administrator.

Specifying the Cumulus Vault Administrator
To configure the Vault Server, there has to be a user account which functions as 
the Cumulus Vault Administrator. 
If the Vault Server is running on the same computer as the Cumulus Server, you 
can give any existing user the Vault Administrator permission. 
However, if the Vault Server is not on the same computer as the Cumulus Server, 
you need to specify the Vault Administrator on this computer. You may even 
have to set up a user who is given the Vault Administrator permission. 
In both cases use the User Manager module of the Server Console to do so:

1. From within the Cumulus Client, select File > Administration > Server Con-
sole, or connect to the Web Server Console via a Web browser

2. Log on to the computer running the Vault Server you want to administrate 
as Cumulus Administrator or the user who has the permission: User Adminis-
trator.

3. Select User Manager.

4. Edit the user’s description who is supposed to be the Vault Administrator 
and under Server Permissions, select the Administrator Permissions to 
assign the Vault Administrator permission.

5. Click OK to save the defined properties.

In order to make it easy for the Vault Administrator user to perform all adminis-
trative tasks, this user should also have the following permissions for the catalogs 
that use Vault: 
• Application Permissions

Open Catalog, Create Record, Delete Asset
• Administrator Permissions

View Catalog Settings, Modify Catalog Settings, Modify Central Asset Loca-
tion
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Activating Vault and Specifying the Vault Storage Location
As the Vault Administrator, it’s up to you to create and specify the location of the 
main Vault folder where Vault will store the assets it controls. Where this location 
actually exists is up to you, with one restriction: it must physically be on a local 
disk of the computer running the Vault Server.
There are a couple of things to keep in mind when creating the folder to house 
your team’s assets:
• All versions of your Vault-controlled assets from all catalogs will be housed 

there, so sufficient storage space should be available.
• You can specify a new location for the main Vault folder at any time (end of 

project, month, year, etc.), but once you do your workgroup will not be able 
to use Cumulus Vault to access the assets stored in the previous location 
unless you have made use of a special utility that updates the asset refer-
ences to the new location .

First, create this main Vault Storage folder on the computer running the Vault 
Server, and then configure the Vault Server application by telling it where this 
folder is. You can structure this main Vault Storage folder when setting up cata-
logs for Vault. Use this way to create any subfolders in the main Vault folder, only. 
When you create new folders inside the main Vault Storage folder when setting 
up catalogs. These folders are created as special folders for Vault and called Vault 
Folders. Such a special Vault Folder contains an XML file that describes it and that 
is necessary for certain functions, e.g. the exclusive assignment of a catalog to 
Vault as its central asset location.
When configuring the Vault Server you are offered to have Vault Folders auto-
matically structured when a certain number of days or assets is reached. For bet-
ter performance we strongly recommend you to make use of the functions that 
automatically create subfolders.
To configure the Vault Server:

1. From within a Cumulus Client, select File > Administration > Server Con-
sole, or connect to the Web Server Console via a Web browser.

2. Log on to the Cumulus Server you want to administrate as Cumulus Admin-
istrator or the user who has the permission: Vault Administrator.

The modules of the Server Console application are loaded.

3. The Server Console application is started. Log on to the computer running 
the Vault Server as a user who has Vault Administrator permission.

4. Select Vault Server.

The Cumulus Vault Server Setup window is displayed. 

5. Under General, enable Activate Vault Server.
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6. In the Vault Storage Folder field, enter the path to the folder on the Vault 
Server computer into which the assets shall be placed when cataloged.

The path you enter here refers to a location on the computer running the 
Vault Server. Make sure to observe the conventions for describing paths of 
the operating system where the Vault Server is installed, regardless of 
whether you are connecting from a Windows or Mac OS Client.

NOTE: Vault Server for Mac OS X
As the Vault Server for Mac OS X is based on UNIX technology you have to 
use UNIX path and file naming conventions for administration. 

7. Under Automatically Created Subfolders, decide on the handling of subfold-
ers by selecting the desired option:

• Do Not Use Automatically Created Subfolders
All assets will be stored directly in the Vault folders. 
This option is only available while none of the the subfolder options is acti-
vated. Once the automatic creation of subfolders is activated, there is no 
point of return. 
NOTE: If you decide on this option and later decide on using subdirec-
tories, all assets stored directly in Vault folders will be moved to a special 
subdirectory called Default. This will also happen to assets stored in 
Vault with former versions of Cumulus Vault when you decide to use 
subdirectories with the current Cumulus Vault version. 

• Use 
Enter the complete path of an existing subfolder or a folder to be created 
within the Vault Storage Folder (using the path naming conventions of the 
operating system where your Vault Server is installed). 
Remember, that for better performance we strongly recommend you to 
activate this option.
NOTE: If you don’t enter a name and leave the default unchanged, new 
cataloged assets are stored in the same Default folder as the assets that 
were automatically moved there after the use of automatically created 
subfolders was activated. 

• Create a New Folder After ... Days
Enter the number of days (1 to 10,000) after which a new subfolder will be 
created to house the assets to be cataloged hereafter. This number is the 
minimum number of days before a new subfolder will be automatically 
created. 

• Create a New Folder Upon Reaching ... Assets
Enter the maximum number of assets (1 to 10,000) a subfolder may contain 
before a new subfolder will be created to house the assets to be cataloged 
hereafter. (Due to Cumulus TAG files or other metadata files, the actual 
number might differ.)
NOTE: These automatically created subfolders are named after their 
creation date and time (YYYY-MM-DD_hh-mm-ss). 

8. Under Version Limitations, decide on the handling of versions. You can 
either keep all versions or limit the versions of an asset kept in Vault. If you 
activate the option Only Keep, enter the number of latest versions you want 
to be kept in Vault. If you also want the oldest version to be kept, enable the 
option Additionally Keep Oldest Version. 

9. Click Save Changes.

Once you have configured the Vault Server you should go on and set up your 
Cumulus catalogs to work with Vault.
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Implementing Cumulus Vault
You implement Cumulus Vault by setting up your Cumulus catalogs to work with 
Vault. There are two things that you need to do with a catalog to subject its assets 
to Vault’s control:
• Prepare the catalog by adding the special version control record fields to all 

records of the catalog. (See “Preparing Catalogs for Vault,” p. 138.)
• Link the catalog to Vault by having its assets placed there whenever they are 

cataloged. You can either store all of a catalog’s assets in Vault, or let the users 
decide which assets are to be stored there. (See “Linking Catalogs to Vault,” 
p. 140.)

Another consideration is user access to the assets controlled by Vault. You need 
to make sure that the desired users can work with these assets. To find out how, 
see “User Access to Vault,” p. 143.
If a catalog is configured to work with Vault, you also have the option of handing 
over already cataloged assets to Vault. For more information, see “Adding 
Already Cataloged Assets to Vault,” p. 144.
Configuring catalogs to work with Vault is similar to configuring catalogs in gen-
eral. You first log on as Cumulus Administrator to the Cumulus Server, then open 
the desired catalog and specify its properties.

Opening a Workgroup Catalog
The following is a brief review of opening a catalog:

1. From any Cumulus Client, select File > Connect to Server.

The Connect to Server dialog opens. 

2. Type the name of the user who has the appropriate permissions for the cat-
alogs to be set up for Vault in the Name field and the corresponding pass-
word in the Password field. 

3. Click OK. The Catalog Access window opens.

4. In the Catalog Access window, select the catalog(s) you would like to open 
and click Open.

Once the catalog is open, you are ready to add the record fields required to work 
with Cumulus Vault.

Preparing Catalogs for Vault
To make a catalog work with Vault, you have to add the version control record 
fields to the catalog. These fields are:
• Check out Location – Contains encoded information on where the asset has 

been checked out to, i.e., the location to which it has been saved on the user’s 
file system. You must add this field for Vault to be able to copy and track 
assets.

• Check out Date – Contains information on the date and time the asset was 
checked out.

• Check out User – Contains information on who checked the asset out.
• Version History – Contains information on each version of an asset, i.e., when 

it was checked out and in as well as by whom. This field is a text field and can 
be edited by the user (if allowed).
NOTE: Check out Duration
If the Check out Date field is also contained in the catalog, the Version 
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History field contains information on the check out duration at the end 
of each entry. This information is only available via this field. If this infor-
mation is deleted from this field it cannot be reconstructed. 

NOTE: Reconstructing Data
If the content of the Version History field was completely deleted, the 
field is treated as containing no value and will be filled with the informa-
tion stored on the server upon the next checking or record update. 

The fields Check out Date and Check out User also enable catalog users to view 
whether or not an asset is currently checked out and, if so, by whom. But to view 
the contents of these fields, they have to be added to the Record View Sets. (For 
information on adding fields to a view, see the Client User Guide.)
To add version control fields to your catalog:

1. Make sure the collection window containing the catalog is the active win-
dow in Cumulus.

2. Select Cumulus / Edit >  Preferences. 

3. Click Catalog Settings.

The Catalog Settings window is displayed. If the active collection window 
contains more than one catalog, select the catalog you want to edit under 
Catalogs.

4. Click Record Fields. This displays a list of the current record fields included in 
the catalog.

5. Click the Add Field button. This opens the dialog Add Field. 

6. Click the Modules tab.

7. Select Cumulus Application.

8. Select the field(s) you want to add. Version control fields are: Check out 
Location, Check out Date, Check out User, Version History

TIP: Under Modules, you can use also use the Catalog Template Fields for 
Asset Version Control for adding the fields.<<<

9. Click OK. This brings you back to the fields list to which the fields have been 
added.

10. Click Apply to save your changes.

The catalog can now work with Vault, but there are no assets in Vault for it to 
work with. The next step is to have Cumulus place assets under Vault’s control 
whenever they are cataloged.
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Linking Catalogs to Vault
When a catalog is linked to Cumulus Vault, assets can be handed over to Vault 
when they are cataloged by any user. As the Cumulus Administrator, you link a 
catalog to Vault by telling Cumulus essentially two things.
First, you have to configure Cumulus to be able to add assets to Vault when they 
are cataloged. You do this by specifying Cumulus Vault as a central location for 
the catalog. You even have a couple of options for specifying when assets should 
be handed over to Vault:
• Always – All assets added to the catalog are handed over to Vault. Should be 

considered the default setting, because it ensures that all of the catalog’s 
assets are subject to Vault’s access and revision control.

• As Set in Asset Handling Set (i.e., at the users’ discretion) – You let each user 
specify (with the Asset Handling Set they employ) whether or not to catalog 
assets to Vault. Useful if only certain types of assets – as your workgroup 
defines them – need to be subject to access and version control. 

• Always and Exclusive – All assets added to the catalog are handed over to 
Vault and their asset storage location is Vault exclusively. A catalog that is set 
to this option will have a forced 1-to-1 relation with its Vault Folder: every 
record in the catalog represents an asset stored in the corresponding Vault 
Folder and each asset in this Vault Folder is represented by a record in this 
catalog. This is the guiding principle for all functions performed. For example 
this means that assets managed by this catalog cannot be moved and that 
deleting the records representing them will always delete the assets as well. 
A catalog that is set to this option is called a Vault exclusive catalog.
NOTE: After the Always and Exclusive option has been activated for a 
catalog, all assets already contained in the catalog will be copied to the 
corresponding Vault Folder and their records will be updated to reflect the 
new asset storage location. 

Second, you have to tell Cumulus where to store the assets to be controlled by 
Vault, in effect tell Cumulus which computer in your network is running the Vault 
Server. You specify this computer by its network name or TCP/IP address. At this 
point, you don’t need to specify the actual folder on the Vault Server computer, 
since you already specified it when you configured the Vault Server.
To link a catalog to Vault:

1. Make sure the collection window containing the catalog is the active win-
dow in Cumulus.

2. Select Cumulus / Edit >  Preferences. 

3. Click Catalog Settings.

The Catalog Settings window is displayed. If the active collection window 
contains more than one catalog, select the catalog you want to edit under 
Catalogs.

4. Click General.

5. Under Copy Assets to Central Location, enable Use Central Asset Location.

6. Choose where to store the copies and which Asset Storage module you 
want to use.
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The Choose an Asset Storage Module dialog opens.

7. Select Cumulus Vault and click OK.

The Select Remote Module dialog opens.

8. Select the computer running the Vault Server from the Computer field. This 
is the computer that contains the folder you specified as the Vault location 
(see “Configuring the Vault Server,” p. 135). You can click the arrow button to 
the right of the field for a list of currently active Vault Servers in your net-
work. 

The Choose Asset Location dialog is opened. You now have to decide 
whether you want the assets to be stored directly in the folder of the Vault 
Server or in a subfolder nested in the Vault Server folder. Such a subfolder is 
called a Vault Folder. 

9. Select the desired option. 

10. If you decided on Use Vault Server Directly, your next step is to click OK.
If you decided on Use Vault Folder, the list for selecting this folder is acti-
vated. Then your next step is to select the Vault Folder you want the asset to 
be stored in and click OK. 
If you want a new Vault Folder to be created for storing the assets of this cat-
alog, click New Folder. A dialog for entering a name for the folder is dis-
played. It contains the name of the catalog as default. 

NOTE: If a catalog is set exclusive for a Vault Folder this folder cannot be 
used as a central asset storage location for any other catalog. If you want 
a catalog to be set exclusive, you have to create a new Vault Folder for it. 

You return to the General section of the Catalog Settings window. The name 
or IP address of the computer running the Vault Server and the name of the 
Vault Folder are displayed.
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11. Select the mode for copying assets to the central asset storage location cho-
sen above:

• Always
• As Set in Asset Handling Set
• Always and Exclusive (available with Vault only)
(For more information on the different modes, see page 140.)

12. Click Apply to save your changes and select the next catalog you want to set 
up for Vault.
OR 
Click OK to save your changes and close the Preferences window.

When users catalog assets to this catalog from now on, the asset can be placed 
or will be placed into the folders inside the Vault Server folder you specified when 
you configured the Vault Server.

Configuring Asset Handling Sets for Vault
The Asset Handling Sets your workgroup users use have to be configured for 
Vault. Asset Handling Sets are important for Vault in the various aspects:
• for cataloging 
• for asset access
• for asset version handling
For cataloging they are important as the user must use Asset Handling Sets with 

the Asset Storage module Cumulus Vault activated for cataloging assets to be 
placed under Vault’s control. And Asset Handling Sets are very important for cat-
aloging if you have set a catalog to let each user decide whether the assets 
they’re cataloging should be placed under Vault’s control or not. The user 
decides this by selecting an Asset Handling Set. If the user employs an Asset Han-
dling Set with the Copy to Central Asset Location option and the Asset Storage 
module Cumulus Vault activated for cataloging, the cataloged assets are placed 
under Vault’s control.
For asset access they are important, as the user must use Asset Handling Sets 
with the Asset Storage module Cumulus Vault activated for accessing assets that 
are stored in Vault. 
For asset version handling they are important, as they include the Vault settings 
for version handling. Since Vault controlled assets may exist in multiple versions, 
you may have to make a choice between the different versions available when 
you preview, mail, and copy assets controlled by Vault. Cumulus makes it easy for 
you to make this choice. It even enables you to pre-set your decision to best suit 

The Cumulus Vault module must be acti-
vated in Asset Handling Sets in order to 
catalog assets to Vault or to access assets 
stored in Vault.
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the way you work. This setup is defined in an Asset Handling Set. By selecting an 
Asset Handling Set, the user decides on the way of asset version handling. 

See the Client User Guide for information on how to set up Asset Handling Sets in 
general. 
With Vault we recommend you to have your Cumulus users using shared Asset 
Handling Sets only. As these Asset Handling Sets can be centrally administered. 
You can also restrict the users’ access to certain Asset Handling Sets only. How-
ever, whichever way you choose, make sure that at least the Asset Handling Sets 
selected in the User Settings of your users have the Cumulus Vault module acti-
vated.
If you ever decide that you want to change the Vault Server for this catalog, you 
can return to the Catalog Settings and click Browse to specify a new computer. 
However, then you have to redirect the assets. Cumulus provides a special utility 
for redirecting Vault assets. For information on this utility, see “Redirecting Asset 
References,” p. 149.

User Access to Vault
Users’ access to assets controlled by Vault is catalog-specific, since they access 
these assets via Cumulus catalogs.
You have to assign those users who are to work with Vault the corresponding 
permissions. You assign individual user permissions with the User Manager mod-
ule of the Server Console.
If you want users to be able to check assets out, check them back in, undo a 
check out and move assets out of Vault, they have to be assigned the permis-
sions:
• Open Catalog
• Create Records, Modify Records
• Check Out/In, Transfer Asset 
If you also want users to be able to delete records, you have to assign them the 
Delete Record permission.
If you also want users to be able to delete assets – and individual asset versions 
– from Vault, you have to assign them the Delete Record permission and the 
Delete Asset permission. 
In Vault exclusive catalogs you can only delete a record along with its asset only. 
If you want users to be able to delete records from such catalogs you have to 
assign them the Delete Record permission and the Delete Asset permission. 
For a detailed description of user permissions, see “Catalog Permissions,” p. 108.

Cumulus Vault Setup for version handling in Asset Handlings Sets
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NOTE: Permissions on Records from a Vault Exclusive Catalog!
If a user has a catalog housing records that derive from a Vault exclusive cat-
alog (Central Asset Location set to Always and Exclusive) the user’s permis-
sions on these records are the user’s permissions given for the catalog the 
records derive from. For example: Even if a user has all permissions for catalog 
A her/his permissions for records that derive from catalog B (which is a Vault 
exclusive catalog) are the user’s permission for catalog B. 

Adding Already Cataloged Assets to Vault
Linking a catalog to Vault means that assets cataloged to it in the future can be 
handed over to Vault. But what about the assets your workgroup has already cat-
aloged? They too can be placed under Vault’s control, as many of them as you 
want at a time.

NOTE:
In order to be able to add already cataloged assets to Vault, the Client you’re 
connecting from must have access to the assets themselves – wherever they 
may be stored in the network. 

To add already cataloged assets to Vault’s control:

1. Open the catalog whose assets you would like to add to Vault (see “Opening 
a Workgroup Catalog,” p. 138). 

2. Select the record(s) representing the asset(s) you would like to hand over to 
Vault.

3. Select Asset >  Move To.

The Select Asset Storage Module dialog opens.

4. Select Cumulus Vault and click OK.

The Select Remote Module dialog opens.

5. In the Computer field, select the computer running the Vault Server and 
click OK. 

Cumulus moves the selected assets to Vault, where they are now subject to 
access and version control.

Now that you’ve got Cumulus Vault running just the way you want it, you can let 
the Clients start working with it—and let Vault take care of the rest. If you are also 
going to be working with the assets controlled by Vault, you can find all you need 
to know about how in the Client User Guide.
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Administration Utilities
Cumulus provides several utilities for special Vault administration tasks. The utili-
ties can either be started via the Actions menu (when Vault Server is selected) or 
via buttons in the Vault Server Setup window.

Managing Non-cataloged Assets Stored in Vault
Due to whatever reason, Vault may contain assets which are not cataloged. You 
can search for these and either delete them or add them to a catalog. As you can 
only search catalog for catalog, this function is most helpful when you manage 
all assets stored in Vault via one catalog.
To manage non-cataloged assets stored in Vault:

1. From within a Cumulus Client, select  File > Administration > Server Con-
sole, or connect to the Web Server Console via a Web browser.

2. The Server Console application is started. Log on to the computer running 
the Vault Server as a user who has Vault Administrator permission.

3. Select Vault Server.

The Vault Server Setup window is displayed. 

4. Click the Unreferenced Assets button.

The Choose Server Connection dialog is displayed. 

5. If the catalogs you want to scan are managed by a Cumulus Server running 
on the same computer as the Vault Server you are connected to, then you 
can use the current connection and click Next. 

However, check if you are logged on to the Vault Server as a user who has 
the required permissions for the catalogs to be scanned and has access to 
the Asset Handling Sets needed for cataloging. If not, you should change 
the connection as described below. Required permissions are: Open Catalog, 
Create Record and Delete Asset.
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If the catalogs you want to scan are managed by a Cumulus Server running 
on a different computer as the Vault Server you are connected to, then you 
have to change the connection and connect to this computer.

To change the connection:

• Enable the Use Other Connection option.
• In the Server field, enter the server name or the IP address of the computer 

running the Cumulus Server managing the desired catalogs. 
• Enter the name and the password of a user who has the required permis-

sions for the catalogs you want to scan.
• Click Connect and Next.
The Select a Catalog dialog is displayed. It lists the catalogs that are man-
aged by the Cumulus Server chosen in the previous dialog and which the 
logged on user has access to. 

6. Select the catalog to be scanned and click Next.

The Select a Folder dialog is displayed. It lists the folders inside the Vault 
Storage folder. 

7. Select the folder to be matched with the catalog chosen in the previous dia-
log. The selected folder(s) will be scanned as well as its/their automatically 
created subfolders.

NOTE: If you don’t select a folder, the level of the Vault Storage folder will 
be scanned – including all automatically created subfolders but not the 
Vault Folders. 

8. Click Next to start the process. 

A list shows those assets that are stored in the selected folder but not con-
tained in the selected catalog.
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If the list is empty, no unreferenced assets were found. Then you can either 
quit the utility by clicking Close or go back to previous steps by clicking Pre-
vious.

9. Select the desired asset(s) and

• if you want to delete the asset(s) (and all its/their versions) from Vault, click 
Mark to Be Deleted.

• if you want to add the asset(s) to the selected catalog, click Mark to Be Cat-
aloged.

• if you don’t want to touch the asset, click Mark to Retain Unchanged.
TIP: You can also click in the Task column to select the task to be performed 
on an asset.

The assets get marked for the task to be performed. 

10. For assets to be cataloged, you should choose an Asset Handling Set for the 
cataloging:

• Select the entry for the asset to be cataloged and click Choose Asset Han-
dling Set. A list shows those Asset Handling Sets that have Cumulus Vault 
activated as Asset Storage module and that are available to the user you 
are logged on with.

• Choose the Asset Handling Set you want to be used for cataloging the 
selected asset.

11. When the tasks for all assets are defined and all Asset Handling Sets are cho-
sen, click Start. The assets are processed as defined. A list informs you on the 
tasks that were performed.

12. Click Close to quit the utility.
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This function was designed for clearing assets which are in Vault but not cata-
loged. However, you may also use this function for cataloging assets in Vault to 
other catalogs.

Update Folder Information
Folders set up as central asset location for catalogs are called Vault Folders. Vault 
Folders are located in the folder chosen as Vault Storage Folder. Each asset that 
is copied to the central asset location is copied to the selected Vault Folder. How 
does Cumulus recognize such a Vault Folder? A Vault Folder contains an XML file 
that holds the information Cumulus needs. To see and update this information, 
Cumulus provides a utility. 
To update the information on Vault folders:

1. From within a Cumulus Client, select File > Administration > Server Con-
sole, or connect to the Web Server Console via a Web browser.

2. The Server Console application is started. Log on to the computer running 
the Vault Server as a user who has Vault Administrator permission.

3. Select Vault Server.

The Vault Server Setup window is displayed. 

4. Click the Update Folder Info button.

The Select a Folder dialog is displayed. It lists the Vault folders of the Vault 
Server you are connected to. 

5. Select the Vault Folder on which you want to see information and click Next. 

The information on the the selected Vault Folder is displayed.

• Catalog Name – Name of the catalog
• Catalog Server – IP address of computer running the Cumulus Server 

managing the catalog.
• Exclusive – If the catalog is a Vault exclusive catalog this option shows a 

check mark.
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• Delete Catalog Entry – This option can be activated in order to delete the 
entry for this catalog from the Vault Folder’s information. This is useful for 
catalogs that were deleted and no longer exist.

6. If you want to delete the entry for this catalog, activate the Delete Catalog 
Entry option and click Start.

7. Click Close or Cancel to quit the utility.

Redirecting Asset References
Asset references contain information on the server the assets are stored on; e.g. 
IP address and/or server name. Therefore they have to be updated when the 
server changes. Canto provides utilities to help make the process of updating the 
records easy and trouble-free. 
The utility will scan selected catalogs for records ’pointing’ to the former Vault 
location and then update these records to reflect the new location of the Vault 
assets. Without this utility, the records would still 'point' to the former Vault 
Server. The utility does not overwrite, move or otherwise affect asset files at all.
To update the asset references of assets kept in Vault after the Vault Server has 
changed:

1. From within a Cumulus Client, select File > Administration > Server Con-
sole, or connect to the Web Server Console via a Web browser.

2. The Server Console application is started. Log on to the computer running 
the Vault Server as a user who has Vault Administrator permission.

3. Select Vault Server.

The Vault Server Setup window is displayed. 

4. Click the Redirect Asset References button. 

The Choose Server Connection dialog is displayed. 

5. If the catalogs you want to scan are managed by a Cumulus Server running 
on the same computer as the Vault Server you are connected to, then you 
can use the current connection and click Next. 

However, check if you are logged on to the Vault Server as a user who has 
the required permissions for the catalogs. If not, you should change the con-
nection as described below. Required permission are: Open Catalog, Modify 
Record including Modify Asset Reference.

If the catalogs are managed by a Cumulus Server running on a different 
computer than the Vault Server you are connected to, then you have to 
change the connection and connect to this computer.

To change the connection:

• Enable the Use Other Connection option.
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• In the Server field, enter the server name or the IP address of the computer 
running the Cumulus Server managing the desired catalogs. 

• Enter the name and the password of a user who has the required permis-
sions for the catalogs you want to scan.

• Click Connect and Next.
The Select a Catalog dialog is displayed. It lists the catalogs that are man-
aged by the Cumulus Server chosen in the previous dialog and which the 
logged on user has access to. 

6. Select the catalog(s) managing the Vault assets and click Next.

The Specify Vault Server Names dialog is displayed. 

7. In the Old Server Name to Replace field, enter the DNS name or IP address 
of the computer where your former Vault Server was installed. As default, 
Cumulus prompts the name of the first Vault Server computer which it finds 
in the selected catalog’s records.

8. In the New Server Name to Write field, enter the DNS name or IP address of 
the computer where your current Vault Server is installed.

9. In the New Alternate Server Name to Write field, you can optionally enter 
the alternate information on the computer where your current Vault Server 
is installed – the information you did not enter in the New Server Name to 
Write field above (DNS name or IP address).

10. If you want to have the complete information that is stored in the record 
field Asset References updated, activate the Automatically Update Asset 
Reference option.

11. Click Start. The utility will search the selected catalog(s) for records that 
’point’ to the former Vault location. Then it will check whether the corre-
sponding assets exist in the new Vault location and finally will update the 
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assets’ references. A list informs you which assets’ references were redi-
rected. 

NOTE: If you cancel the function, it will be stopped but the updates of the 
already processed records are kept. 

12. Click Close to quit the utility.
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Troubleshooting
This chapter offers troubleshooting information to help you quickly

solve common problems. Topics covered in this chapter include fac-

tors that influence program performance, common problems and

their solutions, and the importance of documenting problems before

calling for assistance.
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Factors Influencing Performance
Numerous factors can affect software program performance. The following lists 
common factors to consider if Cumulus seems to be having performance prob-
lems.

Server Speed and Available Memory
The processor speed and memory of the server hosting Cumulus dramatically 
affects overall program performance. For more information, see “Cumulus Server 
System Requirements” in the Installation Guide.

Use of a Non-Dedicated Server 
Ideally, having a dedicated Cumulus Server ensures the highest possible pro-
gram performance. If you are experiencing performance problems and are run-
ning Cumulus concurrently with other programs, evaluate the number of 
applications that are running simultaneously. Test and see if performance 
improves as the number of programs running concurrently decreases.

Storage Media Type 
The type of media on which you store your catalogs dramatically affects the 
speed at which Cumulus catalogs, displays and locates media file information. 
For the fastest performance possible, store catalogs on your server instead of off-
line on removable media (e.g., CD-ROM or SyQuest, Zip, Jaz, and MO cartridges).

Number of Records 
The sheer number of assets Cumulus manages at once directly affects cataloging 
performance, but not record search and retrieval time. Unlike other media man-
agement programs, Cumulus indexes nearly every word entered into a record by 
default. When you catalog new assets, the program rebuilds the index as each 
asset is cataloged. Thanks to this design, Cumulus can search and retrieve 
records instantly regardless of the catalog size. However, after a certain point, cat-
aloging performance may degrade.

Hard Disk Fragmentation
Check your system’s hard disk for fragmentation. For more information on hard 
disk fragmentation and defragmentation, see the documentation that came 
with your system.



TROUBLESHOOTING –  COMMON PROBLEMS AND SOLUTIONS 155
Common Problems and Solutions
This section contains frequently asked questions and their possible solutions. 

Slow Catalog Performance
When I work with a catalog from a Client, most of the functions I use take much lon-
ger than expected. Why?
The problem may lie in the connection between the Clients and the computer 
running the Cumulus Server. Communication between Server and Clients is han-
dled via TCP/IP. If the Server computer is a Domain Name Server (DNS) that is nor-
mally difficult to reach from other computers, then Cumulus functions executed 
across this connection will also take longer to run.

Maximum Catalog Size 
What is the largest number of records that a Cumulus catalog can hold?
Cumulus Workgroup is limited to a catalog file size of 4 GB. Cumulus Enterprise 
is limited to a catalog file size of 1 TB. The number of records this permits 
depends upon:
• the thumbnail quality/size settings
• the amount of text in each record (e.g., in the Notes field)
For example, catalogs containing incredibly long notes as well as large and high 
quality thumbnails might reach the 4 GB maximum file size at 100,000 records. In 
contrast, catalogs with records that contain shorter notes and small thumbnails 
might not reach the 4 GB maximum file size until 400,000 records.
For information on selecting thumbnail size for new catalogs, see “Catalog Set-
tings,” p. 28. For information on changing thumbnail size for existing records, see 
the Client User Guide.

Changing Thumbnail Appearance 
Can I change a thumbnails appearance?
The actual size (in pixels) of a thumbnail is controlled by the Asset Handling Set 
used for cataloging. You can, however, change a thumbnail’s appearance within 
the Record pane by selecting three different options (small, medium, large) 
found in the View menu or the toolbar. You can define the size for these three 
options in the User Settings. For more information, see the Client User Guide.

Exporting Catalog Information
How do I export catalog information to another program?
Cumulus supports the ability to export record and category information to a tab-
delimited text file, which can then be imported into other catalogs or applica-
tions. For more information on exporting and importing, see the Client User 
Guide.

Dealing with Unexpected Categories
I was dragging and dropping records between two catalogs and some new catego-
ries appeared in the Category pane. What happened?
Every Cumulus catalog can have a different category structure that contains dif-
ferent categories. When you drag or import a record to another catalog, it may 
be assigned to categories that don’t exist in the destination catalog. If that is the 
case, Cumulus automatically creates the missing categories in the destination 
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catalog.
To avoid this situation, export the categories from one catalog and import the 
into the other catalog before importing records. For more information on export-
ing and importing, see the Client User Guide.

Working with DCS Separation Files 
How do I work with DCS separation files in Cumulus?
DCS 1.0 files consist of five different files: the master file and the four color sepa-
ration files for Cyan, Magenta, Yellow, and Black. When cataloging DCS files make 
sure you use an Asset Handling Set that has DCS File Support activated. Then 
Cumulus catalogs only the master file to avoid creating five records for a single 
image. 

Cataloging OPI System Files
I use Cumulus to catalog the low-resolution files from my OPI system, place them in 
layout applications, and then print them. Will they be substituted with high-resolu-
tion files as expected during printing?
Cumulus is fully compatible with many OPI systems and can form the backbone 
of a successful automation system in any environment. Make sure you use Asset 
Handling Sets for cataloging and accessing that have OPI System Support acti-
vated.

Accessing Support Information Online 
If you have a problem not covered in this chapter, be sure to review the FAQ sec-
tion and the Canto's User 2 User Support Forums on the Canto Website for addi-
tional troubleshooting information (www.canto.com).

Special Problems and Solutions
This section deals with special configuration problems and their solutions. 

Different Port Numbers
I installed Cumulus but the Cumulus default port numbers are already used. What do 
I have to do?
You have to install and start the Cumulus Server and the Remote Admin utility 
manually with commands found in the Cumulus Server installation folder and 
then change the port number(s). 
First install the Cumulus Server and the Remote Admin utility:
– Windows: start install-admin.bat and install-cumulus.bat
– Mac OS X/UNIX: start install-admin.sh and install-cumulus.sh
In case the port number 8954 is already used, change the port number for 
Remote Admin by replacing the number in the RemoteAdminPortNumber 
entry in the server.xml file (found in the conf folder inside the Cumulus Server 
installation folder).
Then start the Remote Admin utility 
– Windows: start the Service or use start-admin.bat
– Mac OS X/UNIX: start-admin.sh
In case the port number 9287 is already used, open the Remote Admin window 
with your Web browser (http://[ServerID]:PortNumber/login.html). Click on 
Change Properties and change the port number for the Cumulus Server by 
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replacing the number in the TCP/IP Port Number field. Then click Submit. 
Finally start the Cumulus Server
– Windows: start the Service or use start-cumulus.bat
– Mac OS X/UNIX: start-cumulus.sh
If you use another port number for the Cumulus Server you have to inform all 
Cumulus Clients to use the changed port number in the Connect To Server dia-
log (e.g. 123.123.123.123:9288 or ServerName:9288). 
If you employ Cumulus Options as Cumulus Sites or Vault, and if they are installed 
on a machine other than the Cumulus Server, you must set up the port number 
used by Cumulus Sites and the Vault Server accordingly. 

Damaged Field Index
Error message: “The catalog is damaged but you can continue working with it. In any 
case, ask your Cumulus Administrator to check the Cumulus Server system log for 
details. ” What must the Cumulus Administrator do?
This error message indicates an indexing error. The Cumulus Server's system log 
will contain an entry like
Index damaged: Catalog "My Catalog", Field "My Field", Sort Index, 
File "C:\Cumulus\Core\CuDBEngine\src\BTree.cpp" (1234)"
The Cumulus Administrator should then 
• open the Catalog Settings for the indicated catalog (e.g. "My Catalog" )

( Cumulus / Edit >  Preferences >  Catalog Settings),
• open the Properties of the indicated field (e.g. “My Field”),
• deactivate the indicated indexing (Sort Index = Index for Sorting/Searching; 

Contain Index = Index for Contain-Searching, Word Index = Index for Word-
Searching) for the field and apply the change, 

• activate the indexing again and apply this change.

Documenting Problems
When Cumulus behaves in an unexpected way or does not work properly, please 
review your situation and repeat the steps that led to the problem. Try to repro-
duce the error, paying special attention to the actions you took before it 
occurred. If there are many steps, write them down so you can tell us exactly 
what you did.
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Appendix
This appendix provides information on parameters for Cumulus Asset-

Processors when used with one of the Cumulus Internet solutions,

additional EJaPs or applications based on the Cumulus Java Classes

and information on the Sample EJaPs folder included with any

Cumulus Client installation. 
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AssetProcessor Parameters
The Cumulus AssetProcessors can be used with additional EJaPs or applications 
based on the Cumulus Java Classes. 
For example: if you want to employ the Pixel Image Converter, you have to 
choose "Pixel Image Converter" as the converter module. Then you set the 
parameter. The following sections list the possible parameters for the different 
Cumulus AssetProcessors. 
For descriptions on how to configure the different Cumulus AssetProcessors for 
the Cumulus application see the Client User Guide.

Pixel Image Converter
• JPEGQuality=<value> 

(possible values as integer: 1-10)
• Format=<value> 

(possible values as string: TIFF, JPEG, BMP, PDF, SCT, PNG, PCX)
• Compression=<value> 

(possible values as string: None, Flate)
• ColorSpace=<value>  

(possible values as string: GRAY, RGB, CMYK)
• StoreIPTC=<value>   

(possible values as integer: 1 or 0; as string: TRUE or FALSE)
• StoreXMP=<value>   

(possible values as integer: 1 or 0; as string: TRUE or FALSE)
• Resolution=<value>[%] 

(value in dpi – dots per inch – as real, e.g. 72.0 without unit 
OR relative to original image in percent, e.g. 50%)

• Width=<value>       
(value for width in pixel, e.g. 640)

• Height=<value>      
(value for height in pixel, e.g. 480)

• MaxWidth=<value>       
(value for maximal width in pixel, e.g. 600)

• MaxHeight=<value>      
(value for maximal height in pixel, e.g. 600)

• CropLeft, CropTop, CropRight, CropBottom=<value>
(values for crop dimensions in pixel)

NOTE: Different Units or Percentage!
You can also define the values for width, height and crop dimensions in other 
units or percentage of the original image pixel size. To do so, enter the abbre-
viation of the measurement unit (in, cm, pc) or the percentage character at the 
end of the number (integer or floating point) of the Width or Height parame-
ter, e.g. "Width=50.0%" or "Height=3.25in" 

NOTE: MaxWidth and MaxHeight
If you define MaxWidth and MaxHeight which specify a bounding box, these 
values will be preferred to any given values for Width and Height. 

• EnlargeImage=<value>   
(possible values as integer: 1 or 0; as string: TRUE or FALSE)

• SourceDPI=<value>
To use a correct value of resolution of source image, if a wrong value is saved.

• Filter=Blur|Gauss|Sharp
Use this parameter to apply a filter.
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• FilterSize=S|M|L
Use this parameter to vary the radius of a filter (S for small, M for medium, 
L for large.) Will be used only if Filter is set.

• RotD=90|180|270
Apply rotation of the image for 90, 180 or 270 degrees.

• FlipH=TRUE|FALSE
Apply horizontal mirroring of the image. 
(Possible values as integer: 1 or 0; as string: TRUE or FALSE)

• FlipV=TRUE|FALSE
Apply vertical mirroring of the image. 
(Possible values as integer: 1 or 0; as string: TRUE or FALSE)

Example : 
<%link converter="Pixel Image Converter"
param="Format=TIFF"%>Convert To TIFF<%endlink%>

ZIP Processor
• ZipFile=<filename> 

(if not specified the asset name with the .zip extension is default.)
• MacBinary=<value>   

(possible values as integer: 1 or 0; as string: TRUE or FALSE)
• MacOSXCompatible=<value>   

(possible values as integer: 1 or 0; as string: TRUE or FALSE)
• Encoding=<value>

Possible values are
– DOSLatinUS
– DOSLatin1
– DOSLatin2
– ISOLatin1
– ISOLatin2
– ISOLatin9
– MacRoman
– MacJapanese
– MacRussian
– MacCentralEuroRoman
– UTF8
– WinLatin1
– WinLatin2
– WinJapanese

NOTE:
If you enable the Mac OS X compatible Format, the encoding will be always 
"UTF8". 

Example:
<%link converter="ZIP AssetProcessor"
param="MacBinary=1"%>Zip-File<%endlink%>

DCS
You can use one of the following parameters to get a specific color separation 
file:
• GetCyan 
• GetMagenta 
• GetYellow 
• GetBlack 
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• GetMain 
Example: 
<%link converter="DCS"
param="GetCyan"<%endlink%>

OPI
You can use one of the following parameters to get the high or low resolution 
file:
• GetHiRes 
• GetLowRes 
Example: 
<%link converter="OPI"
param="GetHiRes"<%endlink%>

PDF PageMerge AssetProcessor (optional)
• PDFFile=<filename>

QXP Server AssetProcessor (optional)
• DDSServer=<servername> or <IPaddress>
• Format=”PDF”

NOTE: Only PDF format supported! 

Params=<parameters for specified format>

Generic Asset Processor (optional)
Enables Cumulus to call external applications from within Asset Actions. It can be 
used for processing, packaging, and delivering tasks.
For each platform you specify the command lines for external applications by 
defining variables (similar to those for the Generic Filter.) 

The following variables have to be used in the command line for the input and 
output files: $INPUT and $OUTPUT. They will be replaced by Cumulus before exe-
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cuting the command line depending on the module task in the following man-
ner:

In case the application to be called expects a special file extension, you can spec-
ify the extension directly behind the variable:
$OUTPUT.jpg „C:\Temp\CumulusTemporary.jpg“

In the same manner you can specify suffixes to append at the destination name:
$OUTPUT_step01.tiff „C:\Temp\CumulusTemporary_step01.tiff“

To exactly specify the file name you can assign one:
$OUTPUT=result.png  „C:\Temp\result.png“

NOTE:
Some applications require the proper file extension 
(e.g. OUTPUT.jpg or OUTPUT.flv.)

Replacement Examples for Processing
"C:\Program Files\MyConverter\conv.exe" $INPUT /opt1 -prm=2 $OUTPUT

will be replaced by:
"C:\Program Files\MyConverter\conv.exe" "C:\My Assets\Selected.jpg" /
opt1 -prm=2 "C:\Temp\Cumulus01"

Replacement Examples for Packaging
"C:\Program Files\MyZipTool\myziptool.exe" -compress -zipfile=$OUTPUT 
$INPUT

will be replaced by:
"C:\Program Files\MyZipTool\myziptool.exe" -compress -
zipfile="C:\Temp\Cumulus02"      ...

"C:\My Assets\Selected1.jpg" "C:\My Assets\Selected2.pdf" "C:\My 
Assets\Selected3.doc"

Replacement Examples for Delivering
cmd /C copy $INPUT "C:\My Destination Folder"

will be replaced by:
cmd /C copy "C:\Asset Location\The Selected Asset.ext" "C:\My 
Destination Folder"

Examples for Windows
Processing: Conversion of images to JPEG using IrfanView
"C:\Program Files\IrfanView\i_view32.exe" $INPUT /convert=$OUTPUT.jpg

Processing, Packaging: Compression of files using 7-Zip to 7z format:
"C:\Program Files\7-Zip\7z.exe" a -t7z $OUTPUT.7z $INPUT

Calling a batch script:
cmd /c "C:\My Scripts\myscript.cmd" $INPUT $OUTPUT

Asset Processor Task $INPUT $OUTPUT
Processing Quoted path of source asset. Quoted path of destina-

tion asset.
Packaging Space separated list of quoted 

paths of source assets.
Quoted path of destina-
tion asset.

Delivering Quoted path of source asset. - (will be deleted)
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Examples for Mac OS / Linux / Unix:
Generate compressed tar file:
tar -czf $OUTPUT.tgz $INPUT

Generate compressed tar file with specified destination file name:
tar -czf $OUTPUT=FromProcessor.tgz $INPUT

Generic Filter
The Generic filter has got an additional option to generate the thumbnail and the 
preview by calling an external application, in the same way the Generic Processor 
works. The parameters are nearly the same: command lines for each platform. For 
this module the variables which have to be used are:
• $INPUT – will be replaced by the quoted path of the cataloged asset
• $PREVIEW - will be replaced the quoted path of a temporary file.
The called application has to generate a picture in JPEG or PNG format.

Examples
Generate a PNG image from EPS assets using GhostScript on Windows
"C:\Program Files\gs\gs8.61\bin\gswin32.exe" -sDEVICE=pngalpha 

-dEPSCrop -dBATCH 

-dNOPAUSE -dNOPROMPT -dQUIET -sOutputFile=$PREVIEW.png $INPUT

If your workflow already generates a JPEG preview for an asset and saves it beside 
the asset named <assetfilename>_preview.jpg then you can access this 
preview using the following command line and make a copy for Cumulus:
cmd /C copy $INPUT_preview.jpg $PREVIEW
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Sample EJaPs Folder 
With Cumulus 6 Canto introduced a new technology: Embedded Java Plugins or 
EJaP for short. The newly introduced EJaP technology provides unlimited possi-
bilities to customize the out of the box solutions to individual needs and to add 
new functionality. Since EJaP is Java-based, it enables Cumulus to be enhanced 
with a multitude of commands, thereby making Cumulus more customizable 
than ever before. Any new task can now be programmed with EJaP. 
The Sample EJaPs folder provides examples of this new technology. The EJaPs 
included can be integrated with the Cumulus out of the box solution. The new 
functionality they provide might be included in the Cumulus menus, in the Pref-
erences dialog or might have no user interface. For details see the documenta-
tion the respective EJaP provides. 
The integration with the Cumulus out of the box solution is very easy. Copy the 
EJaP (file extension ejp) in the ejp folder of the installation folder of your Cumulus 
application (Cumulus Client or Single User). Under Mac OS X, you open this folder 
by opening the installation folder of your Cumulus application and then pressing 
the CTRL key and selecting the Cumulus application icon simultaneously to get 
the context menu for the application. In this menu select Show Package Con-
tents, then open contents and finally open Mac OS. There you find the ejp 
folder.
Once you have started the Cumulus application again, you can make use of the 
functionality the EJaP provides.

Technical Support and Liability
For support and for any further product or technical information, kindly contact 
the company that produced the respective EJaP.
The software in the Sample EJaPs folder was created by and is the property of 
software developers independent from Canto. It is provided "as is". In no event 
will Canto be liable for any lost revenue, profit or date, or for special, indirect, con-
sequential, incidental or punitive damages, arising out of or related to the use of 
or inability to use this software. All express or implied warranties, including any 
implied warranty of fitness for a particular purpose or non-infringement are dis-
claimed. 
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Glossary
This Glossary offers an alphabetical listing of terms and phrases used

throughout this manual and Cumulus.
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Action 
Function or combination of certain functions. Cumulus provides different types 
of actions. See also Asset Action, Trigger Action.

Asset
A general term describing any type of digital media (including graphic, page lay-
out, presentation, sound, and video files) that has value to its owner. 

Asset Action
Combination of certain functions saved under a chosen name that is performed 
on assets in Cumulus. 

Asset Handling Module
When cataloging and accessing assets, Cumulus uses different modules: Asset 
Storage, Asset Processor, Metadata and Filter modules. 

Asset Handling Set
A setting that defines how assets are handled – during the cataloging process 
and when accessing assets.

Asset Information
The information about an asset as stored in the record associated with the asset.

Asset Information window
A special window that displays the information about a cataloged asset. This 
information is stored in the asset’s record. (See also Record.) Cumulus also pro-
vides an Information View and an Information Pane.

Asset Reference
The mechanism by which Cumulus tracks the actual location of an asset man-
aged in a Cumulus catalog.

AXR (Asset Cross References)
Automatic detection of usage and cross-references of assets within Cumulus. 
Cumulus is able to detect links and placed assets in compound documents such 
as QuarkXPress, EPS, Adobe InDesign, and Illustrator (version 8, 9) as well as 
Microsoft Word and PowerPoint documents. 

Boolean
A system of logic based on two possible values: true or false. Cumulus uses the 
Boolean operators "and" and "or" to combine search conditions.

Cache
A temporary storage area where frequently accessed data can be stored for rapid 
access.

Catalog
A special file (with the extension .ccf ) that Cumulus creates to manage cataloged 
assets. See also Asset and Cumulus Catalog File.

Catalog file name
Name of the special file for a catalog (  with the extension .ccf). The catalog 
name defaults to this file name (without the extension). The catalog name can 
be changed without changing the catalog file name. See also Cumulus Catalog 
File.
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Cataloging
The process by which a user adds one or more assets to a catalog. 

Category
Cumulus categories are used to organize records, much like folders are used to 
organize files in a traditional filing cabinet. But the asset can appear in any num-
ber of Cumulus categories at one time. They are similar in purpose to keywords 
used in other programs. See also Folder category and Related category.

Category Information window
A special window that displays the information about categories.

Category Exchange File
See Cumulus Category Exchange File. 

Category pane
Located on the left side of the Collection window. The Category pane displays 
category names in a hierarchical list. Multiple tabs are provided so that categories 
can be created and displayed in separate tabs.

Category View Set 
A setting that defines the display options for the Category Information window. 
For each tab different display options can be set.

Central asset location
A central asset location is a single storage location used to store certaindigital 
assets. Employing a central asset location ensures your assets remain accessible 
to all, and can more easily be accounted for.

Client
A computer user who accesses a server application (such as the Cumulus Server) 
across a network.

Client/server architecture
A software configuration in which users (also called clients) access a server appli-
cation across a network.

Collection
Any set of records from any one catalog, including their display properties. A col-
lection can be saved (see Cumulus Collection File) and opened again. A collec-
tion – whether saved or unsaved – is always connected to its catalog. In order to 
open a particular collection you must have access to its catalog.

Collection window
A window featuring two panes (Category pane and Record pane) that function 
as the central user interface. 

Compound search
A search query consisting of two or more search conditions.

Context menu
Also called shortcut menu. A menu that opens when clicking the right mouse 
button /  Control key + mouse button. The available options are related to the 
selected object.
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Cross Client
See Cumulus Cross Client.

Cumulus 
An indispensable digital asset management system for organizing and manag-
ing digital assets. See also Asset.

There are different editions of Cumulus designed to meet the needs of anyone 
who wants to keep track of their digital media: Cumulus Workgroup and 
Cumulus Enterprise. 

Cumulus Administrator 
A person who configures and manages Cumulus catalogs. The Administrator is 
responsible for keeping the catalogs running smoothly for Cumulus Client users, 
backing up catalogs, and other tasks. 

Cumulus application window
The main Cumulus window containing the menu bar, the toolbar, the statusbar, 
and – as “child” window(s) – the Collection window(s) with various panes.

Cumulus Action
See Asset Action.

Cumulus Catalog File
A special file(with the extension .ccf) that Cumulus creates to manage cataloged 
assets (digital media).

Cumulus Category Exchange File
A file (  with the extension .cce) that Cumulus creates when exporting category 
information.

Cumulus Collection File
A special file (  with the extension .cfe) that Cumulus creates to manage saved 
collections.

Cumulus Cross Client
Standalone version of the Cumulus Native Client. It enables users to create new 
catalogs on their local computers, open catalogs served by Cumulus Servers, and 
update metadata and assets between the two.

Cumulus Internet Client Pro
A Cumulus Option. A powerful Java based application designed to publish, dis-
tribute and market assets over the Internet. Users with a standard Web browser 
can comfortably search for cataloged assets, collect them into a collection basket 
and convert them as required. They can also catalog assets, assign them to cate-
gories and edit metadata. 

Cumulus Record Exchange File
A special file (  with the extension .cre) that Cumulus creates when exporting 
record information.

Cumulus Server
The computer where Cumulus Server software is installed and where Cumulus 
catalogs should reside.
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Cumulus Sites
A Cumulus Option. Starting with Cumulus 8.1, Cumulus Sites is the ideal tool to 
publish and market digital assets on dynamically generated Web pages to the 
Web. 

Cumulus Vault
A Cumulus Workgroup and Enterprise feature. A full-featured Version Control 
System that manages user access to asset files and provides up-to-the-minute 
information on each asset’s version history.

Cumulus Web Client
A Cumulus Option. Provides Cumulus catalogs online and offers read/write 
access for metadata edits as well as asset uploads and downloads to users with 
a standard Web browser. Starting with Cumulus 8.1, Cumulus Web Client is a 
standard feature on all Cumulus Workgroup, Enterprise and Complete systems. 
It is also available as an option for Cumulus Entry.

Cumulus Web Publisher Pro
A Cumulus Option. A powerful Java based application designed to publish, dis-
tribute and market assets over the Internet.

Details view
Each record appears in the Record pane as a text listing that includes fields you 
can define (e.g., record name, file format, resolution, etc.). See also Thumbnail 
view.

Drag and Drop
A way to move user-interface objects by dragging them with the mouse and 
dropping them into targets.

EJaP
Embedded Java PlugIn. Technology that provides unlimited possibilities to add 
new functionality or to integrate Cumulus into workflows. EJaPs are Java code 
that runs within the Cumulus application. 

EJSP
Embedded Server Plug-In. Technology that provides possibilities to add new 
functionality, or to integrate Cumulus into workflows. ESPs are similar to EJaPs 
(Embedded Java PlugIn). Whereas EJaPs are Java code that runs within the 
Cumulus application, ESPs are Java code that runs at the Cumulus Server. 

EXIF
Exchangeable Image File Format. Standard for storing interchangeable informa-
tion in image files, especially those using JPEG compression. Most digital cam-
eras now use the EXIF format. The format is part of the DCF standard created by 
JEIDA (Japan Electronics and Information Technology Industries Association) to 
encourage inter-operability between imaging devices. Cumulus can read EXIF 
metadata information while cataloging. You can view and edit this metadata. 
See also Metadata.

Filters
Software utilities that Cumulus uses to capture information about an asset dur-
ing the cataloging process. For more information on the availability of new file 
filters, please see the Canto Website (www.canto.com).
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Find window
Cumulus tool that enables users to search catalogs for records or categories that 
match search conditions.

Folder category
Folder categories are automatically created by Cumulus during the cataloging 
process. These automatically created categories resemble the folder or directory 
hierarchy in which the assets reside. They are identified by a smaller folder in their 
icons. They are created by default but this option can be disabled.

FTP
File Transfer Protocol. A standard Internet protocol, which is the simplest way to 
exchange files between computers on the Internet. 

HTTP
HyperText Transfer Protocol. A standard Internet protocol, which is the protocol 
most often used in the World Wide Web to transfer information between servers 
and browsers.

ICP
See Cumulus Internet Client Pro.

Information window
Special windows that display the information about records or catagories. See 
also Asset Information window,  and Category Information window.

IPTC 
International Press Telecommunication Council. Standard for digital text applied 
to an image. Applications used for professional imaging, support IPTC; e.g. the 
text information in Photoshop is a subset of the IPTC information. Cumulus can 
read IPTC metadata information while cataloging. You can view and edit this 
metadata and Cumulus can write your changes back to the asset. See also Meta-
data.

IPTC Information window
A special window that displays the IPTC information about a cataloged asset. This 
information is stored in the asset’s record. 

Java Server Page
Java Server Page (JSP) is a technology for controlling the content or appearance 
of Web pages through the use of servlets, small programs that are specified in 
the Web page and run on the Web server to modify the Web page before it is 
sent to the user who requested it. 

LDAP
Lightweight Directory Access Protocol. Directories containing information such 
as names, phone numbers, and addresses are often stored on a variety of incom-
patible systems. LDAP provides a simple protocol that allows you to access and 
search these disparate directories over the Internet.

Media file
Any electronic or digital media file (including graphic, page layout, presentation, 
sound and video files). See also Asset.
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Menubar
Appearing at the top of the Cumulus application window, the menubar houses 
menus that contain every program command.

Metadata
Metadata is any data that helps to describe the content or characteristics of an 
asset. It is the information stored with each asset—such as file name, location, 
etc. Different types of assets have different metadata fields: an image file, for 
example, would contain information on color and resolution, while an audio file 
would have a field for the playback duration.

Palette Mode
View mode that is specially designed for using Cumulus with another applica-
tion, e.g. a desktop publishing application. In palette mode the Cumulus applica-
tion shrinks to a palette that can conveniently be used with another application. 
That way you can easily drag and drop cataloged assets into other applications. 

Path/Pathname
A description of the location where a file is stored on a computer hard drive, 
server, or removable medium (such as CD-ROM, Syquest, Zip, Jaz, or MO car-
tridges).

Preview
A special program mode in which you can examine cataloged assets such as 
video clips, sound files, and image files.

Query
A combination of search conditions. Queries can be saved to disk and loaded 
into the Find window.

Quicklist
A list containing default field values to fill in fields. In Cumulus, available with the 
IPTC Information window.

Record
The actual catalog entry Cumulus creates when an asset is added to a catalog. 
Records store valuable information about an asset, such as the file name, file loca-
tion, file type, resolution, etc. 

Record Exchange File
See Cumulus Record Exchange file.

Record pane
Located on the right side of the Collection window, the Record pane displays 
records as thumbnails or plain text. See also Record, Thumbnail view and Details 
view.

Related category
An alias of an existing category that acts as a virtual cross reference to the original 
category. You can use related categories to place multiple instances of the same 
category under various parent categories, without having to copy the entire con-
tents of the category. By default, the names of related categories are displayed in 
italics with a “(related)” appendix. 
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Record View Set
A setting that defines how records are displayed in the different view modes 
Cumulus provides: Thumbnail View, Details View, Info View and Information win-
dow.

Resolution
The number of pixels per inch in any graphic file format. Higher-resolution files 
have a higher number of pixels per inch than lower-resolution files. Working with 
higher-resolution files usually requires more memory and hard disk space than 
working with lower-resolution files.

Script
A list of instructions executed by a computer. Scripts are used by Cumulus to per-
form complex tasks automatically.

Server/Client Asset Transfer
A Cumulus feature (especially useful in a cross platform environment) that allows 
users in a network to access assets for previewing, copying and transferring via 
their connection to the Cumulus Server. With this feature the user is not forced 
to have direct access to the computer where the asset is stored. Only the com-
puter running the Cumulus Server requires this access. 

Simple search
A search query consisting of one search condition.

Sites
See Cumulus Sites.

Skin
A term for the particular way in which information is arranged and displayed on 
a computer screen.

Statusbar
A bar providing descriptions on category/record status.

TAG file
The Cumulus Metadata Exchange file format, which Cumulus can create when 
cataloging assets from a location where you are allowed to save files. The file has 
the same name as the asset ( with the extension .tag). TAG files can hold all 
information that can be viewed in the Asset Information window – and more. For 
example, if a particular asset has been cataloged into different catalogs, this infor-
mation is part of that asset’s TAG file. 

Thumbnail
A miniature display of a cataloged asset.

Thumbnail view
The record appears with a miniature display of the cataloged asset in the Record 
pane.

Toolbar
A standard program tool that offers buttons as shortcuts to commonly used 
commands.
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Tooltip
A small floating descriptive window that appears above a toolbar button when 
the cursor is positioned over it.

Trigger
A stored procedure that is activated automatically when a specified event 
occurs. Cumulus Triggers can be used to perform many tasks, such as auditing 
catalogs, records and categories. Cumulus Triggers can be set for catalogs, 
records and categories. 

Trigger Action
The action performed when a Cumulus Trigger is activated. See also Action.

URL
Uniform Resource Locator. The address of a file (resource) accessible on the Inter-
net. 

XMP
Extensible Metadata Platform. Adobe’s XMP™ is a labeling technology that allows 
you to embed metadata into the asset itself. With an XMP-enabled application 
(e.g. all applications of Adobe Creative Suite), information about a project can be 
captured during the content creation process and embedded within the file and 
into a content management system. Cumulus can read XMP metadata informa-
tion while cataloging. You can view and edit this metadata and Cumulus can 
write your changes back to the asset. See also Metadata.

Web Client
See Cumulus Web Client.

WPP 
See Cumulus Web Publisher Pro.
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converting to other database engine 67
copying 63
creating 20, 58
damage prevention 64
Database Mirroring 54
deleting 66
disconnecting users from 69
dividing 66
explained 9
journaling vs. mirroring 52
linking to Vault 140
logging 68
maintenance 61
making available 22
making available to Clients 22
making unavailable to Clients 22
manager, naming a 18
maximum number of records 61
maximum size 155
merging several into one 66
multiple 19
naming 65

catalog names vs. catalog file names 65
permitted cross-platform characters 19
renaming 29

preparing for Vault 138
rebuilding from mirror 64
reducing size by dividing 66
removing from Cumulus Server 23
repairing 64
restricting user permissions by Live Filtering 117
securing 52
settings 28
sharing 22
storage media 154
updating with Catalog Templates 61
user access 107

Categories
avoiding automatic folder categories 45, 46
explained 10
permissions for individual users 117

Category Fields
adding to a catalog 46
creating 48

Category View Sets
configuring See Client User Guide

Central Asset Location
activating 29
employing 31
explained 133
fields required for Duplicates Control 29
specifying Vault as 140
versioning 80

Changing
password 104

Check out duration 138

Check Users Catalog (menu item) 113

Client Groups 122

Clients See Cumulus Clients

Collection Basket, permission for saving 117

Collections
explained 10
permissions 114

Configuring
Asset Actions See Client User Guide
Asset Handling Sets See Client User Guide
catalogs for Vault 138
Metadata Templates See Client User Guide
PermissionsTemplates See Client User Guide
Print Templates See Client User Guide
Record Filters See Client User Guide
Triggers See Client User Guide
User Settings See Client User Guide
Vault Server 135
View Sets See Client User Guide

Connect to Server dialog box 16

Converting
catalogs to other database engines 67

Copying
assets to Vault during cataloging 140
catalogs 63
records 66
User Settings 126

Copyright 2
Creating

Catalog Template 59
catalogs 20, 58
category field 48
custom record field 48
roles 120

Cross-platform issues 9, 19

Cumulus Administrator
identity of 16
logging on as 16
password of 17

Cumulus Server
avoiding improper shutdowns 53
dedicated 154
IP address of 16
multiple 19
starting 83
stopping 83
using Remote Admin 83

Custom Record Fields
creating 48

Customizing
Catalog Settings 28
category field properties 29



INDEX 179
D
Database Mirroring 54

DCS files 156

Defining
mail configuration 82
Scheduler Task 93

Deleting
catalogs 66

Disconnecting users 23, 69

Drag and drop
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